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About This Manual3333333333333333333333
This manual introduces DECwindows Motif applications,
describes how to customize your DECwindows environment, and
includes advanced user information.

DECwindows Motif is based on the X Consortium specification
for the X Window System, Version 11, Release 5 and the Open
Software Foundation’s OSF/Motif Version 1.2.

Note

All references to DECwindows in this manual refer to
DECwindows Motif software.

Audience
This manual is for new and experienced DECwindows users. You
need not be familiar with the Digital UNIX operating system or
the DECwindows Motif graphical user interface.

For a first-time DECwindows user, this book guides you through
DECwindows techniques and features.

For the experienced DECwindows user, information is provided
about the Motif interface, customizing your environment, and
advanced user topics.

Organization
Use this manual in accordance with your knowledge of
DECwindows.

If you are new to windowing systems, read Part 1.

If you are familiar with graphical user interfaces, look over the
summaries of the contents of each part and chapter in the
following table to review what is familiar about DECwindows and
identify the areas you want to know more about.

The manual is divided into four parts comprising 10 chapters and
four appendices:



Part 1 Introduces the DECwindows Motif Graphical
User Interface and includes all the information
you need to get started. It describes the basic
window components and how to use the
mouse to manipulate these components.

Chapter 1 Introduces DECwindows and describes the
main components of the DECwindows
interface.

Chapter 2 Describes how to start, pause, and end a
DECwindows session and how to run window
applications. It also describes how to get help
and read documentation on line.

Chapter 3 Describes basic window components and
explains how to use the mouse to select and
manage these components.

Part 2 Describes how to use and manage window
features common to all applications, introduces
the DECwindows Motif Desktop Applications,
and describes how to use the Options menus to
customize your windows environment.

Chapter 4 Describes tasks common to many applications,
such as how to work with text, print files, and
mix colors. This chapter also describes how to
run applications on another host on the
network for display on your workstation
screen.

Chapter 5 Introduces the DECwindows Motif Desktop
applications.

Chapter 6, Chapter 7 Describe how to customize your windows
environment with the window manager and
Session Manager Options menus.

Part 3 Describes advanced features of Mail, AccessX
software, and how to use the.Xdefaults
and .mwmrc configuration files to customize
your window environment.

Chapter 8 Describes how to use the advanced features of
Mail, including how to change editors, sort
incoming mail, and customize your Mail
environment.

Chapter 9 Provides advanced topics on customizing your
windows environment, including how to
customize the file .mwmrc and how to
modify resources in the file .Xdefaults.
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Chapter 10 Describes how to use AccessX, software that
provides features to help people with different
disabilities interact with Digital workstations
running the Digital UNIX operating system.

Appendix A Describes how to use DECwindows with a
keyboard.

Appendix B Describes how to compose characters in the
DECterm terminal emulator.

Appendix C Describes commands that help you manage
windows.

Appendix D Provides sample resource and configuration
files.

Related Documents
The printed version of the Digital UNIX documentation set is
color coded to help specific audiences quickly find the books that
meet their needs. (You can order the printed documentation from
Digital.) This color coding is reinforced with the use of an icon on
the spines of books. The following list describes this convention:
22222222222222222222222222222222222222222222222222
Audience Icon Color Code22222222222222222222222222222222222222222222222222
General users G Blue

System and network administrators S Red

Programmers P Purple

Device driver writers D Orange

Reference page users R Green22222222222222222222222222222222222222222222222222

Some books in the documentation set help meet the needs of
several audiences. For example, the information in some system
books is also used by programmers. Keep this in mind when
searching for information on specific topics.

The Documentation Overview, Glossary, and Master Index
provides information on all of the books in the Digital UNIX
documentation set.
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Reader’s Comments
Digital welcomes any comments and suggestions you have on this
and other Digital UNIX manuals.

You can send your comments in the following ways:

• Fax: 603-881-0120 Attn: UEG Publications, ZK03-3/Y32

• Internet electronic mail:
readers_comment@zk3.dec.com

A Reader’s Comment form is located on line in the following
location:
/usr/doc/readers_comment.txt

• Mail:

Digital Equipment Corporation
UEG Publications Manager
ZK03-3/Y32
110 Spit Brook Road
Nashua, NH 03062-9987

A Reader’s Comment form is located in the back of each
printed manual. The form is postage paid if you mail it in the
United States.

Please include the following information along with your
comments:

• The full title of the book and the order number. (The order
number is printed on the title page of this book and on its back
cover.)

• The section numbers and page numbers of the information on
which you are commenting.

• The version of Digital UNIX that you are using.

• If known, the type of processor that is running the Digital
UNIX software.

The Digital UNIX Publications group cannot respond to system
problems or technical support inquiries. Please address technical
questions to your local system vendor or to the appropriate Digital
technical support office. Information provided with the software
media explains how to send problem reports to Digital.
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Conventions
The following conventions are used in this manual:

mouse The term mouse is used to refer to any
pointing device, such as a mouse, a
trackball, a puck, or a stylus.

MB1 (Select)
MB2 (Drag)
MB3 (Menu)

MB1 indicates the left mouse button,
MB2 indicates the middle mouse button,
and MB3 indicates the right mouse
button. (The buttons can be redefined by
the user.)

1Ctrl+x 1222222777777 A sequence such as 1Ctrl+x 1222222777777 indicates
that you must hold down the key labeled
Ctrl while you press another key or a
mouse button.

1Return 122222227777777 In some examples, a key name is shown
enclosed in a box to indicate that you
press a key on the keyboard.

new term, user input Boldface text represents the introduction
of a new term. Boldface text also
indicates information that you must enter
from the keyboard or a screen object that
you must choose or click on.

% or $ A percent sign represents the C shell
system prompt. A dollar sign represents
the system prompt for the Bourne and
Korn shells.

# A number sign represents the superuser
prompt.

file Italic (slanted) type indicates variable
values, placeholders, and function
argument names.

[ | ], { | } In syntax definitions, brackets indicate
items that are optional and braces
indicate items that are required. Vertical
bars separating items inside brackets or
braces indicate that you choose one item
from among those listed.

. . . In syntax definitions, a horizontal ellipsis
indicates that the preceding item can be
repeated one or more times.
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cat(1) A cross-reference to a reference page
includes the appropriate section number
in parentheses. For example, cat(1)
indicates that you can find information
on the cat command in Section 1 of
the reference pages.
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1Introducing the DECwindows Motif
Graphical User Interface3333333333333333333333

Digital provides an easy way to interact with the Digital UNIX
operating system—the graphical user interface called
DECwindows Motif. The DECwindows Motif interface is based
on two industry standards: the X Consortium’s X Window System
and the Open Software Foundation’s Motif user interface. This
interface lets you use the mouse or keyboard to interact with
applications.

When you log in to your workstation, your screen becomes a
visual ‘‘workspace’’ where you arrange your work. You can open
windows to manipulate files and directories and to run applications
and utilities. You can arrange your workspace so that the files and
programs you use most often are easily accessible.

Four components work together to create your workspace
environment: the X server, the OSF/Motif window manager
(mwm), the Session Manager, and X client applications. The
following sections introduce these components.

1.1 X Servers and Clients
The DECwindows interface uses the client/server method of
computing inherent in the X Window System. A component called
the X server provides display services. The X server acts as an
intermediary between applications and the workstation’s display
hardware: it handles output from the clients to the display and
forwards input (keyboard or mouse) to the appropriate client for
processing. X clients are applications that use the services of the
X Window System.

X clients can run on your workstation or on another system.
Because the X Window System has built-in networking capability,
applications can run on one system and be displayed on any other
workstation on the network that supports the X Window System
Protocol.



1.2 Window Manager
A window manager is a special X client that controls the size,
placement, and operations of your windows. The Motif window
manager (mwm) creates a three-dimensional frame around each
window. The window frame contains buttons and handles you use
to move, resize, overlap, and shuffle windows on your display and
a menu for working with your window. See Figure 3-1.

1.3 Session Manager
The Session Manager provides the top-level interface to your
workstation. Use the Session Manager to:

• Start, pause, or quit a session.

• Start applications.

• Customize your session operation. For example, you can
specify:

– Which applications can be started automatically each time
you begin a session

– How the keyboard and mouse should behave

– What other systems are allowed access to this workstation

– Support for a language other than English

1.4 X Client Applications
The Digital UNIX operating system includes many X client
applications that help you make full use of the windows
environment. The applications include terminal emulators, a set of
desktop applications, Bookreader software for reading online
documentation, Mail, and sample X clients supplied by the X
Consortium.

1.4.1 Terminal Emulators
A terminal emulator window provides workstation users with a
traditional character-cell interface to run nonwindowing
applications and work with your files and directories.

The DECterm terminal emulator emulates the following types of
terminals: VT320, VT300, VT220, VT102, VT100, VT52, and
terminals supporting ReGIS graphics. ReGIS (Remote Graphics
Instruction Set) is a graphics protocol for terminals.
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The xterm terminal emulator emulates VT102 and TEKTRONIX
4014 terminals.

1.4.2 DECwindows Motif Client Applications
The Digital UNIX operating system provides a set of client
applications with the DECwindows Motif interface. The desktop
applications include:

• Bookreader

Bookreader is an online information access tool for viewing
the contents of books distributed and stored on line.

Digital offers Digital UNIX, ULTRIX, VMS, and layered
product documentation in online form, packaged on CD-ROM
disc and accessible using Bookreader.

• Calculator

Calculator functions like a handheld calculator. It performs
simple arithmetic functions—addition, subtraction,
multiplication, division—and computes percentages and square
roots. In addition, Calculator also performs trigonometric and
inverse trigonometric functions, generates random numbers,
and performs other more advanced operations.

• Calendar

Calendar combines the functions of a desktop calendar and an
appointment book. You can look at a year or month display,
review scheduled appointments one day at a time, or create
several different calendars to use for specific purposes.

• Cardfiler

Cardfiler creates electronic ‘‘boxes’’ of index ‘‘cards.’’ Each
card has a heading and additional text. Each box contains an
alphabetized set of cards pertaining to one or more subjects.

• CDA Viewer

CDA Viewer is a tool for reading documents containing
compound text, graphics, and image data on terminals and
DECwindows workstations. The CDA Viewer displays text,
PostScript, and DDIF documents and files, and lets you page
through the document or view an image.

• Clock

Clock displays the time (in both analog and digital format) and
date and has an alarm to remind you of appointments.
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• Mail

Mail is a window interface to the Rand mh Mail Handler. You
can exchange messages with other computer users and print,
file, delete, reply to, and forward messages. Mail also supports
the display of PostScript messages.

• Notepad

Notepad is an editor that allows you to perform simple editing
operations on text and to save or retrieve text from files.

• Paint

Paint is a graphics application that lets you create simple
pictures by using an assortment of art tools. With Paint you
can save your pictures, print them on different kinds of
printers, copy them to other applications, or display them on
your screen with the CDA Viewer.

• Print Screen

Print Screen takes a snapshot of your workstation screen or
just a portion of the screen. You send the snapshot directly to a
printer or save it to a file for later printing or for inclusion in
another application.

• Visual Differences

Visual Differences provides a graphical display of the
differences between two ASCII text files. It compares two files
line by line, highlights the differences, and allows you to scroll
through the compared files or move from one difference to
another.

1.4.3 X Consortium Client Applications
The Digital UNIX operating system supports all of the X
Consortium clients that come with the X Window System. Some
of these clients duplicate features provided in the Session Manager
and several desktop applications. Use whichever application best
suits your needs.

The X clients, located in /usr/bin/X11, are too numerous to
list here. The following table describes some of the more
commonly used X clients:
22222222222222222222222222222222222222222222222222222222222222
X Client Description22222222222222222222222222222222222222222222222222222222222222
xbiff Mailbox flag

xcalc Scientific calculator
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22222222222222222222222222222222222222222222222222222222222222
X Client Description22222222222222222222222222222222222222222222222222222222222222
xclock Analog/digital clock

xconsole Tool for monitoring system console messages

xedit Simple text editor for windows

xhost Server access control program

xmh X interface to the mail handler

xrdb X server resource database utility

xrefresh Tool to refresh all or part of a screen

xset User preferences utility

xterm X teminal emulator22222222222222222222222222222222222222222222222222222222222222
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2Starting Your Session3333333333333333333333
This chapter describes how to log in to a Digital UNIX
workstation and begin using window applications. It also provides
instructions for reading online documentation and how to get help
on any application.

The features described in this chapter require use of the mouse. To
learn about using the mouse, read Chapter 3.

2.1 Starting a Session
If your installation and startup procedure is successful,
DECwindows displays a Start Session screen that prompts you for
your login name and password. (When the operating system is
installed, an account with an associated login name and password
is established for you.)

 

OK Cancel
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Digital UNIX on my.system.com

login:

Password:

TM

Copyright Digital Equipment Corporation 1991, 1995.

To start a session:

1. Position the mouse pointer over the login text-entry box and
click MB1.

2. Type your login name, then press Return.

The Password text-entry box gets input focus.



3. Type your password.

To preserve the secrecy of your password, the letters you type
are not displayed on the screen.

4. Press Return, or click on the OK button, if you have entered
your login name and password correctly.

If you provide wrong information or make a typing mistake and
do not correct it, your system does not let you start a session.
Instead, it displays a warning that some information is incorrect.

 

Invalid login

Acknowledge

Press Return or click on the Acknowledge button to dismiss the
message. Then retype your information and press Return.

If your system is idle for awhile, the screen saver feature blanks
your screen. To restore the screen image, simply move the mouse
or press any key.

If your user information is correct, your session begins and The
Session Manager menu bar and console window (dxconsole) are
displayed on your screen. The Session Manager console displays
any informational, warning, and error messages you receive during
a session.

Note

If your home directory does not exist or is not
writable, the login will default to failsafe mode.
Failsafe mode provides a DECterm window to use to
recover from your problem.

If your customized session is corrupted, your session
might immediately exit. If this occurs, force failsafe
mode by pressing the F1 or F2 function key instead of
the Return key after typing your password. Use the
DECterm window to correct your customization
errors.
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2.1.1 Starting Applications

 

Applications

Bookreader
CDA Viewer

Calendar
Cardfiler

DECterm
Mail
Notepad

Differences
XTerm

Paint

Print Screen

Calculator

Clock

DECwindows applications increase your productivity by
automating basic tasks. For example, Mail automates sending and
receiving interoffice messages; Cardfiler automates creating and
filing index cards.

To run an application, choose the application from the Session
Manager Applications menu. DECwindows displays the
application in a window. Chapter 5 provides more information on
starting and using these applications.

If you want to run character-cell applications or work with files
and directories, open a terminal emulator window by choosing
DECterm or xterm from the Session Manager Applications menu.

Use a terminal window to enter UNIX commands, access files and
directories, or use any other keyboard user interface. If your
system is part of a network, you can communicate with other
systems and share information and resources.

2.1.2 Reading Documentation On Line

 

All documentation, including this guide, is available on line. The
Bookreader software lets you read documentation on your
workstation screen.

Start the Bookreader by choosing Bookreader from the Session
Manager Applications menu. The book Using Bookreader and
libraries of books should appear in a library window. If they do
not, check with your system manager or refer to the section
‘‘Displaying the Documentation’’ in the Installation Guide.

Libraries contain groups of related book titles. An icon to the left
of each library and title indicates whether the title is a library or a
book.

To display the titles of books in a library, double click on the
library. A list of book titles for that library appears. To open a
book, double click on the book title. For more information about
using the Bookreader, see Section 5.2.

2.1.3 Pausing a Session
You can put your current session on hold indefinitely and lock
your workstation without ending your session. Any running
applications continue to run. When your session is on hold, a
blank screen is placed over the workstation screen and the pause
dialog box is displayed. Enter your password into this box to
resume your session.
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Before you put your session on hold, make sure you save any files.
Then, if your system fails, you will not lose any information.

To put your current session on hold, choose Pause from Session
Manager’s Session menu. Your screen is cleared and the pause
dialog box is displayed. Type your password and press Return or
click on OK to resume your session. All updates to windows are
performed and you can resume working without having to re-
create your workspace environment.
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OK Clear

Password

Type your password to resume the session.

2.1.4 Ending a Session
To end your session, choose End Session from the Session
Manager Session menu. The Session Manager displays a dialog
box asking for confirmation to end your session and save any
settings that changed. At the end of your session, all windows are
closed and the Start Session screen appears on your workstation
screen.
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2.2 Getting Help

 
?

To get help with any DECwindows application, use the Help menu
in the application window:

 ZK−1004U−R

File 

Context−Sensitive Help

Overview

Using Help

Product Information

Editor: MYFILE.TXT

CustomizeEdit Help

Shift+Help

The Help system provides information about screen objects,
concepts, system messages, or tasks to perform in applications.
The Help system is designed to let you request general information
on an application and quickly narrow the focus of your inquiry.

A Help menu is available in each Application’s menu bar. Most
Help menus are organized as follows:
2222222222222222222222222222222222222222222222222222222222222
Menu Item Function2222222222222222222222222222222222222222222222222222222222222
Context-Sensitive Help Describes any object in the window,

such as a menu or push button, and tells
how to use the object.

Overview Summarizes the purpose and functions
of the application, and allows navigation
to help on those functions.

Using Help Activates the Help system and tells how
to find the information needed.

Product Information Tells what version of the application is
running.2222222222222222222222222222222222222222222222222222222222222

2.2.1 Opening a Help Window
To get help about tasks in any application, choose Overview from
the application’s Help menu.

To get help about screen objects such as menu names, scroll bars,
system messages, and dialog boxes in most applications:

1. Choose Context-Sensitive Help from the application’s Help
menu.
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The pointer will change to a question mark.

2. Click on the screen object.

A Help window opens, displaying information about the object
you specified.

An example of a Help window follows.

 

HelpViewFile Edit

Help on Calendar

Close Go Back

Additional topics:

Year View
Selecting New Calendar Displays
Returning to Today

.

.

.

.

Displaying a Month View

Choose the Month menu item from the View menu to view
a particular month or month that contains a selected day.
First click on a particular month (or day) in the current view,
then choose the Month menu item.  The view changes to
show the month you have selected.
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Displaying a Month View

Displaying a Day View

Topic Screen

Search

You can display product information about your application, such
as the copyright notice, by choosing Product Information from the
application’s Help menu. In some applications, the Help menu also
contains a Glossary menu item, which you can use to look up
terms specific to your application.

The Overview topic contains overview text and lists additional
topics. These topics are highlighted when you position the pointer
on them. Double clicking on a highlighted topic causes the text for
that topic to be displayed.
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When you first open a Help topic, the following message may be
displayed in a message window on your screen:
Starting Bookreader

This occurs because the Bookreader software is responsible for
displaying the help windows. Bookreader will be started
automatically for you.

Use the buttons and arrows at the bottom of the window to move
through the text. To close the topic that is displayed on the screen,
click on the Close button:

 
Close

To go back to one or more of the topics viewed previously, click
on the Go Back button until you reach the desired topic. A
dimmed button, like the Go Back button shown below, means that
you are at the first topic:

 
Go Back

To move to the next topic or the previous topic, click on the arrow
to the right or the left of the word Topic:

 
Topic

To move to the next screen or the previous screen, click on the
arrow to the right or the left of the word Screen. If the end of the
current topic appears, moving to the next screen opens the next
topic.

 
Screen

For more information about using Help in any application:

1. Choose Using Help from the application’s Help menu.

A Help window appears.

2. In the Help window, choose Overview from the Help menu.

2.2.2 An Alternative Help Style
Some applications do not use Bookreader to display a help Topic
window. A plain font is used to display text in the alternative help
system. In the Topic window, the overview text appears in the top
window pane, and the list of additional topics appears in the
bottom pane.
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This help system lets you select additional topics, retrace your
steps, or branch off to a different topic. You can also return to the
On Window topic and start down another topic path.

To display an additional topic:

1. Select the item from the list of additional topics.

2. Choose Go To from the View menu.

For still faster navigation, double click on the topic you want.
Double clicking on a topic is a shortcut for selecting the topic and
choosing Go To.

Help displays the selected topic. Continue to select other topics
from the list of additional topics or redisplay the previous topic by
clicking on the Go Back button.

In addition to reading help in a Help window, you can:

• See the path you followed to get to a current topic

Use the Search menu to look at a recorded history of your help
session.

• Search Help for titles and keywords

Use the Search menu to search Help for words or phrases to
see whether they appear in topic titles or in Help text. For
example, you might want to see whether a Mail topic title
contains the word ‘‘Sending,’’ or you might want to find the
topics in which the word ‘‘message’’ appears.

• Save help text in a file

Use the edit menu to select text from a Help topic and save it
in a file. This option lets you print the file for later reference or
mail it to another user.
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3Working with Windows3333333333333333333333
This chapter explains how to work with windows and window
components such as menus and dialog boxes. It describes how to
use the mouse to select items and to move, resize, and shrink
windows.

3.1 Using the Mouse
The mouse provides a convenient way to interact with
DECwindows and DECwindows applications. Use the mouse to
choose commands from a menu, to enlarge and shrink windows, to
select, cut, and paste text, and to rearrange windows on your
screen.

The mouse has three buttons. MB1 (for mouse button 1) is on the
left, MB2 is in the middle, and MB3 is on the right. Most often,
you use MB1 to interact with applications. This button
arrangement naturally suits right-handed users; you can rearrange
this configuration if you prefer to use the mouse with your left
hand. See Section 7.5 for information about how to change the
mouse button arrangement.

To work with the mouse, make sure that the cable connecting it to
the workstation is pointing away from you. Place the mouse on a
smooth surface. As you move the mouse, watch your screen to
see how moving the mouse moves the pointer on the screen in
exactly the same way. If you run out of room on your desk, lift
the mouse and put it down where you have more room. The
pointer does not move when you lift the mouse.

By default the pointer is shaped like an arrow, but it can change
shape to reflect the state of an application. For example, it
becomes an hourglass or a wrist watch when an application is
performing a task that needs more time to complete.



 

Pointing

Working

Moving
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3.1.1 Summary of Mouse Techniques
By learning the following mouse techniques, you can work with
any DECwindows application:

• Point: Using the mouse, position the pointer to where you
want the next action to occur.

• Click: Quickly press and release any mouse button. You
should hear and feel a faint click.

• Press: Point to the menu name, scroll bar stepper arrow, or
wherever you want the action to occur. Without moving the
mouse, press and hold MB1.

• Drag: Press and hold MB1 (or MB2), move the pointer, and
release MB1 (or MB2).

• Double click: Point to the object and click MB1 twice in
quick succession.

• Shift click: Point to the object. Press and hold the Shift key
and click MB1. Release the Shift key.

3.2 Managing Windows
Typically you will run more than one application and so you will
work with several windows. This section describes basic features
of windows and explains how to move, size, and arrange them.
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Figure 3-1:   Parts of a Window

 

HelpFile Edit PrintOptions

DECterm

Window Menu Button

 Frame

Menu Bar

Title Title Bar

Maximize Button

Minimize ButtonResize Border

Work Area

Resize
Border

Resize
Border

Commands

#
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Window 

3.2.1 Parts of a Window
Most windows include some of the components shown in Figure
3-1:

• The window frame surrounds a window and usually consists
of resize borders, a title bar, and buttons that you use to
rearrange your screen display.

• The resize border surrounds an application window and lets
you resize the application’s window.

• The title bar shows the name of the application and contains a
window menu button, a minimize button, and a maximize
button.

• The title identifies the function of a window. For a main
window, it usually contains the name of the application. For a
dialog box, it can also contain specific information about the
use of the window.

• The window menu button displays the window menu, which
contains menu items for working with windows.

• The minimize button lets you shrink a window to an icon on
the workspace. An icon is a small graphic representation of an
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object, usually an application.

• The maximize button lets you increase the size of a window
to its maximum allowable size.

• The menu bar contains the names of menus you can use to
work with the application.

• The client or work area is the area in a window where you
interact with the application.

• The matte is an optional decorative border between the
window frame and the work area.

3.2.2 Making Windows Active
The system must know which window you are currently using so
that what you type ends up in the correct place. By giving a
window input focus, you tell the system it is the active window.
Only one window at a time has input focus.

To give a window input focus, point to the window frame and
click MB1. The window frame is highlighted to indicate it is the
‘‘active’’ window. Any keystrokes you type appear in this
window.

This way of giving a window focus is called explicit focus. You
can customize your environment so that simply moving your
pointer into a window gives it focus. This is called pointer focus.
For information on changing this behavior, see Chapter 6.
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Window without
Input Focus

Window with
Input Focus

3.2.3 Moving Windows
You will often want to move the windows to arrange your
workspace. To move a window:

1. Position the pointer anywhere in the window’s title bar (except
on a button). If the title bar of window you want to move is
covered with other windows, move those windows to the
bottom of the stack of windows by shift clicking MB1 in their
title bars. Or minimize them by clicking MB1 in their
minimize buttons.

2. Press and hold MB1.

3. Drag the window to the new location.

When you move a window, it is given input focus and moves to
the front of the stack of windows.

To cancel a move operation, press the Escape key (or the F11
key).

3.2.4 Resizing Windows
You can resize windows to make working with them more
convenient, for example when you want to arrange your screen to
have several windows simultaneously visible. Use a window’s
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resize borders to change its size.

To change the size of a window:

1. Position the pointer on one of the window’s resize borders.
The resize operation is limited by the side or corner that you
select.

The pointer changes into one of the following resize cursors:
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2. Press and hold MB1.

3. Drag the resize cursor until the window is the size you want.

To make the window larger, drag the resize cursor toward the
outside of the window. To make the window smaller, drag the
resize cursor toward the inside of the window. The outline
stops moving if you try to make the window smaller than its
minimum permissible size.

4. Release MB1.

3.2.4.1 Minimizing Windows

 
Minimize a window to an icon to free up space on your screen
without quitting an application. When you minimize a window,
the application it represents continues to run and remains easily
accessible.

To minimize a window, point to the window’s minimize button
and click MB1. The icon appears on the workspace. You can also
minimize a window by double clicking MB1 on the window’s
title.

To restore the icon to a window, point to the icon on the
workspace and double click MB1. The window opens at the top of
any stack of overlapping windows, is given input focus, and is
available for your use.
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3.2.4.2 Maximizing Windows

 
The maximize button enlarges a window so that it fills your
screen. When you maximize a window, your other windows and
icons stay on the screen, but they are covered by the maximized
window.

To maximize a window, point to the window’s maximize button
and click MB1. The window expands to its maximum allowable
size.

To restore a maximized window, point to the window’s maximize
button and click MB1. The window returns to its original size.

3.2.5 Viewing Text with Scroll Bars

 

Some application windows display scroll bars, which let you view
the text that does not fit in a single window. Some windows have
both horizontal and vertical scroll bars.

A scroll bar consists of stepper arrows at either end of the scroll
region. The slider is the thicker box that overlays some of the
scroll region. If a vertical slider is at the top of the scroll region,
the beginning of the file, list, or other text in the window is
visible. If the slider is at the bottom of the scroll region, the end of
the text is visible.
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Scroll
Region

The length of the slider, compared to the length of the scroll
region, indicates what proportion of all the text in the window is
currently visible. For example, a short slider indicates that most of
the text is not visible. A long slider that completely fills the scroll
bar indicates that all the text is currently displayed.

The following table describes how to use scroll bars:
2222222222222222222222222222222222222222222222222222222222222
To scroll Do this2222222222222222222222222222222222222222222222222222222222222
One line at a time Click MB1 on the stepper arrows.

Forward one window of text at a
time

Point to the scroll region below the
slider and click MB1.

Back one window of text at a time Point to the scroll region above the
slider and click MB1.

Continuously through the text one
line at a time

Press and hold MB1 on either
stepper arrow.

Continuously through the text one
window of text at a time

Press and hold MB1 in the scroll
region.

To a particlar position in the scroll
region

Click MB2 in the scroll region
above or below the slider.
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2222222222222222222222222222222222222222222222222222222222222
To scroll Do this2222222222222222222222222222222222222222222222222222222222222
To another location in the text Drag the slider to a position in the

scroll region that corresponds to
the general location you want to
see. If the slider is at the top of the
scroll region, you are viewing the
beginning of the text. If the slider
is in the middle of the scroll
region, you are viewing the middle
of the text. Cancel the drag by
clicking another mouse button
before releasing MB1.2222222222222222222222222222222222222222222222222222222222222

3.2.6 Special Menus to Manage Windows
The preceding sections describe how to manage windows by using
the buttons and resize borders on the windows’ frames. You can
access many of these features by using the Window menu.
Additionally, you can customize and control your DECwindows
environment with the Workspace menu.

The Window menu contains menu items for working with
windows. To display a Window menu, click on the Window Menu
button on the left corner of the title bar:
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Move

Restore

Minimize

Size

Maximize

Workspace

Lower

Close

Help

Alt + F5

Alt + F7

Alt + F8

Alt + F9

Alt + F10

Alt + F3

Alt + F4

The workspace is the background of your workstation screen; it is
the area of your screen that has no windows, dialog boxes, or
icons covering it. The Workspace menu contains general
information for arranging windows and customizing the window
manager. To display the Workspace menu, press MB1 or MB3 on
the workspace:

 

Workspace

Shuffle Up

Shuffle Down

Next Window

Previous Window

Pack Icons

Options

Restart

Help
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You can also display the Workspace menu by choosing Workspace
from the Window menu.

3.2.6.1 Using the Workspace Menu to Arrange Windows

When you are working with stacked windows and select a
window, the selected window moves to the front of the stack and
is given input focus. But if a larger window obscures a smaller
window, you cannot select that small window without moving the
larger window out of the way. If you use the title bar to move the
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larger window, you disrupt your work arrangement.

Use the window-arranging options on the Workspace menu to
shuffle your windows without moving them to another location.
The options are Shuffle Up, Shuffle Down, Next Window, and
Previous Window.

The Shuffle Up and Shuffle Down menu items raise and lower
windows on the screen without affecting input focus.

You can shuffle the windows on the screen until a hidden window
is displayed and then continue to type in the large window. If no
windows are obscuring other windows, shuffling the windows has
no effect.

The Next Window and Previous Window menu items change
which window is active. The active window is raised to the top of
the screen.

The Next Window and Previous Window menu items are useful if
you want to circulate through all the windows on the screen. Using
these options differs from shuffling windows. Next Window
always brings you to the next window even if it is not obscured
and always makes that window active.

For example, suppose you have three windows: a clock, the
Session Manager window, and a DECterm window. The DECterm
window is active. If you select Next Window, then the clock may
become active. If you select Next Window again, then Session
Manager window becomes active. If you choose Previous
Window, then the clock becomes active again.
2222222222222222222222222222222222222222222222222222222222222
To Do this2222222222222222222222222222222222222222222222222222222222222
Raise the bottom-most window to
the top of the screen

Choose Shuffle Up from the
Workspace menu.

Lower the top-most window to the
bottom of the screen

Choose Shuffle Down from the
Workspace menu.

Give input focus to a previously
active window

Choose Next Window from the
Workspace menu.

Give input focus in the reverse
order of Next Window

Choose Previous Window from the
Workspace menu.2222222222222222222222222222222222222222222222222222222222222
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3.2.7 Customizing Your Windows
The DECwindows Motif window manager (mwm) controls the
way your windows look (for example, the style and contents of the
title bar) and behave when you are working with them. By using
the Workspace options menu, you can customize your workspace
and windows to suit your working needs and style. For more
information about customizing the window manager, see Chapter
6. For advanced topics in customizing, see Chapter 9.

3.3 Interacting with DECwindows
You interact with DECwindows applications by using a mouse or
keyboard to make selections from menus or in special windows
called dialog boxes. DECwindows applications generate message
boxes, informing you of status or errors, for example.

When using DECwindows, some tasks are easier to perform with a
mouse and some are easier with a keyboard. Try both mouse and
keyboard techniques and use each where it works best. For more
information about keyboard techniques and procedures, see
Appendix A.

This section describes how to use menus, dialog boxes, and
message boxes to interact with DECwindows applications.

3.3.1 Working with Menus

 

Applications

Bookreader
CDA Viewer

Calendar
Cardfiler

DECterm
Mail
Notepad

Differences
XTerm

Paint

Print Screen

Calculator

Clock

Many times you interact with windows applications by selecting
items from a menu. The names of menus available in an
application appear on its menu bar.

When working with DECwindows Motif, there are three types of
menus. You access these menus in different ways, but all present
a selection of items. The menu types are:

• Pull-down menus

Pull-down menus are found in an application’s menu bar.
‘‘Pull-down’’ refers to the way the menu is displayed when
you click on its name. Some pull-down menus contain
commands; others list the names of items you can work with.

To display a pull-down menu, on the menu bar, point to the
menu name and press and hold MB1. To select an item, while
holding MB1, drag to the item you want and release MB1.

• Pop-up menus

Pop-up menus often duplicate commands that are available
from pull-down menus. They can be displayed anywhere on
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the applications work area to give you quick access to files or
commands.

To display a pop-up menu, press and hold MB3 on the
application’s work area and drag to the menu item you want.
Release MB3 to choose the item.

• Options menus

Options menus appear in a dialog box. Only the current option
is displayed until you click on the menu. To display an options
menu, press and hold MB1 on the current option. To select an
item, hold and drag MB1 to the item you want, then release
MB1.
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Sunday Sunday

Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

You can also display a menu by clicking MB1 on the menu name.
To choose an item, click MB1 on the item.

To cancel any menu selection and dismiss the menu, drag the
pointer outside the menu and release the mouse button.

Any menu can contain submenus: An arrow next to a menu item
indicates that a submenu will be displayed when you choose that
menu item.

 

On Window Manager...Help

On Version...
On Terms...
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If you select a menu item that is followed by three periods (...), a
dialog box will appear.

Some applications, such as Mail, offer rectangular push buttons
to duplicate frequently used commands that are also available as
menu items. Push buttons are usually found underneath the area
where the application’s text and graphics are displayed. To
execute these commands, click MB1 on the push button.
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3.3.1.1 Two Menu Shortcuts

Menus contain two shortcuts that you can use with your keyboard:
accelerators and mnemonics.

An accelerator is a key or sequence of keys on your keyboard that
you can use to execute a function in a menu. Accelerators are
listed in the menu to the right of the function items if they are
available for that function.

A mnemonic is an underlined letter in a menu name or a menu
item. Mnemonics let you display menus and perform tasks by
typing letters on your keyboard.

For more information about using keyboard accelerators, see
Appendix A.

3.3.1.2 Using Tear-Off Menus

Most DECwindows applications allow you to tear off pull-down
menus. Tear-off menus let you keep frequently used menus
displayed without repeatedly pulling them down. To tear off a
menu:

1. Display a pull-down menu.

If the menu is a tear-off menu, a dotted line appears at the top
of the menu.

2. While holding MB1, drag the pointer to the dotted line; then
release MB1.

The menu will change its appearance and resemble a small
dialog box. You can move it to a more convenient location.
The menu remains active until you close it or until the parent
application is closed.

3–14 Working with Windows



 ZK−0995U−R

Clock

HelpFile 

Display...

Alarm...

Save Options

Restore System Options

Options

Clock

HelpFile Options

Display...

Alarm...

Save Options

Restore System Options

Clock Options

Display...

Alarm...

Save Options

Restore System Options

HelpFile Options

Apr 22 Fri

02:00 PM

To close a tear-off menu:

1. Click on the Window menu button in the tear-off menu. (The
window menu button is described in Section 3.2.1.)

2. Choose the Close menu item.

3.3.2 Working with Dialog Boxes
A DECwindows application displays a dialog box whenever it
needs additional information from you to carry out a task.
Sometimes you need to type text; other times, you need only click
on a button to change a setting.
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DECburger:  Order Entry Box

Rare

Well Done

Medium

Ketchup

Mustard

Pickle

Onion

Mayonnaise

Fries

Size Medium

Drinks

Quantity

0
Quantity 0 Quantity 0

Cola

Apple Juice

Orange Juice
Grape Juice

Punch
Root Beer
Water

CancelResetOK Apply

Radio Button

Slider

Check Button

List Box

JONES

Push Buttons

Options Menu

Text−Entry Box

Hamburgers

3.3.2.1 Changing Information in a Dialog Box

Dialog boxes offer various devices, illustrated above, to supply
information to an application:

• Text-entry box

A text-entry box is an area in a dialog box where you type
information.

An insertion cursor is visible in each text-entry box. The
insertion cursor, which blinks when the text-entry box has
input focus, shows you where the text you type will appear.
What you type appears to the left of the insertion cursor. Use
the 331

33
(Delete) key to correct typing mistakes.

• Diamond-shaped radio buttons and square check buttons

Click on a radio button to select one option from many. Click
on a check button to turn a setting on or off. A selected radio
or check button is dark filled.
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• Slider and scale

Dialog boxes often contain a scale and slider when you need to
supply a numeric value. The arrow in the slider points to the
current value. Drag the slider to change the value.

• List box

Choose one of several items by clicking on one in a list box.
Scroll bars appear if the choices do not fit in the list box.

• Push button

Click on a push button, such as OK, Apply, or Cancel to tell
an application what to do with the information you supplied in
the dialog box.

Note

A double border around a push button indicates
that it is the default option. Default options are
those that the application designer anticipates users
will most frequently choose. Usually, the OK
button is the default option in a dialog box.
Whenever you see a button with a double border,
pressing Return achieves the same result as
clicking on that button.

Usually, the easiest way to interact with a dialog box is with the
mouse, as just described. You can also interact with dialog boxes
using just the keyboard. See Appendix A.

3.3.2.2 Saving Your Settings

Once you change the settings you want, click on either the OK or
the Apply button and the new settings will take effect. If you
decide not to change the settings, click on the Cancel button.
Some applications might save or apply settings in different ways.
Refer to the individual application’s help for more information.

Many dialog boxes also have a Help button. Click on the Help
button if you need more information about the dialog box and
selections you can make.

3.3.2.3 Making Selections from List Boxes

A list box is part of a dialog box that contains a list of items, often
file names, from which you can choose. Many applications
display a list box when you open or save a file.
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To select an item from a list box, position the pointer on the item
and click MB1. The item you select is highlighted.

 

Menu Names

Applications
Commands
Control
Customize
File
Files
Games
Help
Options
Options {Session Manager}

<Background>
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If an application needs a file name to complete a task, it displays a
file selection box.
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Notepad: Open

/usr/users/jones/*

.

..

Mail
OSF.INFO

.Mail

.X11Startup

.X11Startup_motif

.Xdefaults

.Xdefaults.old

.Xdefaults_motifbin

/usr/users/jones/
^

IDC

A file selection box contains a list box that displays a list of files
in the current directory.

To open or use a file, click on a file name in the list box to select
it, then click on OK. Alternatively, simply double click on the file
name.

If you want to work with a file that does not appear in the list box,
type the name of the file in the Selection text-entry box and click
on OK. Or, use the Filter text-entry box to list a subset of files
from which you select.

For example, if you are running Bookreader, your entry in the
Filter text-entry box might look like this:
/usr/staff/jones/*.decw_book
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3.3.3 Working with Message Boxes
Applications use message boxes to convey information to you.
Message boxes can:

• Notify you that an application is starting

• Ask you to confirm a request

• Provide status on an application or particular task

• Ask you if you want to proceed with a task

Click on OK to dismiss a message box.
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4Performing Common Tasks3333333333333333333333
DECwindows applications let you perform many basic tasks the
same way. For example, both Mail and DECterm handle text in
the same way. This chapter describes how to:

• Edit text

• Print files

• Mix colors

• Run applications across the network

4.1 Working with Text

 

Edit

Copy

Select All

Your applications provide many shortcuts to editing text that save
you from retyping long file names or large blocks of text. Most
applications, including the desktop applications, let you move and
copy text:

• From one place in a window to another.

• From one window to another window. For example, you can
copy text from one Create–Send window in Mail to another.

• From one application to another application. For example, you
can move a picture from Paint onto a Cardfiler card.

In addition, most applications provide an Edit menu to cut, copy,
and paste text and graphics.

Finally, most applications define specific keys to let you perform
basic text editing. These keys, described in Section 4.1.4, let you
move the cursor and delete small amounts of text efficiently.

4.1.1 Selecting Text
Before you can delete, copy, or move text to other locations within
a window or between windows, select the text. You can select a
word, a line, or any amount of continuous text.

The following table summarizes the ways to select text:



2222222222222222222222222222222222222222222222222222222222222
To Do this2222222222222222222222222222222222222222222222222222222222222
Position the cursor where you want
the selection to start

Point to the location and click
MB1.

Select a word Point to the word and double click
MB1.

Select a line Point to the line and triple click
MB1.

Select a screen of text Point to the text and click MB1
four times.

Select continuous text, from the
original selection point to the point
where the button is released

Press and hold MB1 and drag the
pointer through the text.

Extend the current selection Simultaneously press and hold
Shift and MB1 while dragging the
pointer through the additional text.

Extend the current selection to
where the pointer is positioned

Press and hold Shift and click
MB1.2222222222222222222222222222222222222222222222222222222222222

You can select only one piece of text at a time. By selecting text
in one application, you cancel any other text selection established
in the same window or in another application.

4.1.2 Copying Text
After you select text, you can copy it anywhere within a window if
the application supports text editing. You can also copy between
such applications or from a terminal emulator window to a
window that supports text editing. You can copy text in different
ways—the choice depends largely on which window you want
active after completing the copy operation.

To copy text in windows:

1. Select the text to copy, using the text selection techniques
described in Section 4.1.1.

2. Position the cursor where you want the text copied by pointing
and clicking MB1.

3. Click MB2.

The text is copied to the new location.
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Some applications use different methods for copying text. See that
application’s documentation for an explanation of how to copy
text in that application.

When copying text between windows using the method just
described, the window in which you select the text takes input
focus. If that window is not the one in which you are currently
working, and to which you copied the text, then you have to
reestablish focus to continue your work once you finish the copy.
(This scenario doesn’t apply if you have customized your
workspace to use pointer focus instead of explicit focus. See
Section 6.1.)

QuickCopy is a way to grab a piece of text from another window
without changing focus. QuickCopy cannot be used if you use
pointer focus.

To use QuickCopy:

1. In the current window, position the cursor where you want the
text to be copied to by pointing and clicking MB1.

2. In the other window, point to the text you want to copy.

3. Press and hold MB2.

4. Drag across the text you want to copy.

The text is highlighted as you drag across it.

5. Release MB2.

The text is copied to the new location in your current window.

To move text from one window to another:

1. In the current window, position the cursor where you want the
text pasted by pointing and clicking MB1.

Make sure the window has input focus.

2. In the other window, point to the text you want to move.

3. Press and hold Ctrl+MB2.

4. Drag across the text you want to move.

The text is highlighted as you drag across it.

5. Release Ctrl+MB2.

Some applications use different methods for moving text. See each
application’s documentation for an explanation of how to move
text in that application.
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4.1.3 Deleting Text with Pending Delete
If you select some text (as described in Section 4.1.1) and then
type new text, the selected text is deleted with the first keystroke.
Deleting selected text this way is called pending delete. With
pending delete, you can delete large blocks of text with one
keystroke instead of pressing the 331

33
key repeatedly.

To avoid pending delete after you select some text but before you
press a key, point to the selected text and click MB1. This cancels
the select.

4.1.4 Text Editing Key Definitions
You can use the text editing techniques described in the following
table to move the cursor or delete text in most DECwindows
applications. Use the arrow keys to move the cursor one character
at a time.
2222222222222222222222222222222222222222222222222222222222222
To Press2222222222222222222222222222222222222222222222222222222222222
Move the cursor to the next word Ctrl+ →
Move the cursor to the previous word Ctrl+←
Select text to the right of the cursor Shift+→
Select text to the left of the cursor Shift+←

F12 or Ctrl+HMove the cursor to the beginning of the
line

Move the cursor to the end of the line Shift+F12 or Ctrl+E

TabMove the cursor forward between text-
entry boxes

Shift+TabMove the cursor backward between
text-entry boxes

F13 or Ctrl+JDelete the characters to the left of the
cursor up to and including the beginning
of the word

Shift+F13Delete the characters to the right of the
cursor up to and including the end of the
word

Delete the character to the left of the
cursor and move all text to the right of
the deleted character one space to the
left

331
33

4–4 Performing Common Tasks



2222222222222222222222222222222222222222222222222222222222222
To Press2222222222222222222222222222222222222222222222222222222222222
Delete the character after the cursor and
move all text to the right of the deleted
character one space to the left

Shift+ 331
33

In overstrike mode,
Shift+ 331

33
deletes the

character under the block
cursor.

Ctrl+UDelete all characters to the start of the
line

Refresh the window Ctrl+R2222222222222222222222222222222222222222222222222222222222222

4.1.5 Copying Text with Drag and Drop

 

The drag-and-drop feature lets you move or copy text appearing in
screen objects. Most often, you use this feature to copy text from
one text-entry field to another (although text appearing in a dialog
box, a label, or a button can also be moved). For example, select
text from a card in the Cardfiler desktop application and transfer it
to the Notepad. (These desktop applications are discussed in
Chapter 5.)

To drag and drop text into a new location:

1. Select the text with MB1. (Text such as error messages cannot
be selected. Start with the next step for such text.)

2. Point to the text. To move it, press and hold MB2; to copy it,
press and hold Ctrl and MB2.

A move or copy icon appears.

3. Drag the icon to the location where you want to drop the text;
then release MB2.

If an object is highlighted as you drag the icon across it, you
can drop the text into it. For example, you can drop the text
into a text-entry field.
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4.2 Printing Files

 

File

Print...

Print

Extract

Move

Copy

Open−Close

Ctrl+P

Ctrl+M

Receive Mail

Exit Ctrl+E

You can print the information displayed by applications that you
use. For example, print a mail message, or print a drawing you
create in Paint.

When you choose the Print menu item in an application, the
application sends a file to the printer. While your job is being
printed, you can continue to work in your current application or go
on to other tasks.

To print something currently being displayed on your screen—for
example, a mail message—choose Print from the application’s
menu options. The file is sent to the printer specified as the value
of the PRINTER environment variable. (The Command and Shell
User’s Guide explains how to set environment variables.) If you
choose Print..., a print dialog box will appear in which you can
specify additional printing options.

4.3 Mixing Colors

 

Many applications let you choose your own colors for window
components. If an application provides this option, it displays a
color mixing dialog box when you choose certain settings. For
example, the color mixed illustrated above is displayed when you
customize window border colors as explained in Section 6.2.

Use the color mixer’s Color Model options menu to choose one of
the following color models for selecting and defining colors:

• Picker

• Hue, Lightness, Saturation (HLS)

• Red, Green, Blue (RGB)

• Browser

• Gray Scale

You can use each of these models alone, or you can use them in
any combination. For example, you can use any color model to
select a color and use the Picker color model to blend the selected
color.

4.3.1 Using the Color Picker
The Picker is the default color model for the color mixer. It
contains the following components:
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Color
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Color
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Arrow
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The color display box displays colors as you mix them.

The color spectrum is a static collection of colors.

The Spectrum options menu lets you set the spectrum to one of
the following common color palettes:

• Spectrum (white, red, orange, yellow, green, blue, blue-violet,
violet, brown, and black)

• Pastels

• Vivids

• Earthtones

The four color palettes provide a wide variety of colors from
which you can choose. The Spectrum options menu also includes
any palettes specific to an application.

When you click MB1 on a spectrum tile or interpolator tile, that
color becomes the new color. The tile is highlighted, identifying it
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as the currently selected color.

You can use the selected color without modification, or you can do
one or more of the following tasks:

• Use the interpolator to smear (blend) the selected color into
various shades

• Use the arrow buttons to make the color lighter or darker,
warmer or cooler

• Switch to another color model and use the features of that
model to modify the current selection

Use the two paint buckets to load the interpolator with the colors
to smear:

1. Click MB1 on a spectrum tile or interpolator tile.

The color display box displays the color of that tile.

2. Click on a paint bucket, which fills the interpolator end tile
below it with the selected color.

3. Fill both interpolator end tiles or one; the color of the empty
interpolator end tile defaults to white.

As an alternative to the paint buckets, use the eyedropper to load
the interpolator. Clicking and holding MB1 on a spectrum or
interpolator tile, the original color tile, or the new color tile causes
the pointer to become an eyedropper filled with the color of that
tile.

Move this eyedropper to the interpolator and use it to fill one of
the two end tiles by clicking MB1 on one of the tiles. If you do
not position the eyedropper directly on one of the two end tiles,
the tile closest to the end is filled with the eyedropper color. Note
that the cursor must be inside the interpolator.

Use the Undo button to reverse the last interpolator action, which
can be a smear, the filling of an end tile, or the activation of one
of the warmth or lightness adjustment buttons.

4.3.2 Using Other Color Models
You can also change colors by selecting one of the following
models from the Color Model options menu:

Hue, Lightness, Saturation (HLS)
The HLS color model contains three scales that represent the
ranges of hue, lightness, and saturation. Use the scales to
change the color as follows:
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• Hue is color.

• Lightness is color intensity; that is, the amount of the
color.

• Saturation is the purity of the color, or how much the
color is diluted by white.

Red, Green, Blue Color Model (RGB)
The RGB color model contains three scales that represent the
color ranges for red, green, and blue. Specify a color by
indicating the intensity of color on each of the three scales.

Browser
The Browser color model displays the colors listed in
/usr/lib/X11/rgb.txt. Each tile in the window
displays a different color along with the color name. Use the
scroll bar to display the entire list. Click MB1 on a tile to
select a color. The color display box becomes filled with that
color. The browser color model is available on all systems.

Gray Scale
The Gray Scale color model contains a scale that lets you mix
gray shades ranging from black to white. Note that switching
to the Gray Scale color model converts the current new color
to gray.

4.3.3 Using the Scratch Pad
The scratch pad lets you store intermediate colors for later use in
color mixing.

To access the scratch pad, click on the scratch pad button in any of
the color models.
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Scratch Pad...

Save colors here...

Clear Cancel

Paint Bucket to
Load Scratch Pad

To store the currently selected color in the scratch pad, click on
the paint bucket above the scratch pad color tile. The scratch pad
adds that color to its list of stored colors. You can scroll through
the list with the scroll bar.

Use the Clear button to cancel this list and return the scratch pad
to its initial state.

Note that the currently selected color can be one of many color
tiles on the Picker color model. When using other color models,
however, you can select only the new and original color tiles.

To set the new color tile to a scratch pad color, scroll to the new
color and click on the scratch pad color tile. The new color tile
changes, and the scratch pad tile is highlighted. In the Picker color
model, this highlighting indicates that the scratch pad color can
now be dumped into one of the interpolator end tiles by using the
paint bucket buttons.

4.4 Running Applications Across the Network
A typical work environment might include a single workstation
running DECwindows and displaying applications. Because
DECwindows functions across networks and operating systems,
you can make the most of your computer resources by running
applications—applications you might not have on your
workstation—from another computer for local display on your
monitor.

Remotely run applications always appear to be running on your
workstation but allow you to take advantage of larger computers
that may be better suited for a specific computing task.
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This section describes how to run a remote application from a
remote node and includes information on how to:

• Authorize access to your workstation

• Log in to a remote host running either the Digital UNIX,
ULTRIX, or OpenVMS operating system

• Run applications for display on your workstation

4.4.1 Authorizing Access to Your Workstation
Before using your workstation to display remotely run applications
you must authorize the remote computers or hosts to access your
display. Use the Security... menu item in the Session Manager
Options menu to add the names of those hosts to which you are
connected by means of a Transmission Control Protocol/Internet
Protocol (TCP/IP) or DECnet network. You must have an account
on the remote host in order to log in to start the application.

To grant access to specified remote hosts:

1. Choose Security... from the Session Manager Options menu.
This dialog box appears:

 

Security Options

Authorized Hosts

Hostname

Apply Cancel Help

Add
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OK

fluffy.zk3.dec.com
furface.zk3.dec.com

Remove

tomcat.zk3.dec.com
pusscat.zk3.dec.com

2. Click MB1 in the Hostname text field and type the host name.

If the connection between your system, and the remote host is
through the DECnet network, use DECnet syntax, which
requires two colons (::) after the host name. If your connection
to the remote host is through the TCP/IP network, colons are
unnecessary. Ask your system manager if you don’t know your
network type.
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3. Click on the Add button.

The host name appears on the list of authorized hosts.

4. Click on OK to dismiss the dialog box.

4.4.2 Enabling the Display
After registering remote hosts, you are ready to run applications on
the remote host. Remember you must have an account so that you
can log in and start the application.

To run an application on a remote host for display on your Digital
UNIX workstation screen:

1. Open a terminal window on your workstation and, using the
rlogin (for TCP/IP) or dlogin (for DECnet) command,
log in to the remote host.

2. On the remote host, specify which workstation screen you
want the application displayed on:

From a Digital UNIX or ULTRIX remote host:

If you use the C shell, enter this command at the system
prompt:
setenv DISPLAY your-workstation:0

If you use the Bourne or Korn shell, enter these commands at
the system prompt:
DISPLAY=your-workstation:0
export DISPLAY

Here, your-workstation is the name of your local
workstation. The single colon indicates that the connection
between your system and the remote host is through TCP/IP.
Use two colons (::) after your workstation name if the
connection is through a DECnet network. The 0 indicates that
your workstation has just one monitor, or if it has two, the 0
specifies display on the first monitor. With two monitors, a 1
could be substituted to specify display on the second monitor.

From an OpenVMS remote host:

Enter the following command at the system prompt:
set display/create/node=your-workstation

Here, your-workstation is the name of your workstation.
The network connection is assumed to be DECnet. If the
OpenVMS node is running a product such as DEC TCP/IP
Services for OpenVMS, you can specify TCP/IP as the
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network transport with the following command format:
set display/create/transport=tcpip/node="your-workstation"

Without the quotes in this command, OpenVMS would
translate your workstation’s host name to all uppercase letters.
However, the name of your workstation may have been
explicitly entered in lowercase in the OpenVMS TCP/IP hosts
database. If so, you must enclose the workstation name in
quotation marks (" "), as shown in the last command, to
preserve any lowercase letters in the name. If you are unsure of
how your workstation name has been entered, use the
hostname command in a DECterm on your workstation.

3. Enter the command that starts the application you wish to run
remotely and display on your local workstation.

See Chapter 5 for the commands used to start DECwindows
applications.

Note

You cannot run the Session Manager from a
remote host for display on your workstation.
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This chapter introduces the following Digital UNIX DECwindows
Motif desktop applications:
222222222222222222222222222222222222222222222222222222222222222
Use this application To222222222222222222222222222222222222222222222222222222222222222
Bookreader Display online documentation on your

workstation screen.

Calculator Perform mathematical operations like a handheld
calculator.

Calendar Keep track of your scheduled appointments and
plan your time.

Cardfiler Organize your information with index cards and
card files.

CDA Viewer Display the contents of many different types of
files on your workstation screen.

Clock Display the time of day (in both analog and
digital format) and the date on your workstation
screen.

DECterm Create a window that emulates a VT300 series
terminal.

Mail Exchange messages with other computer users.

Notepad Create letters or notes and save them to a file for
later use.

Paint Create a picture or an illustration.

Print Screen Take a snapshot of your entire screen or just a
portion of it and print the file containing the
snapshot now or later.

Visual Differences Browse through a graphical display of the
differences between two files.222222222222222222222222222222222222222222222222222222222222222



5.1 Starting Applications
To start any of the Desktop Applications, you can choose the
application from the Session Manager Applications menu or have
the Session Manager automatically start the application. For more
information about the Session Manager and automatic startup, see
Chapter 7.

You can also start these applications by entering a command in a
terminal emulator window (DECterm). For example, to start Paint,
enter the following command:
/usr/bin/X11/dxpaint &

Table 5-1 lists each DECwindows Motif application and its
corresponding command as found in /usr/bin/X11. Your
command must include the full path unless you add
/usr/bin/X11 to your path in your .login or .profile
file. (The Command and Shell User’s Guide explains how to
modify your path.)

The ampersand (&) at the end of the command line causes the
application to start in the background, allowing you to perform
other tasks in your terminal window.

With many applications you can specify on the command line a
file for the application to open, for example:
/usr/bin/X11/dxpaint mypicture.img &

When Paint starts, it will display the image file
mypicture.img.

Table 5-1:   Starting DECwindows Motif Applications
2222222222222222222222222222222222222222222222222222222222222
To start this application Use this command2222222222222222222222222222222222222222222222222222222222222
Bookreader dxbook

Calendar dxcalendar

Calculator dxcalc

Cardfiler dxcardfiler

CDA Viewer dxvdoc

Clock dxclock

DECterm dxterm

Mail dxmail

Notepad dxnotepad

Paint dxpaint
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Table 5-1:   (continued)
2222222222222222222222222222222222222222222222222222222222222
To start this application Use this command2222222222222222222222222222222222222222222222222222222222222
Print Screen dxprint -X

Visual Differences dxdiff2222222222222222222222222222222222222222222222222222222222222

5.1.1 Changing Settings
Each application starts with a set of predefined, or default, options.
Many applications let you change these default settings by means
of an Options or Customize menu. For example, you can:

• Use the Session Manager Options menu to enable security
options, change your keyboard language, or change the way
the Session Manager starts applications

• Use the Mail Customize menu to select who you want copied
on mail replies or select a preferred main window style

• Use the Notepad Options menu to set word-wrap, case-
sensitive searches, and font attributes

Pull down the application’s Options or Customize menu to see
which settings you can change.

5.1.2 For More Information
For complete information about using each application, pull down
the Help menu on any window and choose the menu item for the
area where you need help.

For more information of using the help menu, see Section 2.2.

If you or your system manager installed the reference page subset
on your system, you can also look up reference information for
each application by using the man command in a terminal
window.

Use the command name described in Table 5-1 as input to the
man command. For example, to read the Paint reference page,
enter the following command in a terminal window:
% man dxpaint

You can also read reference pages with the Bookreader software.
Section 5.2 provides more information on the Bookreader. Click
on the Digital UNIX Operating System bookshelf to find the
Reference Pages bookshelf. The reference pages for the
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applications described in this chapter are available in Reference
Pages Section 1.

5.2 Using Bookreader

 

With the Bookreader software, you can read online documentation
on your workstation screen. To start Bookreader, see Section 5.1.
When the Bookreader starts, libraries of books available from
Bookreader appear in a library window:

 ZK−2638A−GE

Bookreader: Library

HelpViewFile Search

Using Bookreader

Sample Library

Library 2

Libraries contain groups of related book titles. Each library and
title has an icon to the left of it to indicate whether it is a library
or a book.

To display the titles of books in a library, double click on the
library. A list of book titles for that library appears.

5.2.1 Opening a Book
To open a book, double click on the book’s title in the library
window. The table of contents for the book you opened appears in
a navigation window on your screen:
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HelpViewFile 

Using the Bookreader

Sample Library

Library 2

Using Bookreader

HelpViewFile 

Contents

Figures

Index

Title Page

Copyright Page

1 Bookreader

Search

Search

5.2.1.1 Locating Topics in the Navigation Window

The navigation window contains the main sections of the book,
which are typically:

Contents
Figures
Tables
Examples
Index

Notice that some topics are preceded by arrows:

• An arrow that points to a topic indicates that the topic contains
subtopics that do not appear on the screen at the moment.

To display the subtopics, double click on the topic’s arrow.
Alternatively, you can click on the topic’s arrow and choose
Expand or Fully Expand from the View menu.
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• An arrow that points downward indicates that the subtopics are
already displayed on the screen. Double click on the downward
arrow to turn off display of the subtopics or click on the
topic’s arrow and choose Collapse from the View menu.

5.2.2 Opening a Topic to Read Text
To open a topic for reading, double click on the topic listed in the
navigation window. The topic you opened appears in a new
window called the topic window, as shown in the next illustration.
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This document describes how to use Bookreader
to read online documentation.

Using Bookreader

Topic Screen

ZK−2643A−GE

Go Back Close

Search

Use the buttons and arrows at the bottom of the window to move
through the text. To close the topic that is displayed on the screen,
click on the Close button:

 
Close

To move to the next topic or the previous topic, click on the arrow
to the right or the left of the word Topic:

 
Topic

To go back to one or more of the topics viewed previously, click
on the Go Back button until you reach the topic you want. A
dimmed button, as shown, means that you are at the first topic:
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Go Back

To move to the next screen or the previous screen, click on the
arrow to the right or the left of the word Screen. If the end of the
current topic appears, moving to the next screen opens the next
topic.

 
Screen

You might want to display more than one topic at a time. For
example, you can open an appendix in one topic window while
browsing through a chapter in another. Click on the topic in the
navigation window or on a hotspot in topic window and choose
the Open Topic in New Window menu item from the File menu.
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A Using DECwindows with a Keyboard

5.2.2.1 Navigating with Hotspots

Hotspots are highlighted cross-references in the text. The
highlighting is a box that surrounds the text of the reference such
as a table, figure, or section title.
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View Search

in a terminal emulator window.  For example, to start Paint,
enter the following command:

% /usr/bin/X11/dxpaint &

Table 5−1      lists each DECwindows Motif application and its
corresponding command as found in /usr/bin/X11 .  You must
enter the full path as illustrated above or define this path−

Highlighted
hotspot

When you double click on a hotspot, Bookreader takes you
directly to the referenced area. This saves you from going back to
the table of contents and opening a new topic. The cross-
referenced text replaces the current text in the topic window.

By default, hotspots are highlighted only when you position the
pointer on them. You can turn on continuous highlighting by
choosing Hotspots from the View menu.

5.2.2.2 Displaying Figures, Tables, and Examples

When you double click on a highlighted figure, table, example, or
footnote, the reference appears in a separate window.

Text or part of a graphic may sometimes be hidden by the window
boundaries. This happens when the width or length of the text or
graphic is larger than the window. Use the horizontal or vertical
scroll bars to display the hidden area, or use MB1 to enlarge the
window (see Section 3.2.4).

5.2.3 Summary of Other Bookreader Features
Other Bookreader features allow you to:

• Access a library that is not included in the list of default
libraries or specify a library that resides in your directory
under a file name with the .decw_bookshelf file
extension
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• Read a book that is not included in the default libraries or read
books that reside in your directory under file names with a
.decw_book extension

• Open multiple books in separate windows

For more information, use the online Help for Bookreader.

5.2.4 Something to Try
If you have not already done so, try starting Bookreader now.
Double click on in the library window and practice some of the
techniques described in this section.

5.3 Using Calculator

 

Calculator functions like a handheld calculator: It performs simple
arithmetic functions—addition, subtraction, multiplication,
division—and computes percentages and square roots. Calculator
also performs trigonometric and inverse trigonometric functions,
generates random numbers, and performs other more advanced
operations. To start Calculator, see Section 5.1.

Unlike a handheld calculator, Calculator has two displays. The top
display is the accumulator, which shows the number being entered
or the current result, and the bottom display is the memory.

This section describes how to:

• Change from decimal mode to hexadecimal or octal mode

• Enter data

• Perform arithmetic functions

• Use the memory

• Perform special functions

• Transfer data to or from other applications

• Save customized settings
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5.3.1 Changing the Mode

 

Hexadecimal

Octal

Decimal Ctrl+D

Ctrl+H

Ctrl+O

Mode Calculator has three modes: decimal, hexadecimal, and octal. To
change Calculator to hexadecimal mode, choose Hexadecimal
from the Mode menu. Calculator appears on your screen in
hexadecimal mode as shown in the following figure.

 ZK−2867A−GE
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To change Calculator to octal mode, choose Octal from the Mode
menu. Calculator appears on your screen in octal mode as shown
in the following figure.
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5.3.2 Entering Data
You can use Calculator with either the mouse or the keyboard.

• With the mouse, point to the appropriate button and click
MB1.

• From the keyboard, press the keys listed in the following table.
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2222222222222222222222222222222222222222222222222222222222222222222222
Keyboard Key ProducesKeypad or Special-

Function Key2222222222222222222222222222222222222222222222222222222222222222222222
All Modes2222222222222222222222222222222222222222222222222222222222222222222222
0–9 0–9 Numbers 0–9 (0–7 in

octal mode)

/ PF2 /

* PF1 *

– – –

+ , +

= Enter =

MC Ctrl+F4 MC

MR Ctrl+F5 MR

M+ Ctrl+F6 M+

M– Ctrl+F7 M–2222222222222222222222222222222222222222222222222222222222222222222222
Decimal Mode2222222222222222222222222222222222222222222222222222222222222222222222
. . .

P pi

N PF3 +/-

% PF4 %

C Shift+F1 Clear

E Shift+F2 Clear Entry

D Ctrl+F8 deg (switches the
trigonometric
argument type: deg,
rad, or grad)

! Ctrl+F9 x! (x factorial)

~ Ctrl+F10 1/x

R Ctrl+F11 Rnd

I Shift+F3 Inv (switches sin, cos,
and tan to the inverse)

S Shift+F4 sin (sine)

O Shift+F5 cos (cosine, or
arccosine if Inv is on)

T Shift+F6 tan (tangent, or
arctangent if Inv is on)

LO Shift+F7 log (or 10 to x if Inv
is on)

LN Shift+F8 ln (or e to x if Inv is
on)

Q Shift+F9 square root function
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2222222222222222222222222222222222222222222222222222222222222222222222
Keyboard Key ProducesKeypad or Special-

Function Key2222222222222222222222222222222222222222222222222222222222222222222222
^ Shift+F10 y^x (or y to the 1/x if

Inv is on)2222222222222222222222222222222222222222222222222222222222222222222222
Hexadecimal and Octal Modes2222222222222222222222222222222222222222222222222222222222222222222222
& Ctrl+F8 and

vbar Ctrl+F9 or

^ Ctrl+F10 xor

Ctrl+F11 nor

~ Shift+F9 not

! Shift+F10 neg

C (octal only) Shift+F1 Clear

E (octal only) Shift+F2 Clear Entry2222222222222222222222222222222222222222222222222222222222222222222222
Hexadecimal Mode2222222222222222222222222222222222222222222222222222222222222222222222
A Shift+F3 A

B Shift+F4 B

C Shift+F5 C

D Shift+F6 D

E Shift+F7 E

F Shift+F8 F

Ctrl+C Shift+F1 Clear

Shift+F2 Clear Entry2222222222222222222222222222222222222222222222222222222222222222222222
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Memory
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Accumulator
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When you enter data into the accumulator, notice that Calculator
uses a radix separator (. or ,) to distinguish between entered digits
and an operand. To see this, enter the following data:

1. Enter 1134. Notice that a radix separator does not appear in the
accumulator.

2. Enter a plus sign (+). Calculator inserts a decimal point after
the number 1134 to signify the completion of an operand.

Depending on the contents of the accumulator, you can use one of
the following methods to correct mistakes in computation:

• To erase the last digit you entered into the accumulator, press
the 331

33
key.

• To clear the accumulator, click on the CE button.

• To reverse the last operation, choose Undo from the Edit
menu. For example, choose Undo to restore the last operand or
to remove the previous paste operation.
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5.3.3 Performing Arithmetic Functions
Calculator displays numbers in the range of plus or minus
99,999,999,999,999. Calculator performs all calculations in left-
to-right order and treats operators with equal importance.

For example, to evaluate the equation 6 + 5 * 3:

1. Find the sum of 6 + 5.

Calculator displays an 11.

2. Figure the product of 11 * 3.

The result is 33.

Also note the way Calculator computes percentages. For example,
to determine 6 percent of 195:

1. Enter 195.

Calculator displays the number in the accumulator.

2. Enter * and Calculator inserts a decimal point.

3. Enter 6.

The number 6 appears in the accumulator.

4. Enter %.

The result, 11.7, appears in the accumulator.

5.3.4 Storing Values in Memory
Use the memory display to store results and values for later
computation. The figure in memory starts as zero. You can add
the contents of the accumulator to memory or subtract the contents
of the accumulator from memory by using the M+ and M- buttons,
respectively. To enter the contents of memory into the
accumulator, click on the MR button. To clear the contents of
memory, click on the MC button.

5.3.5 Performing Special Functions
Calculator performs trigonometric and inverse trigonometric
functions as well as other special functions.

The special-function keys in decimal mode are as follows:

5–16 DECwindows Desktop Applications



2222222222222222222222222222222222222222222222222222222222222
Key Description2222222222222222222222222222222222222222222222222222222222222
Decimal Mode2222222222222222222222222222222222222222222222222222222222222
deg Degree key. Selects the units for angular measurement.

By default, Calculator is in degree mode. Clicking on
the deg key places Calculator in the radian mode,
which is indicated by the key label changing to ‘‘rad’’.
Clicking on the key again places Calculator in gradient
mode, which is indicated by the key label changing to
‘‘grad’’. The angular mode has no effect on Calculator
unless the trigonometric functions are being used.

x! Factorial key. Calculates the factorial (x)(x - 1)(x -
2)...(2)(1) of the displayed integer x, for integers
0≤x≤16. 0! = 1 by definition.

1/x Reciprocal key. Divides the displayed value x into 1, if
x is not 0.

Rnd Random number generator key. Generates a random
number between 1 and the integer of the display. It
does not generate negative numbers or numbers less
than 1.

Inv Inversion key. By default, Calculator performs
noninverted trigonometric functions. When you activate
the inversion key by clicking on it (which is indicated
by the key becoming darkened), Calculator performs
inverted trigonometric, log, and exponent functions.

sin Sine key. Instructs Calculator to find the sine (or
arcsine if Inverse is on) of the displayed value.

cos Cosine key. Instructs Calculator to find the cosine (or
arccosine if Inverse is on) of the displayed value.

tan Tangent key. Instructs Calculator to find the tangent (or
arctangent if Inverse is on) of the displayed value.

log Common logarithm key. Calculates the common
logarithm (base 10) of the number x in the display, if x
is greater than 0. If Inverse is on, calculates 10 to x.

ln Natural logarithm key. Calculates the natural logarithm
(base e) of the number x in the display, if x is greater
than 0. If Inverse is on, calculates e to x.

square root Square root key. Calculates the square root of the
number x in the display. The x value cannot be
negative.
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2222222222222222222222222222222222222222222222222222222222222
Key Description2222222222222222222222222222222222222222222222222222222222222
Decimal Mode2222222222222222222222222222222222222222222222222222222222222
y^x y to the xth power key. Raises the displayed value y to

the xth power (or y to the 1/x power if Inverse is on).
Order of entry is y y^x x. The y value cannot be
negative, but both x and y can be fractionals.2222222222222222222222222222222222222222222222222222222222222

The special-function keys in hexadecimal mode are as follows:
2222222222222222222222222222222222222222222222222222222222222
Key Description2222222222222222222222222222222222222222222222222222222222222
Hexadecimal Mode2222222222222222222222222222222222222222222222222222222222222
A Enter hexadecimal number A (decimal 10).

B Enter hexadecimal number B (decimal 11).

C Enter hexadecimal number C (decimal 12).

D Enter hexadecimal number D (decimal 13).

E Enter hexadecimal number E (decimal 14).

F Enter hexadecimal number F (decimal 15).2222222222222222222222222222222222222222222222222222222222222

The special-function keys in hexadecimal and octal modes are as
follows:
2222222222222222222222222222222222222222222222222
Key Description2222222222222222222222222222222222222222222222222
Hexadecimal and Octal Modes2222222222222222222222222222222222222222222222222
and In Boolean algebra, calculates logic

AND (both propositions are true).

or In Boolean algebra, calculates logic OR
(either proposition is true or both
propositions are true).

xor In Boolean algebra, calculates logic
XOR (either of the propositions is true).
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2222222222222222222222222222222222222222222222222
Key Description2222222222222222222222222222222222222222222222222
nor In Boolean algebra, calculates logic

NOR (both propositions are false).

not In Boolean algebra, calculates logic
NOT (negation).

neg In Boolean algebra, calculates NEG (the
complement of x).2222222222222222222222222222222222222222222222222

5.3.6 Copying Text

 

Copy

Paste

Undo Alt+Delete

Ctrl+Insert

Shift+Insert

Edit You can copy numbers from another application into Calculator’s
accumulator and from Calculator’s accumulator or memory into
another application.

To transfer data from the active display in the calculator window
to another application window, choose Copy from the Edit menu.
For example:

1. Click on the accumulator display.

2. Enter a number into the accumulator.

3. Choose Copy from the Edit menu, or for greater speed, press
and hold MB3 to display a pop-up menu and choose the Copy
menu item.

Now you can paste the data to another application’s window.

To copy data from another application, select the data and use the
application’s copy function. Then choose Paste from Calculator’s
Edit menu. You can paste a number, or you can paste an equation
like 4147.4*24=. Calculator will display the result,
99537.6. Calculator treats the contents of a paste operation just
as if you entered the data from the keyboard. The following figure
illustrates pasting an equation copied from a Cardfiler card into
Calculator.
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5.3.7 Saving Customized Settings
If you change the screen placement and size of Calculator during a
session and want to save those settings, choose Save Geometry
from the File menu. The next time you start Calculator, the display
reflects the new settings.

To restore the default size and placement of Calculator, choose
Restore System Settings from the File menu.
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5.4 Using Calendar

 

Jan
1

Calendar combines the functions of a desktop calendar and an
appointment book to help you keep track of your meetings and
plan your time. Calendar lets you look at the display for a full year
or month and also allows you to review your scheduled
appointments one day at a time. To start Calendar, see Section 5.1.

You can create several different calendars to use for specific
purposes. For example, you can create calendars to:

• Keep track of your personal engagements

• Schedule conference room reservations

• Share with a group for group meetings and activities

Calendar has three main displays: day, month, and year. When it
starts, Calendar presents the month display on your screen.
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The month display shows the current month and year with the
days of the month arranged in weekly rows. The current day has a
box surrounding it.

You can move among or within displays as follows:

• To move to a day, month, or year display, double click on a
day or year number or a month name. For example, double
click on a day number in a month display to change the
calendar window to a display of the selected day; or double
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click on the year number in a day display to change the
window into a calendar of the current year.

• Use vertical or horizontal scroll bars to move backward and
forward within a display. For example, in the day display use
the bar under the months or the bar to the right of the time
slots.

• Use the View menu to display a selected item, the day display
for today, or the specified type of display (month, day, year).

In the month and year displays, Calendar helps you distinguish
between days containing appointments and free days. When you
enter an appointment, the day number changes from a normal
(roman) font to an italic font wherever it is displayed. On a color
workstation, the day number for days with entries appears in the
highlight color.

5.4.1 Creating an Entry in the Day Display
The day display shows the time slots for that day. You can type
entries, such as appointments, directly into the time slots; or you
can use the Entry Editor to type longer entries and specify other
options, such as alarms, to remind yourself of appointments.

To record an entry directly in your time display:

1. Display the day for which you want to make the entry.

2. Click (and drag to expand, if necessary) on the desired time
slot.

3. Enter the desired text in the time slot.

4. Click in the highlighted area at the left of the time slot (where
the times are displayed).

This action completes the time slot entry.
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To create a long entry or to specify options for the entry, use the
time slot Entry Editor:

1. Double click on the desired time slot in the day display.

The Entry Editor dialog box is displayed. See illustration,
below.

2. Enter the text.

You can use the Tab key, the space bar, Return, and the arrow
keys to format the text.
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3. Adjust the alarms and repeat intervals as required.

4. If you want, click on icons to add or remove them from the
entry display.

These icons are symbols that act as reminders for the contents
of the entry. Calendar attaches no particular meaning to them.

In the Entry Editor dialog box, icons currently associated with
the entry are displayed next to the text entry field, immediately
to its left. You can control which icons are displayed by
clicking on icons in the list of icons displayed in two rows,
lower in the dialog box.

If an icon is already displayed next to the text entry field,
clicking on the same icon in the two-row list of icons removes
it from next to the text entry field. If an icon is not displayed
next to the text entry field, clicking on it in the two-row list
places it next to the text entry field.

When you OK the dialog box, the icons next to the text entry
field will be displayed in the handle of the timeslot entry in
the day view.

5. Click OK to confirm the entry and to dismiss the Entry Editor.

If you exit from the Entry Editor without entering any text, or if
you delete all the text describing a previous entry, the time slot
remains unscheduled.

The Entry Editor dialog box is shown below.
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5.4.2 Sending and Receiving Calendar Entries Through Mail
You can send and receive calendar entries through electronic mail.
To do so, you must display both the Calendar entry (or only the
correct day display if you are receiving the entry) and a
Create–Send window in DECwindows Mail.

To send an entry through electronic mail:

1. Open a Create–Send window in Mail.

2. Select the entry from Calendar by clicking MB1 on the entry’s
handle.

3. Position the mouse pointer in the Create–Send message area.

4. Click MB2.
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To receive an entry through electronic mail:

1. Open the day view and use MB1 to select the text from an
existing mail message.

2. Use MB1 to give Calendar input focus.

3. Click MB2 on the Calendar time slot where you want to copy
the mail text.

You can also use the Copy and Paste menu items on the Edit
menu to copy information from calendar entries to mail messages
and vice versa.

5.4.3 Summary of Other Calendar Features
With Calendar, you can also:

• Set alarms to remind you of appointments

• Mark special days

• Create overlapping entries

• Use the clock in the Day Display

• Use multiple calendars

• Customize your calendar

• Print part of a calendar

For more information, use the online Help for Calendar.

5.4.4 Something to Try
If you have not already done so, try starting Calendar now and
open today’s Day Display. Enter an appointment and set an alarm
to have Calendar remind you of the appointment when the time
approaches.
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5.5 Using Cardfiler

 

Cardfiler lets you create an electronic file box of index cards. This
electronic file box is called a card file. Card files contain cards,
which can hold information such as names, addresses, and
telephone numbers. For example, you could have a card file called
Food that is filled with cards containing recipes and names of
restaurants. Card files can also contain graphic images and a
combination of text and graphics.

By organizing your cards into card files, you can keep one group
of cards separate from another group; for example, you can
separate your business cards from your personal cards.

When Cardfiler is started, the Cardfiler window appears on your
screen. Initially, the card file is empty, but it fills up with index
topics as you add cards. The following illustration shows the
Cardfiler window displaying the names of six cards.

 

HelpFile Search Card

Windows
CASE_Tools
Device Drivers
I18N
I14Y

Cardfiler: /usr/users/jones/projects.card

Dev_Tools
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5.5.1 Creating or Opening a Card File
You can create a card file first and then add cards to it, or you can
create cards and then save them into a card file. For example, you
could create a card file called Clients, and then fill it with
cards that contain the names and telephone numbers of your
clients.
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To start Cardfiler, see Section 5.1. To create a new card file or
open an existing card file:

1. Choose the Open... menu item from the File menu.

The Select File dialog box appears.

2. To create a new card file, click on the Selection text-entry box
and enter the name of the card file you want to create. By
default, card files have a file extension of .card.

3. Click on the OK button.

Cardfiler displays a message telling you the file was not found
and that a new file is being opened.

4. Click on the Acknowledged button.

5. To open an existing card file, double click on the name of the
file in the Files list box.

The requested card file appears.

5.5.2 Creating Cards
Cards contain units of information, such as a person’s name and
telephone number, and are organized in card files. You can create
a series of cards and save them in a card file, or you can open a
card file and then add cards to it. As you add cards, they are sorted
alphabetically according to the topic you choose. Most likely, this
topic will be the name of something, such as a person, business, or
subject. By displaying the topic of each card, the card file window
lists the contents of the card file.

To create a card:

1. Choose the Create Card... menu item from the Card menu.

A dialog box prompts you to enter the topic of the new card.

2. Enter the topic in the Index text-entry box.

3. Click on the OK push button.

Cardfiler displays a blank card in the card window. The text
you entered is added to the title bar at the top of the card
window and to the list of card titles in the Cardfiler window.

4. Enter any information you want on the card.

Using the Return key, space bar, and Tab key, lay out the text
as you want it to appear. Cards can contain up to 4000
characters and up to 64KB of images.
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5. When you are finished with the card, choose the Close menu
item from the Card window’s File menu. The Card window
closes and the card is added to your card file.

You can open another card in the card file without explicitly
closing the current card. When you choose the Create Card... menu
item from the Card menu in the Cardfiler window, Cardfiler
automatically saves any changes you made to the current card and
returns it to the card file before it opens a new card in the file.

If you create a series of cards before you create a card file, you can
save them in a new card file.

To save existing cards in a new card file:

1. Create your cards from the empty, untitled card file you see
when you start Cardfiler.

2. Choose the Save As... menu item from the File menu to save
under a new file name. The Save As dialog box appears.

In the Selection text-entry box, enter the name of the card file
where you want to put your cards. For example, if you created
a series of cards that contain information about office supplies
your department purchased, you might name the card file
supplies.card.

3. Click on the OK push button.

The new card file name appears at the top of the Cardfiler
window with a list of all the cards in that card file.

5.5.3 Summary of Other Cardfiler Features
With Cardfiler, you can also:

• Search a card file for text

• Edit or rename a card

• Include images in a card

• Merge card files

For more information, use the online Help for Cardfiler.

5.5.4 Something to Try
If you have not already done so, try starting Cardfiler now. Create
a few cards containing names and phone numbers of acquaintances
and save them to a card file called ‘‘friends.’’
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5.6 Using CDA Viewer

 

The CDA Viewer lets you display the contents of documents that
are in specific file formats such as PostScript, text, and those
produced by applications such as Paint, DECwrite, and
DECdecision (DDIF and DTIF formats). CDA Viewer works with
the CDA converters. Therefore, the converters that are installed
on your system determine the specific file formats that you can
view. To start CDA Viewer, see Section 5.1.

When the CDA Viewer starts, its Open dialog box and main
window appear on your screen, as shown below. The dialog box is
where you select the file you want displayed; the main window is
where you view files. The Open dialog box’s File Format list box
shows what file formats can be viewed.
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ddif

ddif
dtif
ps
text

area_chart.ddif
box_parts.ddif
wall.diff
cda_icon.ddif
cda_logo.ddif
ddif_example.ddif

/usr/users/jones/.
/usr/users/jones/..
/usr/users/jones/projects
/usr/users/jones/personal

Display Options

/usr/users/jones/*.ddif

5.6.1 Viewing Files
The following steps form the basic procedure for viewing a file:

1. In the Directories list box, click on the name of the directory
that contains the file you want to view.

2. In the File Format list box, click on the format name (also
called the keyword that applies to the file. If you do not know
the format, refer to Section 5.6.2 for more information.

3. (Optional) Click on the Options File... push button to open a
dialog box that lets you select an existing options file to
control the display.

In the Directories list box, click on the name of the directory
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that contains the options file. Then select the file from the Files
list box.

Note

By convention, options file names include the file
extension .cda-options. If your file name
does not follow this convention, the file will not
be listed unless you modify the File Filter text-
entry box to match the actual file name and then
click on the Filter push button.

4. (Optional) Click on the Display Options push button to open a
dialog box, shown below, in which you can set the size of the
display. The paper size you specify is used only if the
document has no inherent format (page size) or if you override
the document’s format.

You can select a paper size from the available list, or you can
supply your own values in characters,1 inches, or millimeters.
To supply your own values, first click on the desired unit of
measurement; then enter the desired values in the Width and
Height text-entry boxes.

Click on the Override Document Format check button if you
want to override the existing format with your own.

The Display Options dialog box includes several options that
apply only to PostScript files.

Click on the OK push button to return to the Open dialog box.

3333333333333333333
1 The characters unit corresponds to the size of a character in the 12-point Courier font,

which is CDA Viewer’s default font and which is also similar to the standard font used by
most printers. In 12-point Courier, and in the character unit as interpreted by CDA Viewer,
there are 10 columns per inch (0.1 inch per character horizontally) and 6 rows per inch
(0.167 inch per character vertically).
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Note

Processing options, paper size values, and the
Override Document Format option apply only to
the next file you open. The appearance of the
currently displayed document does not change.

5. In the Files list box, double click on the name of the file that
you want to view, or click on the file name and then click on
the OK push button.
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The Open dialog box closes, and the selected file is displayed
in the CDA Viewer window. The title bar shows the name of
the file, as does the CDA Viewer icon. The number of the
currently displayed page and the total number of pages appear
in the lower right corner of the window.

You can:

• Move through the file

Click on the inner arrow buttons at the bottom of the
window to move forward or backward one page. Click on
the outer arrow buttons to move to the beginning or end of
the document. To view a specific page number, click on the
Page... push button and enter the page number in the Page
dialog box.

• Halt PostScript processing

If you are viewing a PostScript file, a Cancel push button
is displayed at the bottom of the window. While the CDA
Viewer is formatting a page, you can click on the Cancel
push button to stop processing. Clicking on this button
does not close the file; it merely halts processing of the
current page.

• Display information about the file you are viewing

Choose the Document Information... menu item from the
File menu. If the file contains the information, CDA
Viewer displays the product name (the name of the
application that produced the file), title, author, version,
and creation date.

• Display diagnostic information

Choose the Diagnostic Information... menu item from the
File menu to display information such as warnings and
errors that occurred while you were formatting the file.
(This menu selection is dimmed if no diagnostic
information is available.)

• Close the file

Choose the Close File menu item from the File menu to
clear the display.

• Open a new file

Choose the Open File... menu item from the File menu and
repeat from step 1.

5–34 DECwindows Desktop Applications



• Exit CDA Viewer

Choose the Quit menu item from the File menu.

5.6.2 Specifying Supported File Formats
The file format you specify depends on the application (or the
conversion) that produced the file you want to view.

The following table summarizes the file formats supported by
CDA converters on all Digital UNIX DECwindows Motif systems.
Your system might also support converters for additional formats.
All formats that are supported on your system are listed in the File
Format area of the Open dialog box, as illustrated above.
22222222222222222222222222222222222222222222222222222222222222
Keyword Description Default File

Extension22222222222222222222222222222222222222222222222222222222222222
ddif .ddifDDIF files created by and for

applications such as DECwrite and
DECdecision

dtif .dtifDTIF files created by and for
applications such as DECdecision

ps .psPostScript files to be printed on
supported output devices

text .txtText files that can be edited with a
text editor22222222222222222222222222222222222222222222222222222222222222

Note

You can view PostScript files only if the Display
PostScript System Extension is installed on your
server. If this software is not installed, the ps
(PostScript) keyword will not appear in the Open
dialog box.

Most formats have an associated default file extension. The
preceding table includes the default file extension for each
supported format. The default file extension for the format that
you select automatically appears in the filter mask, which
determines which files are listed. For example, if you specify the
text format, the filter mask ends in .txt, and the Files list box
shows files with that file extension.
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Not all file names have the default file extension for their format.
You must specify the actual format of the input file, regardless of
its file extension.

5.6.3 Summary of Other CDA Viewer Features
With the CDA Viewer, you can also:

• Create an options file to specify processing options

• Specify PostScript options such as landscape or portrait mode

• Adjust the page display size of your PostScript file

• Clarify your PostScript file for online viewing

• View a PostScript file that contains tray size directives.

• View a page as it is being processed, rather than waiting to
view the entire page after it has been processed

For more information, use the online Help for the CDA Viewer.

5.6.4 Something to Try
If you have not already done so, try starting the CDA Viewer now
and view the sample Clock Tower picture created with Paint or a
.ddif file you might have created with DECwrite.

To display the Clock Tower:

1. Choose the Open... menu item from the File menu.

The Open dialog box appears with the names of the files in
your current directory.

2. In the Open File text-entry box, enter the picture file name.

The clock tower file is located at:
/usr/examples/dxpaint/clock.img.

3. Click on the OK push button. The CDA Viewer displays the
Clock Tower picture.
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5.7 Using Clock

 

Clock displays the time (in both analog and digital format) and the
date. You can change the Clock display to suit your needs. You
can also set Clock’s alarm to remind you of appointments. To start
Clock, see Section 5.1.

After you start Clock, it looks like this:

 

HelpFile Options

Clock

Oct 08 Tue

09:00 AM

ZK−2874A−GE

 

5.7.1 Customizing the Clock Display
You can customize the Clock display to include any combination
of the date and time regions.

To change the Clock display, choose Display... from the Options
menu.

The Display Options dialog box appears:

 

Clock:  Display Options

CancelOK

ZK−0910U−R

Analog

Menu Bar

Digital

24 Hour Digital Time

Date

Shaded (enabled) check buttons indicate the current settings. To
change the setting, click MB1 on a check button or its label. For
example, if you want only the analog clock displayed and the
Analog, Digital, and Date check buttons are shaded (enabled),
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click on the Digital and Date check buttons to disable those
settings.

To use the current settings, click on OK. To dismiss the dialog
box without changing any settings, click on Cancel.

Alternatively, you can use the Clock pop-up menu to customize
the display:

1. Place the pointer anywhere in the Clock display (except the
window frame or title bar).

2. Press and hold MB3. A pop-up menu appears.

3. Drag to the Display... menu item.

4. Release MB3. The Display Options dialog box appears.

5. Make any desired changes to the Display Options settings.

6. Click on OK.

You can move or resize the Clock display and save Clock’s size
and position as well as the Display Options by choosing Save
Options from the Options menu or the pop-up menu.

To restore the system defaults, choose Restore System Options
from the Options menu or the pop-up menu.

5.7.2 Setting the Alarm
You can set the alarm to remind you of an appointment.

To set the alarm:

1. Choose Alarm... from the Options menu. This brings up the
Alarm Options dialog box. (Alternatively, double click
anywhere on the Clock display to bring up the Alarm Options
dialog box.)

5–38 DECwindows Desktop Applications



 

Clock:  Alarm Options

Cancel

Alarm Message

Sound Settings

Keyboard Bell

Alarm Settings

AM

PM

Alarm Enable

Repeat Daily

OK

12 00

ZK−0909U−R

2. Click on the Alarm Enable check button to enable the alarm.

3. Click on the Keyboard Bell check button to turn on the alarm
sound.

4. Type the hour when you want the alarm to sound in the entry
box for the hour of the day.

You can use a 12-hour clock, in which case you need to
specify AM or PM, or you can use a 24-hour clock
(‘‘military’’ time).

To erase a number that you previously entered or to correct
typing mistakes, use the 331

33
key.

5. Finish entering the time you want the alarm to sound in the
entry box for the minutes of the hour.

6. If you are using a 12-hour clock, click on either the AM or PM
radio button.

7. To display a message on your screen when the alarm sounds,
type the message in the Alarm Message entry box. Alarm
messages can contain up to 200 characters.

8. To use the current settings, click on OK. To return to the date
and time display without changing the previous settings, click
on Cancel.
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When the alarm goes off, an Alarm dialog box appears containing
the Alarm Message, and the keyboard bell sounds if you enabled
it. Click on OK in the Alarm dialog box to clear the Alarm dialog
box from your screen.

5.8 Using DECterm

 

The DECterm software is a video terminal emulator. When
DECterm is started, a window appears on your screen. Enter
commands in this window as you would on any terminal attached
to your system or it for remote communications to other systems.
To start a DECterm, see Section 5.1.

 ZK−3442A−GE

Help

DECterm:     Digital Equipment Corp. 1990, 1991

$

File Edit Commands PrintOptions

c

5.8.1 Summary of Other DECterm Features
DECterm also lets you:

• Change the appearance of the DECterm window, for example,
font size and window title.

• Change the DECterm display features such as the type of
cursor and the use of horizontal and vertical scroll bars.

• Change DECterm general features like terminal type.

• Compose characters.
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• Choose a National Replacement Character Set (NRCS).

• Change keyboard, graphic, and printer options.

For more information, use the online Help for DECterm or the
dxterm reference page. See Appendix B for information on how
to compose characters.

5.9 Using Mail

 

The Mail utility (dxmail) provides a window-oriented interface
to the Rand mh Mail Handler. With Mail, you can send messages;
read messages sent to you; and print, file, delete, reply to, and
forward messages. To start Mail, see Section 5.1.

To send a mail message to any user on your system or another
system, click on the Create–Send push button in the Main Inbox
window. A Create window opens. You can have multiple Create
windows open at one time.

 

File Edit Help

Mail:  Create

ZK−0994U−R

SendSave into draftsClose Reset Editor

To:user@hostname.domain
cc:
Subject: The envelope area is everything above the dashed line
−−−−−−−−

The message area is below the dashed line.

The Create window is divided into an envelope area and a
message area. The envelope area contains the following text-entry
fields:
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2222222222222222222222222222222222222222222222222222222222222
Field How to Use2222222222222222222222222222222222222222222222222222222222222
To: Enter the name of the user or users to receive the

message. If you are sending mail to someone on your
node, specify only their user name. If you are sending
mail to someone on another system, you must enter
their host name and user name, for example:

node-name::user-name or username@hostname

If you are using a message router, enter the address in
the appropriate format for your router.

You can send a message to several users by separating
their user names with commas. If you are typing many
addresses and want to continue on a new line, press
Return and start the new line with whitespace (space or
tab) before typing another address.

cc: Optionally, enter the name of the user or users you
want to receive a copy of the message. If you have set
the Copy Self on Send option in your mail profile, your
user name is displayed. If you are typing many
addresses and want to continue on a new line, press
Return and start the new line with whitespace (space or
tab) before typing another address. For information
about sending a copy to a distribution list, see Section
5.9.1.

Subject: Optionally enter the subject of the message. If you
want to continue the subject on a new line, press
Return and start the new line with whitespace (space or
tab) before typing more text.2222222222222222222222222222222222222222222222222222222222222

To enter text in any of these fields, position the pointer at the
beginning of the appropriate field and click MB1. Use the
DECwindows editing commands, described in Chapter 4, to
correct mistakes.

If you are entering text in the To;, cc:, or Subject: fields of the
envelope and your text wraps to a new line, you must insert a hard
return and whitespace (space or tab) at the beginning of the new
line.

When the envelope is complete, position the pointer at the
message area beneath the dashed line and click MB1. In the
message area, enter the text of your message.

You can create the message text by using a text editor, by
forwarding an existing message, or by including an existing file.
You can also save a draft of the message before you send it. This
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is useful if you are interrupted and want to finish a message at a
later time.

When you finish creating your message, click on the Send push
button to send your mail. The Send push button in the Create
window dims after the message is dispatched to all addressees. It
remains dimmed until you change something in the window (for
example, if you enter text in one of the fields).

Once a message is sent, you can edit it, send it to other users, or
choose a command from the File pull-down menu or push buttons.

To create another message, click on the Create window’s Reset
push button. This clears the message and envelope areas in the
window and enables you to enter information for a new message.

To close the window, click on the Close push button.

You can insert an existing file into a mail message by choosing
the Include file... item from the File pull-down menu. Mail
displays the contents of the file in the Create window at the
current cursor location. You can edit the file, provided that it is not
a DDIF file.

Mail sends the message to the addressees listed in the To: field.

5.9.1 Sending a Message to a Distribution List
If you need to send one message to many users, you can create a
file, called an aliases file, that contains a list of users. You
then specify the alias in the To: field when you send the message
(for example, project).

To create mail aliases:

1. Edit your .mh-profile file to include the following line:
Aliasfile: aliases

You can name the file anything you like provided that the
name in the .mh-profile file agrees with the file name
you create in step 2.

2. Create a file named aliases in your $HOME/Mail
directory and enter in the user and node names that you want
to send mail to in the format:

<alias name>: name1@node, name2@node, name3@node
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For example:
project: smith@fisherman, jones@bluefish, \
olsen@striper, johnson@goldfish

You can use any of the alias formats that the mh mail utility
supports. See the mh-alias(4) reference page for more
information on how to create aliases in the aliases file.

5.9.2 Sending PostScript Files
When you send PostScript files, do not use an editor to create a
message. Instead, choose the Include file... menu item from the
File pull-down menu in the Create window.

Be sure to position the pointer in the message area of the Create
window (below the ‘‘Subject:’’ field) so that the PostScript file is
not erroneously written into your mail envelope area.

5.9.3 Reading Messages

 5

4

3

2
1

You can use Mail to read an old or a new mail message. New
messages are added to the inbox folder; old messages (messages
that have been read) are held in the inbox folder until you move
them elsewhere.

When you receive new mail, the inbox folder in the folder box is
highlighted. To read the new mail, in the Main Inbox window
click on the New Mail or Deliver push buttons or select the New
Mail menu item from the Read pull-down menu.

Unread messages are identified in your inbox by an icon
resembling an addressed envelope. Double click MB1 on the
message to be read. Mail displays the message in a Read window.

A Read window is divided into an envelope window pane and a
message window pane. By default, these panes are divided by a
dashed line.

The envelope window pane displays the name of the person who
sent the message and other address information. Use the scroll bar
to display additional information about the message, such as text
indicating that the message is marked or has been replied to, the
message size, message ID, and whether the message is in a foreign
format.

The message window pane displays the mail message. Use the
scroll bar to display any text that does not fit in the window pane.
Messages you read remain in the inbox folder until you move
them to another folder or delete them. To move messages to other
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folders, use the Move... push button or the Move... menu item
from the File pull-down menu.

5.9.3.1 Reading Nontext Messages

You can view messages in text, PostScript, DDIF, or DTIF format.
If you receive a file in a format different from those listed here,
you will not be able to view the file in Mail. Mail displays a
message informing you of the problem. However, you can print,
forward, extract, or reply to such a message.

When displaying a PostScript file...

A PostScript file always begins with a percent sign
and an exclamation point (%!). In a Mail message, the
%! symbol can be preceded by up to 50 lines of
ASCII text. Mail searches the file for the %! symbol
and displays the PostScript file. If the message has
more than 50 lines of text preceding the %! symbol,
you must edit the message to remove excess lines of
text before forwarding it.

5.9.3.2 Reading an Old Message

To read an old message, open the drawer and folder containing the
message and double click on the appropriate message. The
message is displayed in a Read window.

5.9.4 Using Accelerators
The Mail application offers accelerators to perform common Mail
tasks quickly. You can also use the arrow keys to traverse menus
as well as the drawers and folders in the main window.

The following table shows the accelerators and their corresponding
functions:2
2222222222222222222222222222222222222222222222222222222222222
Press To Produce2222222222222222222222222222222222222222222222222222222222222
Alt+F File

Ctrl+E Edit

Alt+S Create–Send

Alt+R Read
3333333333333333333

2 Alt is the Compose Character key.
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2222222222222222222222222222222222222222222222222222222222222
Press To Produce2222222222222222222222222222222222222222222222222222222222222
Alt+M Maintenance

Alt+C Customize

Alt+D Deliver Mail

Alt+X Exit

Ctrl+C Copy Selected Message

Ctrl+E Extract

Ctrl+O Open Folder2222222222222222222222222222222222222222222222222222222222222

5.9.5 Summary of Other Mail Features
With Mail, you can also:

• Change the editor you use to create a message

• Search a selected folder for messages that have something in
common, for example, all messages that contain a specific
word in the subject line

• Customize your Mail environment, including menus and
buttons

• Have Mail automatically sort your incoming mail

For more information on these features, see Chapter 8 or Help for
Mail.

5.9.6 Something to Try
If you have not already done so, try starting Mail now. Click on
the Create–Send button to open a Create window and try the
techniques described in this section.
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5.10 Using Notepad

 

The Notepad is an editor that lets you do everyday tasks such as
recording messages, writing letters, and building data files. The
Notepad editor saves your notes in files, which you can store for
later revision or incorporation into other files. The Notepad editor
supports the techniques for selecting, deleting, moving, and
modifying text described in Chapter 4. To start Notepad, see
Section 5.1.

When it starts, Notepad displays an empty editing window (shown
below) where you can type text from the keyboard or copy in an
existing file for editing. Notepad is interactive; you see the
changes to a file as you make them.

 

HelpSearch Navigate Customize

Notepad: Untitled

File Edit

ZK−0709U−R

5.10.1 Entering Text
To enter text in the Notepad window, click MB1 in the text area
and begin typing. Notepad enters the text at the position marked
by the cursor. Initially, the cursor is displayed in the upper left
corner, but it moves to the right as you type.
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The Notepad editor inserts text into a temporary holding area
called a buffer. The contents of the buffer appear in the Notepad
window. At the beginning of an editing session, the buffer
contains very little text, but the buffer grows longer as you add
information.

A buffer exists only during the editing session. When you end an
editing session, you direct the Notepad editor to save or discard
the contents of the buffer.

5.10.1.1 Formatting Text

Use the Tab key, the space bar, and the Return key to arrange text
in the Notepad window as you want it to appear.

You can also size the Notepad window so it has the line width you
want. By default, Notepad wraps text lines at the right margin
automatically; you do not have to press Return at the end of every
line. To disable word wrapping, choose Word Wrap from the
Customize menu. When word wrapping is in effect, a shaded
toggle button appears to the left of the Word Wrap menu item.
When you disable word wrapping, the toggle button disappears.

5.10.1.2 Scrolling the Buffer

As your text buffer grows, it extends beyond the frame of the
Notepad window. To view text at the beginning or end of the
buffer, use the vertical scroll bar along the right side of the
window. The position of the slider indicates your position in the
buffer. When the slider is at the top of the scroll bar, you are at the
beginning of the buffer. When the slider is at the bottom of the
scroll bar, you are at the end of the buffer. See Section 3.2.5.

5.10.2 Editing a File
The Notepad navigation and editing commands let you move
within a text buffer quickly and easily, adding or modifying
information.

5.10.2.1 Moving the Cursor

When you insert text in the buffer, Notepad adds the text at the
current cursor position, pushing existing text to the right.
Therefore, the cursor is normally positioned at the spot where you
last entered text.

To move the cursor, position the pointer anywhere in the Notepad
window and click MB1. Use the arrow keys to move the cursor.
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Press the Ctrl key and the right arrow key at the same time to
move the cursor one word to the right. Press the Ctrl key and the
left arrow key at the same time to move the cursor one word to the
left. Press the Compose Character key and the right arrow key to
move the cursor to the end of the line. Press the Compose
Character key and the left arrow key to move the cursor to the
beginning of the line.

With a long buffer, reposition the cursor by using menu items
from the Navigate menu. Choose Go to Top to move to the top of
the buffer. Choose Go to Bottom to move to the bottom of the
buffer.

To reposition to a specific line in the buffer:

1. Choose the Go to Line... menu item from the Navigate menu.

Notepad displays a dialog box.

2. Type the line number in the text-entry box and click on the
OK push button.

Notepad repositions the cursor to the specified line.

Another method of placing the cursor on a certain line is to select
a line number in text anywhere on your workstation and choose
the Go to Selected Line Number menu item from the Navigate
menu.

For example, if you are reading an error listing file in a DECterm
window that contains the line number 1019 and you want to look
at line number 1019 in a program source file you are editing in
Notepad, select 1019 in DECterm and choose the Go to Selected
Line Number menu item from Notepad’s Navigate menu. Notepad
places the cursor on line 1019 in your Notepad file.

Note

If you are correcting a program source file, you might
want to start from the bottom and work your way up
so that your edits do not affect how the line numbers
in your source file correspond to the line numbers in
your error listing file.

5.10.3 Canceling an Edit
To cancel your most recent edit, choose the Undo... menu item
from the Edit menu. For example, if you remove text with the Cut
menu item, you can restore the text to its former location with the
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Undo... menu item.

Notepad keeps a detailed record of all your edits so you can undo
a series of edits. To cancel a series of edits:

1. Choose the Undo... menu item from the Edit menu.

Notepad displays the Undo dialog box.

2. Click on the Undo push button to cancel the last editing
operation.

Each time you click on the Undo push button, Notepad cancels
another editing operation.

3. If you undo an editing operation by mistake, reinstate the edits
by clicking on the Redo push button.

4. To complete the operation, click on the Cancel push button.

You can cancel all the edits of an editing session in one step by
choosing the Revert menu item from the File menu. Notepad
displays a Save changes dialog box. When you click on the OK
push button, Notepad restores the buffer to the state it was in when
you first opened the file.

 

Cancel

?

Notepad: Undo

Undo Function

Undo Redo
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Because Notepad saves the last text you selected and deleted, you
can move text from one location in the text buffer to another
location.

5.10.4 Moving Text
To move text in a buffer:

1. Select the text to be moved to another location.

2. Choose the Cut menu item from the Edit menu.

3. Move the cursor to where you want the deleted text inserted by
positioning the pointer and clicking MB1.
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4. Choose the Paste menu item from the Edit menu.

The deleted text is moved to the new location.

5.10.5 Copying Text
Because Notepad keeps track of your selected text, you can copy
text from one location in a text buffer to another location. To copy
text in the text buffer:

1. Select the text you want copied to another location.

2. Choose the Copy menu item from the Edit menu to store the
copied text.

3. Move the cursor to where you want the selected text copied by
positioning the pointer and clicking MB1.

4. Choose the Paste menu item from the Edit menu.

The selected text is copied to the new location.

5.10.6 Saving Text in a File
When you add text to Notepad, the editor records the information
in the buffer. If you want to save the contents of the buffer, you
must direct Notepad to write your text to a file.

To save the text in your buffer as a file:

1. Choose the Save As... menu item from the File menu.

Notepad displays a dialog box that prompts you for the name
of the file.

DECwindows Desktop Applications 5–51



 

Notepad: Save

Filename

OK HelpCancel

ZK−0728U−R

2. Enter the name of the file. Use a name that corresponds to the
contents of the file so that you can easily recognize it. Use the
331
33

key and arrow keys to make any necessary corrections.

3. Press Return or click on the OK push button.

Notepad writes the contents of the buffer to the new file and posts
the file name in the title bar of the editing window.

When you make changes to an existing file, it is also necessary to
save the changes. Once a file has a name, use the Save menu item
to update the file.

To open an existing file:

1. Choose the Open... menu item from the File menu.

Notepad displays the Open dialog box.

5–52 DECwindows Desktop Applications



 

Filter

Selection

FilesDirectories

Filter Cancel HelpOK

ZK−0710U−R

Notepad: Open

/usr/users/jones/*

.

..

Mail
OSF.INFO

.Mail

.X11Startup

.X11Startup_motif

.Xdefaults

.Xdefaults.old

.Xdefaults_motifbin

/usr/users/jones/
^

IDC

2. Either select the file from the files listed in the Files list box or
enter the file name.

You can select a file by double clicking on it or by clicking on
it once and then clicking on the OK push button.

3. Press Return or click on the OK push button.

The contents of the file appear in the editing window and Notepad
displays the file name in the title bar.

You can also open an existing file by selecting a file name in any
other window (for example, DECterm) and then choosing the
Open Selected menu item from the File menu.

5.10.7 Exiting from an Editing Session
If you modified word wrapping or case-sensitive searches and you
would like to save those settings for future editing sessions,
choose the Save Current Settings menu item from the Customize
menu. To restore your previous settings, choose the Use Last
Saved Settings menu item from the Customize menu.
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To end an editing session, choose the Exit menu item from the
File menu. If you have modified the text in the current buffer since
you last saved it, Notepad updates the current file with the changes
and closes the Notepad window.

To discard the edits from a session and close the editing window,
choose the Quit menu item from the File menu.

If a session is interrupted before you save your edits, Notepad still
saves your keystrokes in a journal file. The next time you start
Notepad, a message box is displayed giving you the option to
recover your edits or remove the journal file.

5.10.8 Summary of Other Notepad Features
With Notepad, you can also:

• Move and copy text from one location in the text buffer to
another

• Change the font family and font characteristics such as size,
weight, and spacing

• Include an existing file into the current text buffer

• Split your Notepad window into a number of edit windows

• Open a second Notepad and copy text from one Notepad
window to another

• Combine the contents of two Notepad windows

• Search and replace text

For more information, use the online Help for Notepad.

5.10.9 Something to Try
If you have not already done so, try starting Notepad now. Start
typing text and then save your text to a file.
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5.11 Using Paint

 

Paint is a graphics application that lets you create a simple picture,
such as a sketch or an illustration, using an assortment of art tools.
If you have a color monitor, you can choose colors from a color
palette. To start Paint, see Section 5.1.

Paint can save your pictures, print them on different kinds of
printers, or copy them to other applications. You can also display
the pictures on your screen with the CDA Viewer application (see
Section 5.6).

When Paint is started, the Paint window appears, as shown below.
This window contains a tool palette and a work area where you
draw your picture.
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The Paint window frames a portion of the picture. At the bottom
of the tool palette is a representation that shows which portion of
the picture is currently visible in Paint’s work area. The
highlighted box within the larger box represents the size and shape
of that part of the picture that is visible. The larger box represents
size and shape of the entire picture.

To display different areas of the canvas, press MB1 in the
highlighted box and drag until the box is in the position you want.
Alternatively, you can use the horizontal and vertical scroll bars to
move about the canvas.

5–56 DECwindows Desktop Applications



Paint is a bitmap graphics application, which means that it treats
pictures as a collection of dots called pixels. Different drawing
tools, such as the Pencil, the Paintbrush, and the Text tool, edit the
color of the pixels to create a pattern. Because the canvas has so
many pixels in every square inch, you do not actually see patterns
of dots. Instead, you see a collection of lines, shapes, and text.

5.11.1 Shortcuts to Paint Operations
You can use certain key combinations, called accelerators, to
perform common Paint operations quickly. The following table
shows each key combination and its corresponding function:3
2222222222222222222222222222222222222222222222222222222222222
Press To Produce2222222222222222222222222222222222222222222222222222222222222

UndoAlt+ 331
33

Ctrl+Z Exit

Shift+Remove Cut

Ctrl+Insert Here Copy

Ctrl+O Open

Shift+Insert Here Paste

Ctrl+P Print

Ctrl+S Save

Ctrl+Q QuickCopy2222222222222222222222222222222222222222222222222222222222222

In addition to using accelerators, you can also use key
combinations to manipulate Paint tools. To produce the results
listed in the following table, press and hold the Shift key while
you drag MB1:
2222222222222222222222222222222222222222222222222222222222222
Tool Effect2222222222222222222222222222222222222222222222222222222222222
Rectangle Causes the rectangle to become a square.

Line Causes the line to be at an angle that is a multiple
of 45 degrees.

Paintbrush Causes the image to be horizontal or vertical.

Pencil Causes the image to be horizontal or vertical.

Ellipse Causes the ellipse to become a circle.
3333333333333333333

3 Alt is the Compose Character key on keyboards that do not have a separate Alt key.
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2222222222222222222222222222222222222222222222222222222222222
Tool Effect2222222222222222222222222222222222222222222222222222222222222
Polyline Causes angles to be multiples of 45 degrees.

Eraser Causes the eraser to erase vertically and
horizontally only.

Arc Causes the image to be a quarter circle (instead of
a quarter ellipse).2222222222222222222222222222222222222222222222222222222222222

5.11.2 Summary of Other Paint Features
With Paint, you can also:

• Print a painting

• Use color if you have a color monitor

• Create your own patterns

• Move and copy images

• Crop a picture

• Edit a picture

For more information, use the online Help for Paint.

5.11.3 Something to Try
If you have not already done so, start Paint now and try some
basic techniques by modifying a sample picture called the Clock
Tower.

To display the Clock Tower:

1. Choose the Open... menu item from the File menu.

The Open dialog box appears with the names of the graphics
files in your current directory.

2. In the Selection text-entry box, enter the picture file name.

The clock tower file is located at:
/usr/examples/dxpaint/clock.img

3. Click on the OK push button. Paint displays the Clock Tower
picture. You can now practice choosing tools and using some
of the Paint menu items. Try changing the time on the clock
face.
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5.12 Using Print Screen

 

Print Screen lets you take a snapshot of the entire screen or a
portion of the screen. You save the snapshot to a file or print it.
By default, a screen snapshot is sent to a file formatted for
PostScript printers. To start Print Screen, see Section 5.1.

If you run Print Screen in a terminal emulator window, it defaults
to performing screen captures based on command line switches
and will not display its Motif graphic user interface (GUI). Use the
-X switch to display the print screen GUI. This chapter describes
the Print Screen GUI. Use the man dxprint command to get
information on using Print Screen from the command line.
(Reference pages are discussed in Section 5.1.2.)

When Print Screen starts, the application window looks like this:

 

HelpFile Options

Print Screen:      Digital Equipment Corp.  1988, 1993.

Output Format

Positive Image

Time Delay (seconds)

Output File Name

0

Output Color Black and White

Fit−To−Paper

PostScript

Crop Excess

printscreen.ps

ZK−0811U−R

Capture Portion of Screen

Send to File

Ribbon Saver

Print Orientation Portrait

c

The default settings, illustrated above, let you save print screen
snapshots in a file in PostScript format. However, with the options
menus in the Print Screen window you can change the settings to
accommodate your particular needs. The next section covers the
procedures you use to take screen snapshots, followed by a section
summarizing additional customizations possible with the options
menus.
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5.12.1 Taking Screen Snapshots
Use the ‘‘Send to’’ options menu to choose whether to save a
screen snapshot to a file, print the snapshot, or do both.

 

Send to 

Printer

File

Both

To actually take the snapshot, choose Print or Print... from the File
menu. If you select Send to Printer or Both, then choosing Print
sends the snapshot to the default printer, whereas choosing Print...
displays a dialog box that lets you choose the printer. If you select
Send to File, then choosing Print saves the snapshot to a file; the
snapshot is not immediately printed. When you save to a file, you
can specify a file name in the Output File Name field, or you can
accept the default file name.

In summary, to take a screen snapshot:4

1. Arrange the windows on the screen as you want them captured.

2. Use the ‘‘Send to’’ options menu to choose whether to save
the snapshot to a file, print the snapshot, or do both.

3. Use the ‘‘Capture’’ options menu to choose to capture the
entire screen or just a portion of the screen.

4. Choose Print or Print... from the File menu. Print will print to
the default printer. If you chose Printer or Both in step 2,
choosing Print... will display a dialog box allowing you to
choose a specific printer. If you chose Entire Screen in step 3,
then the snapshot operation proceeds immediately and Print
Screen will display a watch cursor until the snapshot is
completed. If you chose Capture Portion of Screen, continue
with the next step.

5. The pointer changes to a capture cursor (+). Move the capture
cursor to the upper left corner of the area you want to capture.

6. Press and hold MB1.

3333333333333333333
4 Some workstations have special graphics hardware that supports multiple windows

each having individual color palettes. An example of such a workstation is one with
Digital’s SPXgt graphics accelerator. When performing screen captures on such systems it is
important to make sure that the window of interest has input focus before initiating the
snapshot. Print Screen will perform the capture operation using the color palette of the
window with input focus. The time delay feature should be used to delay the capture until
you can set input focus to the appropriate window.
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7. Drag the capture cursor until a box surrounds the area you
want to capture.

8. Release MB1.

The cursor changes to a watch cursor until the capture is
completed.

5.12.2 Using a Time Delay
You may want a time delay before taking the snapshot. For
example, you might want to minimize a window by turning it into
an icon or click on a window to give it input focus.

To take a snapshot of all or part of the screen display after a time
delay:

1. Set the ‘‘Capture’’ and ‘‘Send to’’ options menus as desired.
(See explanation in the previous section.)

2. Specify how many seconds to delay by pressing MB1 on the
Time Delay slider and dragging it until you reach your choice.

3. Choose Print or Print... from the File menu.

If you chose Print..., the Queue Options dialog box appears:

• Enter the options you want

• Click on the OK push button

The time delay begins.

4. During the time delay, arrange the objects on your screen as
you want them captured.

5. The time delay ends. If you chose ‘‘Entire Screen’’ in the
‘‘Capture’’ options menu, the whole screen is saved to a file
and/or printed. If you chose Portion of Screen:

• The pointer changes to a capture cursor (+). Move the
capture cursor to the upper left corner of the area you want
to capture.

• Press and hold MB1.

• Drag the capture cursor until a box surrounds the area you
want to capture.

• Release MB1.
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5.12.3 Summary of Other Print Screen Features
The following table summarizes additional Print Screen options.
For each options menu, in the left column, the default option is
indicated in the center column. For more information, use the
online Help for Print Screen.
2222222222222222222222222222222222222222222222222222222222222222
Option Menu Option Allows You To2222222222222222222222222222222222222222222222222222222222222222
Output Format Postscript (default) Print to a PostScript printer

or create a PostScript file.

Sixel Print to a Sixel device or
save to a Sixel file. Sixel
files can be viewed in a
DECterm window and
printed on most Digital
printers.

DDIF Save to a file in DDIF
format for use with
applications such as Paint,
CDA viewer, or DECwrite.

Ribbon Saver Positive Image
(default)

Take a snapshot that looks
like a normal photo print.

Negative Image Take a snapshot that looks
like a photo negative. May
be useful in conserving
printer toner or ribbon.
Output color must be Black
and White or Gray Scale.

Print Orientation Best Fit Take a portrait snapshot
when captured area is higher
than it is wide; otherwise,
take a landscape snapshot.

Portrait (default) Print a snapshot that is
upright when printer paper is
viewed with its long
dimension vertical.

Landscape Print a snapshot that is
upright when printer paper is
viewed with its long
dimension horizontal.

Output Color Black and White
(default)

Capture a black and white
snapshot.

Color Capture a color snapshot.
Requires a color monitor.
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2222222222222222222222222222222222222222222222222222222222222222
Option Menu Option Allows You To2222222222222222222222222222222222222222222222222222222222222222

Gray Scale Capture a gray scale
snapshot. Requires a gray
scale or color monitor.

Fit-To-Paper Scale To Fit Print a snapshot as large as
possible.

Reduce Only Reduce the size of a
snapshot to fit the printer
paper if the snapshot is too
large.

Crop Excess
(default)

Print only as much of a
snapshot as will fit on the
printer paper and crop parts
that don’t fit.

Increase 2:1 Double the size of a snapshot
printed or saved to file.

Decrease 2:1 Halve the size of a snapshot
printed or saved to file.2222222222222222222222222222222222222222222222222222222222222222

5.13 Using Visual Differences

 

Visual Differences is a graphical interface to the diff program.
You can compare two ASCII text files line by line, and then
browse through the graphical display of the highlighted
differences. To start Visual Differences, see Section 5.1.

When Visual Differences starts, its main window appears. The
title bar contains the application name, followed by the window
number. The first window displayed is always labeled 0. The
windows are numbered to save confusion if you have more than
one Visual Differences window running at the same time. The two
empty text regions will be filled with the text from the files you
want to compare.
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5.13.1 Selecting Files to Compare
To select two files to compare, choose the Open Files... menu
item from the File menu. Two file selection dialog boxes are
displayed: Left File and Right File. Each dialog box lists the files
in the current directory.

To change directory of the files listed, type the pathname of the
directory in the File Filter text-entry box and press the Return key
(or click on the Filter push button). You can instead double click
on the directories listed in the Directories list box. The file
selection test-entry box recognizes the tilde (~) character, which
represents your home directory.

To select a file, either click on the file name and then click on the
OK push button, or double click on the file name. You can also
type the file name in the Selection text-entry box and press Return.

You must select one file in each of the dialog boxes.

After you enter a file name in each file selection dialog box, you
must next choose the Do Differences menu item from the
Differences menu, as described in the following section.

5–64 DECwindows Desktop Applications



5.13.2 Displaying the Differences
To display the differences between the two files that you selected,
choose the Do Differences menu item from the Differences menu.
The time taken for Visual Differences to display the differences
will depend on the length of the files and the number of
differences between them.

Note that trailing blanks (spaces and tabs) are not included as
differences, and are ignored. Any other strings of blanks are also
treated as equal and do not appear as differences.

If there are no differences between the two selected files, if either
of the files is a non-ASCII file, or if you have selected a directory
instead of a file, an appropriate message dialog box is displayed.
The following display shows the differences between two text
files:

 

  

Differences

.LP

.LP
This line is the same

Help

This line is the same 
in both.

Lines which are the same

test file2.

no reference
to test file1.

Files

In this file there is 

Options

.SH 1

Differences

test1 test2

.LP

.LP

.SH 2

Next Diff Prev Diff Next Diff Prev Diff

ZK−0042U−R

Lines across the
Difference Box

File 

Different
Text

action.

This is test file2.

.LP

Line 5 is the same in both
files

Line 5 is the same in both
files.

Line 7 is different 
in this file there is a
reference to 
test file 2.

Line SEVEN is different.

The
Same
Text

Name

The files are displayed in two text windows that appear to the left
and right of the differences box in the center of the display. Each
text region displays the name of its currently selected file.

The differences between the files are connected by lines running
across the difference box in the center of the display. These lines
show the relationships between the differences in the files, and
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where the differences are located in the files.

The differences in the files are shown as areas of highlighted text;
common text is not highlighted.

When you start Visual Differences, the display is set up to give
you linked vertical scrolling and lines connecting the areas of
different text.

With linked vertical scrolling, when you scroll one of the files, the
other file is scrolled with it line by line. When scrolling is
unlinked, you can scroll the files independently of each other and
view different parts of each file at the same time.

5.13.3 Moving Between Differences
Use the scroll bars or the Next Diff and Prev Diff push buttons to
browse through the displayed files. When you click on the Next
Diff push button, Visual Differences searches forward from the
current difference (in the center of the difference display) to the
next difference in that file. The application then moves that
difference to the center of the display.

When you click on the Prev Diff push button, Visual Differences
searches backward from the current difference to find the previous
difference in the file. The application then moves that difference to
the center of the display.

These buttons are useful for moving quickly between the
differences in a long file, especially where there are only a few
differences.

5.13.4 Summary of Other Differences Features
With Differences, you can also:

• Move through the differences in a file

• Change the characteristics of the display, such as line numbers
in the differences region

• Compare a new set of files

• Open several Differences windows

For more information, use the online Help for Visual Differences.
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6Customizing the Window Manager3333333333333333333333
This chapter describes how to use the Workspace Options
submenu to change your window manager features. It also
includes information about advanced window manager
customization options.

By using the window manager customization options, you can
change the way your windows look and behave. The window
manager provides a customization submenu that lets you
customize the following window features:

• Workspace

• Border

• Border colors

• Icons

• Icon colors

• Matte

Although the procedures in this chapter describe how to use the
window manager Options submenu from the Workspace menu,
you can access the same options submenu from every application’s
Window menu. See Section 3.2.6.

To display the window manager Options submenu, from the
Window menu:

1. Choose Workspace from an application’s Window Menu.

The window manager displays the Workspace submenu:



 

Workspace

Shuffle Up

Shuffle Down

Next Window

Previous Window

Pack Icons

Options

Restart

Help

ZK−3663A−R

2. Choose the options submenu from the Workspace submenu.

Note

To change colors on a monochrome monitor, you
might need to modify pixmap resources. Use the file
/usr/lib/app-defaults/Mwm_bw as a
reference. See Chapter 9 for more information about
changing resource settings.

6.1 Customizing Your Workspace
You can change when and how a window becomes active and
other Workspace features by changing your Workspace settings.

To change your Workspace settings, choose Workspace... from the
Workspace Options submenu. The window manager displays the
Workspace Options dialog box:
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Workspace: Options

To make a window active,

When a window becomes active,

Raise it to the top of the screen

Customize the workspace

OK Reset Default Cancel Help

Make a window active when it is

Created

Restored from an icon

Removed from the screen

When moving a window, show the

Show feedback when moving or sizing windows

Set Alt+Space to display the window menu

For international keyboards, ignore the Mod keys

select the window

outline

Click on the settings in the dialog box to customize the features
you want to change. Use the first options menu in the dialog box
to change the way a window is activated. By default, windows
use explicit focus to activate a window. That is, you must point to
the window and click a mouse button. You can change the
explicit focus to pointer focus. With pointer focus enabled,
windows are activated as soon as you move the pointer into a
window.

Note

Changing the Moving a Window setting from outline
to entire window is recommended only on higher
performance workstations.

To improve performance when moving and sizing
windows, disable the Show feedback setting.

If you enable the Alt+Space setting, you can use
compose sequences only on keyboards that have both
Alt and Compose Character keys.
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6.2 Customizing Your Window Borders
To change your window borders, choose Border... from the
Workspace Options submenu. The window manager displays the
Border Options dialog box:

 

Other Resize Border Size

Resize Border Size

Customize the border 

OK Reset

Workspace: Border Options
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Border Decorations

Minimize Button

Maximize Button

Resize Border

Medium

Double Click on Window Menu to Close Window

Default Cancel Help

Window Border

Title

Menu

From the Customize Border dialog box, you can change the
following settings:

Border decorations
Click on a border decoration to add or remove it from all
your window frames.

Resize border size
The resize border is the border around the window that you
drag to resize a window. To change the size of the border,
choose one of the default sizes from the options menu, or
choose the Other menu item to enter your own border size.

Other resize border size
If you choose the Other menu item from the Resize Border
Size Options menu, the Other Resize Border Size text-entry
box receives input focus. Enter a value in this box to define
your own border size.
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Double click on window menu to close window
Click on this setting to enable or disable the Close menu item
when you double click on the Window menu.

6.3 Customizing Your Window Border Colors
To change your window border colors, choose Border Colors...
from the Workspace Options submenu. The window manager
displays the Border Color Options dialog box.

Pick colors that make it easy to distinguish between active and
inactive windows. DECwindows displays the Workspace: Border
Color Options dialog box, which lets you choose the border
background color you want.

From the Workspace: Border Color Options dialog box, you can
change the following settings for active or inactive windows:

Foreground
The color of the title.

Background
The color behind the title.

Top and Bottom Shadows
Shadow colors help present the three-dimensional look of
DECwindows Motif and must be well-matched. The top
shadow colors are on the top and left sides of the border. The
bottom shadow colors are on the bottom and right sides of the
border. DECwindows automatically determines top and
bottom shadow border colors when you change the
background color.

To choose your own shadow colors, disable the Automatic
shadow setting.

6.4 Customizing Icon Appearance
To customize the appearance and placement of your icons on the
workspace, choose Icons... from the Workspace Options submenu.
The window manager displays the Workspace: Icon Options dialog
box.

From the Workspace: Icon Options dialog box, you can change the
following settings:

• Display an icon box
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• Icon placement

• Icon size

• Icon decorations

To customize the position and size of the icon box, move and
resize the icon box, then select Apply Current Settings from the
Workspace menu to restart the window manager.

6.4.1 Customizing Icon Colors
To change your icon colors, choose Icon Colors... from the
Workspace Options submenu. The window manager displays the
Workspace: Icon Color Options dialog box.

From the Workspace: Icon Color Options dialog box, you can
change the following icon image and icon box color settings:

Foreground
To change the icon foreground color, click on the Foreground
button. DECwindows displays the Workspace: Color Options
dialog box, which lets you select the icon foreground color.

Background
To change the icon background color, click on the
Background button. DECwindows displays the Workspace:
Color Options dialog box, which lets you select the icon
background color.

Top and Bottom Shadows
Shadow colors help present the three-dimensional look of
DECwindows Motif and must be well-matched. The top
shadow colors are on the top and left sides of the icon. The
bottom shadow colors are on the bottom and right sides of the
icon. DECwindows automatically determines top and bottom
shadow colors when you change the background color.

To choose your own shadow colors, disable the Automatic
shadow setting and click on the Top Shadow or Bottom
Shadow button. DECwindows displays the Workspace: Color
Options dialog box, which lets you select the icon shadow
color.

Icon Box Colors
To change the Icon Box Background Color, click on the
Automatic color button. Click on the Background button.
DECwindows displays the Workspace: Color options dialog
box, which lets you select the icon background color.
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6.5 Customizing the Matte
To change your matte features, choose Matte... from the
Workspace Options submenu. The window manager displays the
Matte Options dialog box.

From the Matte Options dialog box, you can change your matte
size and color settings.

For more information about adding and removing items from your
automatic startup list, see Chapter 7.

6.6 Saving Your New Settings
You can save the changes you make or reinstate other settings as
follows:
2222222222222222222222222222222222222222222222222222222222222
Choose To2222222222222222222222222222222222222222222222222222222222222
Apply Current Settings Save the settings you just changed

and restart the window manager.

Reset to Last Saved Settings Reinstate the last settings you saved.
Choose this menu item if you want to
reset any attributes that you changed
temporarily but did not save.

Reset to Default Reinstate the default settings.2222222222222222222222222222222222222222222222222222222222222

6.7 Advanced Customization
In addition to the menu items available from the Customize
submenu, you can change the appearance and behavior of windows
by specifying values for elements, known as resources in resource
configuration files. The window manager gets information from
these files each time you start a session, an application, or the
window manager.

For information about modifying resource files, see Chapter 9, the
appendixes in this guide, and the OSF/Motif Programmer’s Guide.
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This chapter describes how to use the options available in the
Session Manager Options menu which you can use to customize
session features such as your keyboard, language, window colors,
and security settings. Where appropriate, this chapter also
describes how to customize the screen display for three types of
workstations:

• Monochrome system—Supports black-and-white output only

• Intensity system—Supports shades of gray

• Color system—Supports a full spectrum of color

7.1 Customizing Your Startup Environment
You can customize the session manager to automatically start the
applications you use each day.

To customize your startup environment:

1. Choose Automatic Startup... from the Session Manager
Options menu.

Session Manager displays the AutoStart dialog box.

2. Click on an application item in the left-hand list box to add it
to your automatic startup list.

The applications are started in the order in which they appear
in this list.

If you want to start one application several times, you must
add the application to the startup list for each time you want it
started. For example, click on DECterm three times to enable
the start of three DECterm windows each time you start a
session.



Note

The Motif window manager (mwm) is a main
component of your DECwindows working
environment. Do not remove the mwm window
manager from your automatic startup list unless you
are replacing it with another window manager.

7.2 Changing Your Session Manager Settings
You can change certain characteristics of the Session Manager
itself. To change your Session Manager settings, choose Session
Manager... from Session Manager Options menu. Session Manager
displays the Customize Session Manager dialog box.

You can change the following settings from the Customize Session
Manager dialog box:

Startup State
Session Manager is displayed as a window at the start of each
session. Click on the Icon button under the Startup State title
to specify that Session Manager be stored as an icon at the
start of every session.

Confirm End Session
When you quit a session, Session Manager asks you for
confirmation. To disable this option, click on the Confirm
Quit Session button. You do not receive a confirmation
message when you end your session.

Pause Screen Message
When you select Pause from Session Managers Session
menu, your screen is cleared and a message is displayed in
the Pause Session dialog box. You can change the message
by editing the text in the Pause Screen text-entry box. To see
your new message, choose Pause from the Session Manager
Session Menu. See Section 2.1.3.

7.2.1 Customizing Window Patterns and Colors
To change window managers, background, and window colors,
choose Window... from the Session Manager Options menu. The
Session Manager displays the Window Options dialog box.
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From the Window Options dialog box, you can change any of the
following settings:

Window Manager
To choose a window manager, enter the directory path to the
window manager file in the text-entry box below and to the
right of the title Window Manager then click on the Default
or Other button.

Screen Saver
Screen Saver extends the life of your monitor by shutting off
its display after a specified time. By default, the monitor
shuts off its display after 10 minutes of keyboard or mouse
inactivity. Drag the arrow in the slider right or left to change
the length of time or click on the Disable button if you prefer
to keep the display on indefinitely.

Screen Background Pattern
To change the default background pattern, click on a pattern
in Screen Background Pattern section of the Window Options
dialog box. The selected pattern is displayed in the pattern
viewer. Click on OK or Apply to see your selection in effect.
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To choose a solid background or foreground instead of a
pattern, click on the boxes to the left of the Default Pattern
button. To display the default pattern, click on the Default
Pattern button.

Solid Foreground
The screen pattern, when set to anything other than the
default pattern, consists of a screen foreground (the filled area
in the pattern) and a screen background (the pattern’s
outline). The selected pattern is displayed in the pattern
viewer.

To change the default screen color on intensity and color
systems, click on the Screen Foreground Color box. The
Session Manager displays a Color Attributes dialog box. For
more information about mixing colors, see Section 4.3.

To see your new setting, click on Apply or OK.

Solid Background
This setting applies to intensity and color systems only. To
change the default screen background color, click on the
Screen Background Color box. Session Manager displays a
Color Attributes dialog box.

Note

As explained below, window color changes do
not take effect immediately.

Window Background Color
To change the default window background color, click on the
Window Background Color box. Session Manager displays a
Color Attributes dialog box.

If you save your changes by clicking on Apply or OK in the
Customize Windows dialog box, your new setting takes effect
when you start your next session.

Window Foreground Color
Changing the Window Foreground Color setting in a window
that contains text also changes the color of that text. If the
window contains graphics, the color of the graphics changes.

To change the default window foreground color, click on the
Window Foreground Color box. Session Manager displays a
Color Attributes dialog box.
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If you save your changes by clicking on Apply or OK in the
Customize Window dialog box, your new setting takes effect
when you start your next session.

You can also change the pattern used for highlighting. This is
especially useful on monochrome and 4-plane color systems.

Window Highlight Color
Changing the Window Highlight Color setting determines the
color surrounding any button in a dialog box.

Window Border Color
Changing the Window Border Color setting determines the
color surrounding buttons selected in dialog boxes.

7.2.2 Changing Your Security Settings
DECwindows software allows you to run applications from
another computer for display on your workstation monitor. By
default, your workstation monitor can display only those
applications that are running on your workstation. This prevents
users on other systems in the network from displaying applications
on your workstation monitor and from capturing and displaying
your keystrokes (including your password) on another monitor.

From the Session Manager Security Options dialog box, you can
authorize yourself or others to use your monitor to display
applications that are running on other systems.

To grant access to specified remote hosts, choose Security from
the Session Manager Options menu. A dialog box appears:
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To add a name to the list of authorized hosts:

1. Enter the host name in the Hostname text-entry box.

If the connection between your system, and the remote host is
through the DECnet network, use DECnet syntax, which
requires two colons (::) after the host name. If your connection
to the remote host is through the TCP/IP network, colons are
unnecessary.

2. Click on the Add button.

The host name appears on the list of authorized hosts.

3. Click on OK to use the new list of authorized hosts.

To save the authorized host list for use in future sessions, select
Save Current Settings from the Session Manager Options menu.

7.3 Customizing Keyboard Settings
To change your keyboard settings, choose Keyboard... from the
Session Manager Options menu.

From the Customize Keyboard dialog box, you can adjust or
disable any of the following settings:

Bell Volume
This warning bell sounds to alert you to system messages.
You can adjust the volume or toggle the bell on or off.

Keyclick Volume
You can adjust the keyclick volume or toggle the keyclick on
or off.

7–6 Customizing Your Session



Auto Repeat
The auto-repeat setting is indicated by a shaded button. To
disable Auto Repeat, click on the Disable button.

Lock Key State
Normally the Lock key on your keyboard produces capital
letters but not shifted number keys. To make your keyboard
work just like a typewriter keyboard, click on the Shift Lock
button. Choosing the Shift Lock option produces both capital
letters and shifted number keys when you press the Lock key.

7.4 Setting Another Session Language
By default, DECwindows applications are displayed in American
English, but are available in multiple languages. To use
DECwindows in another language, you must have the correct
language support installed on your system.

To set another session language, choose Language... from the
Session Manager Options menu. Session Manager displays the
Customize Language dialog box.

Scroll through the list of languages and select one. The next
application you start is displayed in that language. If your system
does not support the selected language, the application is displayed
in American English.

Language capabilities vary between systems. For example, if your
system has French language support and you select French as your
session language, any applications you run on your workstation are
displayed in French. However, if you run an application on a
remote host that does not support French, and you direct the
display to your workstation by setting the DISPLAY environment
variable, the application is displayed in American English. (See
Chapter 4 for information on running applications on remote
hosts).

To find out if an application is available in another language, see
the documentation for that application.

7.4.1 Keyboard Type
The location of specific characters on the keyboard varies
depending on the keyboard model. Selecting the keyboard type
that matches your keyboard model allows the system to display
the correct character when you press the corresponding key.
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The system default keyboard type is determined by the value of
your system’s console language variable and by the type of
keyboard that was connected when the system was last booted.

If the keyboard on your workstation has been changed since the
system was booted, you must set the keyboard type to match the
keyboard model. This changes the keyboard type temporarily
without permanently changing the system default keyboard type.
(For example, you could plug an Austrian German keyboard into a
workstation whose system default keyboard type, specified when
DECwindows was installed, is French.)

To find your keyboard model number, turn the keyboard upside
down and look for a label that specifies the model number. The
model number should be in a format similar to LK201-xx. (The
model number may also be listed as simply LK201. In this case,
the xx you need is in another place on the label. Look for a
number similar to nn-nnnnn-xx.) Use this number to select a
keyboard type from the Keyboard Type list box. For example, if
you are using an Austrian German keyboard and your keyboard
model is LK201-NG, select the Austrian German LK201-NG
keyboard type.

For any language other than North American or U.S., you can also
specify whether you want your keyboard to act as a data
processing (DP) or typewriter (TW) keyboard. Selecting a data
processing keyboard type enables the characters on the right half
of the keycaps. Selecting a typewriter keyboard enables the
characters on the left half of the keycaps.

To use this new keyboard type for subsequent sessions, save the
new setting before you end the current session. The new keyboard
type is in effect for your sessions only after DECwindows verifies
your password at the start of each new session.

7.5 Customizing Your Pointer
You can change the shape and color of the pointer, as well as
certain mouse characteristics. To change your mouse and pointer
settings, choose Pointer... from the Session Manager Options
menu. Session Manager displays the Pointer Options dialog box.

The Customize Pointer dialog box looks like this on intensity and
color systems:
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From the Customize Pointer dialog box, you can change any of
the following settings:

Pointer Acceleration
Click on one of the four options to vary the rate at which the
pointer moves in relation to the mouse. The None setting
keeps the pointer speed constant. The Fast setting makes the
pointer move farther as you move the mouse faster. Thus, you
can move the pointer to another part of the screen without
moving the mouse the same relative distance. The preset
option is Medium.

Mouse Double Click Timeout
DECwindows distinguishes between two successive single
clicks and a double click. Drag the Double Click Timeout
slider left or right to specify how fast you have click for a
double click. Drag right to allow more time between clicks.
You can also adjust the slider by moving the pointer to a
location on the scale and clicking MB2.
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Pointer Foreground Color
The pointer consists of an outline and a filled center.

On a monochrome system, the pointer’s filled area is white
with a black outline by default. Click on the Black On White
button to reverse the fill and outline colors.

On intensity and color systems, the pointer’s filled area or
foreground is black by default. To change this setting, click
on the Pointer Foreground Color button. Session Manager
displays a Color Attributes dialog box. For more information
about mixing colors, see Section 4.4.

To see your changes, click on Apply or OK in the Pointer
dialog box.

Pointer Background Color
This setting applies to color and intensity systems only. To
change the default pointer background color, click on the
Pointer Background Color button. Session Manager displays a
Color Attributes dialog box.

To see your changes, click on Apply or OK in the Pointer
dialog box.

Button Arrangement
The preset mouse button arrangement—MB1 on the left and
MB3 on the right—is natural for a right-handed user. You
can switch the mouse button arrangement by clicking on the
Left Handed radio button. The right mouse button becomes
MB1 and the left mouse button becomes MB3. MB2 stays
the same.

Pointer Shape
By default, the pointer is a left arrow. To change the pointer
shape, scroll through the list of shapes and select the one you
want.
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7.5.1 Saving Your New Settings
You can save your settings or reinstate other settings as follows:
2222222222222222222222222222222222222222222222222222222222222
Choose To2222222222222222222222222222222222222222222222222222222222222
Save Current Settings Save the settings you just changed for

use in every subsequent session.

Reset to Last Saved Settings Reinstate the last settings you saved.
Choose this menu item if you want to
reset any attributes that you changed
temporarily but did not save.

Reset to Default Reinstate the default settings.2222222222222222222222222222222222222222222222222222222222222

Some new settings will not be in effect until you end your current
session and begin another one.

7.6 Advanced Customization
When you save your current settings, the Session Manager records
the changes in the file .Xdefaults in your home directory. The
Session Manager reads this file each time you start a session. In
addition to the menu items available in the options menu, you can
edit resources in this file to further customize your environment.
See Chapter 9 for more information about modifying resources.
See also the appendixes to this guide and the OSF/Motif
Programmer’s Guide.
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This chapter describes how to use advanced features of Mail
(dxmail) which include the following:

• Specifying an editor to create messages

• Searching a selected folder for messages that have something
in common

• Sorting incoming mail automatically into appropriate folders

• Customizing your mail environment, including menus and
buttons

• Improving Mail startup performance by using a cache file
feature

8.1 Changing Editors
Use the DECwindows editing commands, described in Chapter 4,
or a text editor to create messages. The vi text editor is the Mail
program’s default editor. If more than one editor is available on
your system, for example, emacs, you can change editors as
follows:

1. Copy the /usr/lib/X11/app-defaults/DXMail file
to your home directory. This file lists available editors in
choiceEditor: statements.

2. Remove the comment symbol before the choiceEditor:
statement that corresponds to the editor you want to use. Such
editors as emacs, vi, and dxnotepad are available. For
example, to change the default editor to the Notepad, remove
the comment character (!) that appears in the following line:
!*choiceEditor: dxnotepad -geometry 600x400-0+20 %s



Then, add a comment character to the following line:
*choiceEditor: xterm -geometry =-0+20 -title \
dxmail-vi -e vi %s

If you have a private text editor, add a choiceEditor line
in your DXMail file similar to the entries provided and add
comment characters to the other choiceEditor lines.

3. If you are currently running mail, exit and restart mail. This
will ensure that Mail uses the new editor specification.

Note that editor customizations in your login script (for example,
your .login, .profile, or .cshrc file) are not in effect
when the editor is used from Mail. Customizations must appear in
the .xsession file in your home directory. For more
information about the .xsession file, see the X Window System
Administrator’s Guide.

8.2 Picking Messages

 

Pick

Pick from selected folder...

Pick from opened folder...

Create new sequence...

Open sequence

Add to sequence

Remove from sequence

Delete sequence

Mail can search the open or selected folder for messages that have
something in common. For example, you could pick messages that
were sent by a specific user on a specific day, or messages that
contain a specific word in the subject line.

Once it finds messages that meet your criteria, Mail displays a list
of these messages. You can then perform tasks such as copying,
moving, extracting, or reading on this set of messages.

To pick messages:

1. Open or select the folder containing the messages. If you
selected multiple folders, the first folder is used for the pick
operation.

2. Choose the Pick from opened folder... or the Pick from
selected folder... menu item from the Main Inbox window’s
Pick menu.

Mail displays a dialog box.
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The dialog box lets you specify the criteria for picking
messages.

3. Click on the pick criteria text-entry boxes, as explained in the
following table, and type in your message pick criteria.

4. After you have entered your pick criteria, click on the OK push
button to pick the designated messages, or click on the Cancel
push button to cancel the pick operation.

The following table describes the options in the Pick dialog box:
2222222222222222222222222222222222222222222222222222222222222
Option Description2222222222222222222222222222222222222222222222222222222222222
From: The user name of the sender whose messages

you want to pick.

To: The user name of the addressee, or the name
of an alias list whose messages you want to
pick.

Cc: The user name of the addressee (or the name
of a distribution list) who received courtesy
copies of messages you want to pick.

Date: The messages received on the date you
specify.
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2222222222222222222222222222222222222222222222222222222222222
Option Description2222222222222222222222222222222222222222222222222222222222222
Subject: Any text included in the subject line of

messages you want to pick.

Search: Any text in the message body.

Pick from folder: The name of the folder from which you want
to pick.

Create sequence: The sequence name you want to use.

With msgs from
sequence:

The different sequence name if you would also
like to include information from another
sequence.

Date range: The from date and the before date shown in
dd-mmm-yyyy format, for example, 02-Sep-
1992. The before date specifies all messages
received before a particular date. The from
date specifies the starting date to pick
messages.

Date field: The field that you want the date ranges to
search on, such as the Date: field, the
Forwarded: field or the Replied: field.

Merge with old entries
in sequence:

The sequence messages that are merged into
the new sequence.2222222222222222222222222222222222222222222222222222222222222

When you enter text in any of the first five text-entry boxes in the
dialog box, Mail searches for matching text anywhere in the
corresponding fields of all messages in the open or selected folder.

Search text is case sensitive and is considered a search text string.
That is, entering the text John in the From: text-entry box will
pick messages from Jane Johnson and John Doe, but not Olav
Bejohnesson or JOHN::Smith.

The leftmost column of the screen lists a set of Skip toggle
buttons. Enabling these buttons will have these fields skipped
during the search process. The rightmost portion of the display
lists a set of Or toggle buttons. Enabling these buttons generates
another field in the corresponding category that allows you to
further define the search process.

Below the row of Skip toggle buttons on the left side of the screen
is the -Or- toggle button. Enabling this button causes Mail to
produce another set of fields for further defining the search
process.
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Once you have defined a set of pick criteria, the message list is
updated to list only the picked messages. When you close the
folder, Mail discards the picking criteria and all messages are
again available for reading.

8.3 Autosorting Incoming Mail
This section describes how to modify your Mail environment so
that Mail automatically places incoming messages into other
folders and drawers besides the inbox folder.

You can use the slocal function of mh mail with Mail to
automatically sort incoming mail and to highlight different folders,
depending on the type of message received. To do this, set up
slocal to filter incoming mail. The slocal function will, in
turn, spool the mail messages into different files, anywhere you
specify under your home directory. Mail will also associate each
of these spool files with a particular folder. Thus, when the spool
files have messages in them, Mail will detect and highlight the
corresponding folder to that file.

Setting up your mail environment to automatically sort messages
requires that you know how the slocal function works. The
following example explains how to set up the maildelivery
file, which is used by slocal. Another file called
decxmailcheck is needed by Mail to map folders with spool
files.

Assume that you want to receive mail from a mailing list called
mail_list. To automatically sort the messages to mail_list
from the rest of the incoming mail and to specifically highlight a
folder named MailList perform the following steps.

All ‘‘.’’ files are to be created in the user’s home directory only.

1. Create a .maildelivery file in your home directory with
at least the following entries:
From mail_list > ? path/mail_list
default - > ? path/inbox

The path is the absolute pathname to a private spool area
under your home directory.

For more details on setting up the .maildelivery file,
refer to the slocal(1) reference page.
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2. Create a .decxmailcheck file in your home directory with
at least the following entries:
inbox path/inbox
MailList path/mail_list

The path is the absolute pathname to the spool files created
by slocal.

3. Create a .forward file in your home directory with the
following line, including the quote marks:
"| /usr/lib/mh/slocal -user username"

The username is your login name.

To sort your incoming messages, restart Mail. You must restart
Mail after every modification to either file.

You should be aware that highlighting of folders works well with
top-level folders, but not with subfolders.

8.4 Customizing Your Mail Environment
You can customize many Mail features to suit your working
environment. For example, you can specify where to put deleted
messages; how to handle carbon copies; and what window display
style you want Mail to present. You can also add or remove
commands to Mail menus and buttons.

8.4.1 Modifying Your Mail Profile
To make changes to your Mail environment, choose the Modify
mail profile... menu item from the Customize menu in the Main
Inbox window. The Modify mail profile... menu item is the only
menu item. Mail generates the Mail Customizations dialog box
where you can make the following changes:

Skip to next message upon deleting current one.
With this option enabled, mail proceeds to the next message
in the current folder when you delete the message you are
reading. Disable this setting if you want to specify which
message to open next after deleting the current one.

Skip to next message upon moving current one.
With this option enabled, mail proceeds to the next message
in the current folder after you complete a move operation.
Disable this option if you want to specify which message you
want to open next after moving the current one.
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Commit changes in a folder upon closing it.
With this option enabled, Mail performs all changes you have
made such as deleting, moving, and copying messages to
other folders when you close the current folder. Disable this
option if you want to explicitly commit changes by clicking
on the Commit changes button.

Renumber messages in a folder after every commit (Slow).
With this option enabled, Mail renumbers all of the mail in
the current folder whenever a Commit changes function
occurs. If the folder has many messages, this becomes time-
consuming.

Digital recommends that you disable this setting if you have
numerous messages in your folders. With this option
disabled, you must choose the Renumber messages menu
item from the Main Inbox window’s Maintenance menu to
renumber the messages in a folder.

Put deleted messages into wastebasket instead of deleting
immediately.

With this option enabled, Mail moves deleted messages to the
wastebasket folder, allowing you to retrieve them if you
deleted them by mistake. Disabling this option causes Mail to
irretrievably delete messages.

Buttons affect the current message if no messages are selected.
With this option enabled, Mail highlights all buttons on a
selected message whether the button function is available or
not. With the button disabled, Mail highlights only those
buttons that are functionally available. Normally, this button
is disabled.

Open Subfolders when drawer is open.
With this option enabled, Mail opens all folders in a drawer
when you open the drawer. Disable this option if you want to
open a folder by clicking on the folder name.

Close Subfolders when another folder is opened.
With this option enabled, Mail closes all of the folders in a
drawer and removes them from the display when you close
the drawer. Disable this option to leave all the folders
displayed.

Having all folders displayed can become confusing if you
have many folders in several drawers—there is no way to
distinguish which folders belong to which drawers.

Beep instead of putting up a No New Mail dialog box.
Mail sounds a beep when you click the New Mail button and
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there is no new mail. When you disable this option, Mail
instead displays a dialog box indicating that no mail arrived.

Select who to carbon-copy on replies:
You can set only one of the three options in this group at a
time.

The Carbon-copy only to sender setting causes Mail to reply
only to the originator of the message.

The Carbon-copy to everyone who received original message
setting causes Mail to reply to the originator and everyone
else who received the original mail.

The Act according to mh_profile, or system default setting
causes Mail to send mail according to instructions in your
.mh_profile file.

Select whether to send yourself a carbon-copy of your replies:
You can set only one of the three options in this group at a
time.

The Don’t send carbon-copies to yourself setting causes Mail
to send a copy of your reply to the originator without sending
a copy to yourself.

The Do send carbon-copies to yourself setting causes Mail to
send you a copy of your reply.

The Treat yourself just like everyone else setting causes Mail
to send only copies of your reply to those addresses specified
in the cc: field of the message envelope.

Start dxmail as an icon.
Enable this setting to start Mail as an icon. Disable this
setting to cause Mail to automatically display the Main Inbox
window when it starts.

Annotate messages that have been replied to.
Enabling this option causes Mail to time-stamp and to
identify to whom the reply was sent. Mail also denotes that
the message was replied to in the folder message list.

Annotate messages that have been forwarded.
Enabling this option causes Mail to time-stamp and add a
forwarding identifier. Mail also denotes that the message was
forwarded in the folder message list.

Select Main Window Style.
You can specify which style of window you prefer: Paned
window or Outline Style. When you change window styles
you must restart Mail to see the changes take effect.
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8.4.2 Adding Commands to Menus and Button Boxes
To add or delete commands from pull-down menus and button
boxes on any window, edit the DXMail resource file as follows.
(For information on specifying resources in resource files, see
Chapter 9.)

1. Rename the DXMail resource file located in your home
directory.

2. Copy the default resource file that exists in
/usr/lib/X11/app-defaults as DXMail into your
home directory.

3. Retain only the menu or button box entries that you want to
modify.

4. Append the contents of the renamed customized DXMail
resource file to the end of the new DXMail file you are
creating.

5. Add or delete entries as described in the following example
and then restart Mail after saving the changes.

For example, to add a ‘‘rescan’’ option to the lower button box in
the Main Inbox window, look for the following entry in the
DXMail file:

"messageCommandBar: buttonbox"

Then add the following information before the endbuttonbox
line:

"rescan: rescan() \n\"

The edited part now looks like this:
messageCommandBar: buttonbox \n\

deliverMail: incorporate() \n\
reply: reply-selected(send) \n\
forward: forward-selected(send) \n\
printNow: print-selected() \n\
move: move-selected() \n\
delete: delete-selected() \n\
rescan: rescan() \n\

endbuttonbox
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Use function names already defined within dxmail. You cannot
introduce a new function. If you add a function that does not exist,
the button appears, but it is dimmed (inactive) and unusable. For
example, specifying the following button causes a dimmed
(inactive) button:
printNow: print-selected() \n\

8.4.3 Improving Mail Startup Performance
Mail’s startup performance is improved by using a cache file
feature. Mail uses a cache file to store the names of your drawers
and folders so that it can use this information at startup instead of
rescanning the $HOME/Mail directory hierarchy. You will only
see a performance improvement after the second or subsequent
restart of Mail. During the first start and in the absence of the
cache file, Mail must scan the $HOME/Mail directories. The
time needed for this is proportional to the size of the directory
tree.

If Mail terminates abnormally, it invalidates the cache file and
must rescan the $HOME/Mail directories upon restart. Mail
gives you a menu option to invalidate the cache when exiting the
application, if there appears to be an inconsistency between the
cache file and the actual layout of the folders in the directory tree.
To invoke this option, choose the Invalidate cache on exit menu
item from the Maintenance menu in the Main Inbox window.
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9Using Configuration Files to Customize
Your Windows Environment3333333333333333333333

You can use DECwindows as it comes packaged, or you can
create a personalized environment. Most Motif applications
provide built-in ways to change various settings such as colors and
fonts. Customization functions are often found on the Options
Menu on an application’s menu bar. The customization features
provided by an application typically are sufficient for most users.
The changes you make with an application’s option menu are
recorded in special resource files.

You can modify these special files to further customize your
environment; for example, you can change:

• The height and width of a window

• The background and foreground color of window components

• The fonts that appear in labels or titles

• The way keyboard keys and mouse buttons map to text editing
functions

This chapter introduces the basics you need to customize your
windows environment by editing the .Xdefaults, Mwm,
.mwmrc, and application-specific resource files. It also describes
how to switch keyboard styles, in Section 9.3.

After working through this chapter, you may want to learn more
about the things you can customize. Refer to the appendixes to
this guide, the mwm(1) and X(1) reference pages, the MWM
section of the OSF/Motif Programmer’s Guide, the X Window
System Environment manual, and the X Window System
Administrator’s Guide.

9.1 Understanding Resources and Resource Files
An important feature of the X Window System is its flexibility.
You can control many aspects of an application’s look and feel by
using a variable called a resource. You change the behavior or
appearance of a program by changing the value associated with a
resource variable.



A resource is typically named for the aspect of window appearance
or behavior that it controls. For example, the resource name
iconBoxTitle is the title displayed at the top of the icon box.
Resources can be set for data such as window size and color,
graphics contents, and fonts. The resources for each client are
listed on its reference page.

9.1.1 Where Resource Values Are Specified
Resources and values are recorded in special files called resource
files. Most applications read these files during startup and use the
entries you defined to customize the appearance and characteristics
of their windows.

The system default resource values are specified in files in
/usr/lib/X11/app-defaults. These files are Mwm,
Xdefaults, and application-specific resource files.

When you Save Current Settings with the Session Manager, you
create an .Xdefaults file in your home directory. It differs
from /usr/lib/X11/app-defaults/Xdefaults insofar
as you have customized your session as discussed in Chapter 7.
Note the prefix period differentiating the names of your own
.Xdefaults file from the system defaults file
/usr/lib/X11/app-defaults/Xdefaults.

When running Session Manager, the values in the file
/usr/lib/X11/app-defaults/Xdefaults apply to all
applications and all users. Values in your ~/.Xdefaults file
affect all applications that you run. The values in an application-
specific resource file affect only a single application that you run.
The values in /usr/lib/X11/app-defaults/Xdefaults
apply only if you are running Session Manager (dxsession).
However, the values in ~/.Xdefaults apply regardless of
which session manager you use.

You can also use your .Xdefaults file to customize individual
applications by adding to it specifications from application-specific
resource files. Another way to customize an individual application
is by modifying, in your home directory, a copy of its
application-specific resource file.

9.1.2 Creating the .Xdefaults File
If you select the Save Current Settings menu item from the
Session Manager’s Options menu, an .Xdefaults file is
created in your home directory. You can also create one by
copying /usr/lib/X11/app-defaults/Xdefaults to
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~/.Xdefaults. You can modify, remove, or add to the entries
in it to customize your global windows environment.

See Appendix D for a sample .Xdefaults file. Note that
comment lines begin with an exclamation point (!).

The .Xdefaults file is simply a list of resource specification
strings you enter or modify to customize your windows
environment. Each resource specification in an .Xdefaults file
has roughly the following format:1

[name*]resource: value

Here,

name Specifies the name or name string representing the
application or window component to which the
resource assignment should apply. If this argument is
not specified, the resource assignment is globally
available to all applications.

You must separate names in this string with either an
asterisk (*) or a period (.), as follows:

*
Specifies that the resource definition applies to all
window components even if classes or names are
omitted in the specification string.

.
Indicates that the resource definition applies only to the
window component named.

resource Specifies the resource (characteristic) you want to
modify.

value Specifies the value that is to be assigned to the
resource.

Resource names are case sensitive. Most names begin with initial
lowercase letters; compound names use initial capital letters to

3333333333333333333
1 The exact format of a resource specification is given in Appendix A of the X Window

System Toolkit, P. Asente & R. Swick, Digital Press, Bedford, MA, 1990.
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separate names, for example:
backgroundPixel

When you finish adding resource specifications to your
.Xdefaults file, you must load changes into the server to have
them take effect. To load changes, take one of the following
actions:

• Quit the Session Manager, then start a new session.

• Run the X windows resource database utility to reload the
.Xdefaults file into the server.2 Enter:
% /usr/bin/X11/xrdb .Xdefaults

By contrast, you do not have to start a new session or run xrdb
to effect customizations contained in application-specific resource
files—you merely restart the application.

9.1.3 Specifying Colors and Fonts
There are two general ways to specify a color when you are
customizing your environment:

• Create a color directly by using a hexadecimal number.

• Use a predefined color name.

To specify a color directly, that is, without using a color name, use
a three-part hexadecimal number. The three parts of the number
specify the intensity of red, green, and blue, respectively.

The number must begin with a number sign (#) and cannot
include any spaces. Each of the three parts must use the same
number of digits. Here are some examples:
#9047A5 #F0F #55559999BBBB #0000FF #50A070

When using a named color, be sure to type the name exactly as it
appears in the file /usr/lib/X11/rgb.txt on your system.
This list of names is also available in the color widget’s Browser
color model (see Chapter 4).

Table 9-1 lists some of the window elements you can color. For
more information, see the documentation for the client you want to
modify.

3333333333333333333
2 The utility is part of the Basic X Environment subset and might not be installed on

your system. See your system manager if it is not installed.

9–4 Using Configuration Files to Customize Your Windows Environment



There are many other ways to specify colors. See the X Window
System Administrator’s Guide.

Table 9-1:   Example Color Resources
22222222222222222222222222222222222222222222222222222222222222
To color this element Use this resource22222222222222222222222222222222222222222222222222222222222222
Pointer foreground color DXsession.pointer_foreground:

DXsession.display_foreground:Session Manager display
foreground color

DXsession.display_background:Session Manager display
background color

xterm window text XTerm*foreground:

xterm window background XTerm*background:

xterm window text cursor XTerm*cursorColor:

xterm window mouse pointer XTerm*pointerColor:

Window frame text Mwm*foreground:

Window frame background Mwm*background:

Mwm*topShadowColor:Top and left window frame
bevel

Mwm*bottomShadowColor:Bottom and right window
frame bevel

Active window frame text Mwm*activeForeground:

Mwm*activeBackground:Active window frame
background

Mwm*topShadowColor:Top and left active window
beveling

Mwm*bottomShadowColor:Bottom and right active
window beveling22222222222222222222222222222222222222222222222222222222222222

9.1.3.1 Resource Specification Examples

Suppose you want all your xterm windows to have a blue
background, a yellow foreground, and use the fixed font. Follow
these steps:

1. Start your text editor and open the .Xdefaults file in your
home directory.
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2. Insert the following lines into the file:
XTerm*foreground: yellow
XTerm*background: blue
XTerm*font: fixed

3. Save the file.

4. Load the resources into your display’s resource database with
the command
% xrdb -merge .Xdefaults

Start a new terminal window by entering the following command
in a terminal window:
% xterm &

The new window’s background should be blue and the foreground
(text) should be yellow.

The default font sizes in DECterms are chosen to look best when
using 100 DPI fonts. If the default fonts are too small or you are
using 75 DPI fonts, you can change the fonts by adding the
following resource specifications to the DECterm resource file
/usr/lib/X11/app-defaults/DXterm or the
.Xdefaults file in your home directory:
DXterm.main.terminal.bigFontSetName: -*-terminal-*-*-*--*-180-*-*-*-*-*-*
DXterm.main.terminal.littleFontSetName: -*-terminal-*-*-*--*-140-*-*-*-*-*-*

9.1.3.2 Specifying Colors and Fonts on the Command Line

Suppose you want to start a new terminal window, but want it to
have a red background. You can override the settings in your
.Xdefaults file by specifying colors on the command line. For
example, enter the following command:
% xterm -bg red &

Since you did not specify a foreground color (-fg), the yellow
value was read from the .Xdefaults file. To see which options
are actually available for a particular client, refer to an
application’s reference page.

To specify a font on the command line, use the -fn option. For
example, the following command creates an xterm window using
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an 18 point font named Courier:
% xterm -fn "-*-courier-medium-r-normal--18-*-*-*-*-*-*-*" &

The quotation marks surrounding the font name are necessary to
prevent your shell from trying to interpret the wildcard font name
as a file specification.

For a complete discussion of conventions for font names and font
properties, see Part IV of the X Window System: The Complete
Reference to Xlib, X Protocol, ICCM, XLFD. The X Window
System Administrator’s Guide provides detailed information about
locating and managing fonts in the X Window System
environment.

9.1.4 Considerations for Setting Resources
Keep the following in mind when customizing resource files:

• Users can modify resource files in their home directory.
Superuser privileges are required to modify systemwide
resource files.

• Before you edit a resource file, copy the old file to another
name. This gives you an easily accessible backup copy that
you can reload if you make a serious error.

• Place resource specifications for frequently used clients (for
example, dxsession or dxterm) in front of resource
specifications for other clients.

• Use the ifdef COLOR construct to create an
~/.Xdefaults file that supports both color and
monochrome monitors. If you do not, colors might be adjusted
for monochrome in a way that results in blank displays.

• Clients that access resources from other screens in a
multiscreen environment might not have the desired results.

9.1.5 Locating Resources
Resources are assigned when the application program creates a

window component or by the application’s default resource file.
Some applications define unique resources for window
components. For example:

• The PrintCommand resource in Mail

• The windowManagerName_default,
create_terminal, and applications resources in the
Session Manager
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• The terminalMode resource in DECterm

These resources are named in the individual applications’ reference
pages and default resource files located in:
/usr/lib/X11/app-defaults/application-name

Customize these resources by referencing them by name in your
.Xdefaults file.

Example 9-1 and Example 9-2 show sample application default-
resource files.

Example 9-1:   Visual Differences Default-Resource File

*dxdiff*textdisplay*fontList: fixed
*dxdiff*displayLineNumbers: True
*dxdiff*drawDiffsAsLines: False
*dxdiff*displaymenu*borderWidth: 1

Example 9-2:   DECterm Default-Resource File

DXterm*terminalMode: 1
DXterm*autoWrapEnable: on
DXterm*autoResizeTerminal: on
DXterm*autoResizeWindow: on

9.2 Changing Key Definitions
You can use the .Xdefaults file in your home directory to add
resource specifications that change the way keys are mapped to
text editing commands. Table 9-2 lists the text editing keys you
can redefine and describes the preset text editing function for each
key.

Table 9-2:   Text Editing Keys and Preset Functions
2222222222222222222222222222222222222222222222222222222222222
Key Editing Function2222222222222222222222222222222222222222222222222222222222222
→ (right arrow) Moves the cursor one character to the right. In

a single-line field, the cursor does not move
when positioned at the end of the line. In a
multiline field, the cursor moves into the first
position of the next line.

9–8 Using Configuration Files to Customize Your Windows Environment



Table 9-2:   (continued)
2222222222222222222222222222222222222222222222222222222222222
Key Editing Function2222222222222222222222222222222222222222222222222222222222222
← (left arrow) Moves the cursor one character to the left. In

a single-line field, the cursor does not move
when positioned at the beginning of the line.
In a multiline field, the cursor moves into the
last position of the previous line.

↑ (up arrow) In a multiline field, moves the cursor up one
line.

↓ (down arrow) In a multiline field, moves the cursor down
one line.

F12 Positions the cursor at the beginning of the
line.

Shift/F12 Positions the cursor at the end of the line

F13 Deletes characters to the left of the cursor
through the beginning of the word, and shifts
to the left all text to the right of the deleted
characters.

Shift/F13 Deletes the characters to the right of the cursor
through the beginning of the word, and shifts
to the left all text to the right of the deleted
character.

331
33

(Delete key) Deletes the character before the cursor and
shifts to the left all text to the right of the
deleted character.

Shift/ 331
33

In overstrike mode, deletes the character under
the cursor and shifts to the left all text to the
right of the deleted character.2222222222222222222222222222222222222222222222222222222222222

9.2.1 Assigning New Text Editing Commands
A translation specification string in your .Xdefaults file
assigns a text editing command to a named key or mouse button
combination. To assign a new editing command to a named key,
use the following syntax:

*Text.translations: key: function
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Here,

key Specifies the key or mouse button that is used to
invoke the named function.

function Specifies the function to be invoked when the named
key is pressed.

You can also specify the following mouse buttons in a translation
specification string:

Btn1 Left button

Btn2 Middle button

Btn3 Right button

You can assign the following actions to each mouse button:

Down Action is invoked when the button is pressed.

Up Action is invoked when the button is released.

PtrMoved Action is invoked when the mouse button is down
and the pointer is moved.

9.2.2 Example Text Translations
Example 9-3 provides text translation entries you can add to your
.Xdefaults file. These resource specifications assign emacs-
like key bindings to your keyboard keys when you use the Motif
text widget (as, for example, when you edit with the Notepad
[dxnotepad] desktop application).

Example 9-3:   Sample Text Specifications

*Text.translations:
!
Shift<Key>osfDelete: delete-next-character()\n\
<Key>osfDelete: delete-previous-character()\n\
Shift<Key>osfRight: forward-word()\n\
Shift<Key>osfLeft: backward-word()\n\
<Key>F12: beginning-of-line()\n\
Shift<Key>F13: delete-next-word()\n\
<Key>F13: delete-previous-word()\n\
Ctrl<Key>e: end-of-line()\n\
Ctrl<Key>j: delete-previous-word()\n\
Ctrl<Key>h: beginning-of-line()\n\
Ctrl<Key>r: redraw-display()\n\
Ctrl<Key>u: delete-to-start-of-line()\n\
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Example 9-3:   (continued)
!
!
!
Shift ~Ctrl ~Alt<Btn1Down>: extend-start()\n\
Shift ~Ctrl ~Alt Button1<PtrMoved>: extend-adjust()\n\
Shift ~Ctrl ~Alt<Btn1Up>: extend-end()\n\
Ctrl ~Shift ~Alt<Btn1Down>: grab-focus() set-insertion-point()\n\
Ctrl ~Shift ~Alt Button1<PtrMoved>: \n\
Ctrl ~Shift ~Alt<Btn1Up>: \n\
~Shift ~Ctrl ~Alt Button1<PtrMoved>: extend-adjust()\n\
~Shift ~Ctrl ~Alt<Btn1Up>: extend-end()\n\
~Shift ~Ctrl ~Alt<Btn3Down>: stuff()\n\
!
!
!
Ctrl<Key>f: forward-character()\n\
Ctrl<Key>b: backward-character()\n\
Alt<Key>f: forward-word()\n\
Alt<Key>b: backward-word()\n\
Alt<Key>]: forward-paragraph()\n\
Ctrl<Key>[: backward-paragraph()\n\
Ctrl<Key>a: beginning-of-line()\n\
Ctrl<Key>e: end-of-line()\n\
Ctrl<Key>n: next-line()\n\
Ctrl<Key>p: previous-line()\n\
Ctrl<Key>v: next-page()\n\
Alt<Key>v: previous-page()\n\
Alt<Key>\\<: beginning-of-file()\n\
Alt<Key>\\>: end-of-file()\n\
Ctrl<Key>z: scroll-one-line-up()\n\
Alt<Key>z: scroll-one-line-down()\n\
Ctrl<Key>d: delete-next-character()\n\
Ctrl<Key>h: delete-previous-character()\n\
~Shift Alt<Key>d: delete-next-word()\n\
~Shift Alt<Key>h: delete-previous-word()\n\
Ctrl<Key>w: kill-selection()\n\
Ctrl<Key>y: unkill()\n\
Alt<Key>y: stuff()\n\
Ctrl<Key>j: newline-and-indent()\n\
Ctrl<Key>o: newline-and-backup()\n\
Ctrl<Key>m: newline()\n\
Ctrl<Key>l: redraw-display()\n\
Ctrl<Key>k: kill-to-end-of-line()\n\
Any<Key>: self-insert()

Table 9-3 summarizes the functions you can assign to keys and
describes the text-editing action for each.
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Table 9-3:   Text Functions
22222222222222222222222222222222222222222222222222222222222222
Function Description22222222222222222222222222222222222222222222222222222222222222
forward-character Moves the cursor forward one

character.

backward-character Moves the cursor backward one
character.

forward-word Moves the cursor forward one
word.

backward-word Moves the cursor backward one
word.

forward-paragraph Moves the cursor forward one
paragraph.

backward-paragraph Move backward one paragraph.

delete-next-character Deletes the character after the
insertion point.

delete-previous-character Deletes the character before the
insertion point.

delete-next-word Deletes the word after the insertion
point.

delete-previous-word Deletes the word before the
insertion point.

delete-next-line Deletes the line after the insertion
point.

delete-previous-line Deletes the line before the
insertion point.

delete-selection Deletes the selection.

insert-file Inserts a file into the text.

kill-next-word Kills the word after the insertion
point.

kill-to-end-of-line Kills the characters after the
insertion point to the end of the
line.

kill-selection Kills the selection.

newline-and-indent Moves the cursor to the next new
line and indent.

newline-and-backup Moves the cursor to the beginning
of the previous line.

9–12 Using Configuration Files to Customize Your Windows Environment



Table 9-3:   (continued)
22222222222222222222222222222222222222222222222222222222222222
Function Description22222222222222222222222222222222222222222222222222222222222222
next-page Moves the cursor to the next

screenful of text.

previous-page Moves the cursor to the previous
screenful of text.

select-all Selects all the text.

select-word Selects the word the insertion point
is in.

stuff Inserts the text that was last
selected in any window.

unkill Inserts the text that was last
deleted.22222222222222222222222222222222222222222222222222222222222222

9.3 Changing Keyboards
Several Digital workstations come with Personal Computer (PC)
style keyboards. Currently, these keyboards have one of the
following model numbers, although more models may be produced
in the future:

• PCXAL

• LK443

• LK444

Other Digital workstations come with keyboards such as the
LK201 or LK401.

The two styles of keyboards differ both in the functions assigned
to certain keys and in the number of function keys. For example,
the PC-style keyboards have only 12 function keys (F1 through
F12); the LK201/LK401 keyboards have 20 function keys (F1
through F14, Help, Do, and F17 through F20).

Digital UNIX provides a script that automatically performs
mappings to allow you to switch keyboard styles. This script,
/usr/examples/pc_to_lk_keys.sh, uses the xmodmap
utility to edit the keyboard modifier map and keysym table. (For
details about the utility, see the xmodmap(1X) reference page.)

If you have a PC-style keyboard, you can run the script to map
most of the keys on the two keypads to the right of the main
keyboard, as well as a few keys in the top function key row, to the
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corresponding keys on the LK201/LK401 keyboards. For example,
by running the script, you change the function of the keypad Insert
key on the PC-style keyboard to perform the keypad Find function
from the LK201/LK401 keyboards.

Similarly, if you have an LK201/LK401 style keyboard, you can
run the same script, this time with the -u option flag, to map the
keypad keys to the corresponding PC-style keys.

A copy of the script is located in the following file on your Digital
UNIX system: /usr/examples/pc_to_lk_keys.sh

To run the script, at the system prompt enter the name of the file
as if you were entering a command. The first command line in the
following example changes PC-style keys to LK201/LK401 keys.
The second command line changes LK201/LK401 keys to PC-
style keys.
% /usr/examples/pc_to_lk_keys.sh
% /usr/examples/pc_to_lk_keys.sh -u

To have the script run automatically each time you log on to your
workstation, use an editor to create or modify the .xsession
file in your home directory to read as follows :
#!/bin/sh
/usr/examples/pc_to_lk_keys.sh
dxsession

This change PC-style keys to LK201/LK401 keys. The same
.xsession file, but with -u added to the end of the second
line, changes LK201/LK401 keys to PC-style keys.

Now, whenever you log in, your keyboard is automatically set to
the different keyboard style.

Table 9-4 shows the keys on the LK201/LK401 keyboard and their
corresponding equivalents on the Digital PC-style keyboard.

Table 9-4:   LK201/LK401 Key Functions and Their PC-
Style Equivalents

2222222222222222222222222222222222222222222222222222222222222
Key on the LK201/LK401
Keyboards

Equivalent Key or Function on a
PC-Style Keyboard2222222222222222222222222222222222222222222222222222222222222

Help Print Screen

Do/Menu Scroll Lock

Insert Home

Find Insert

Remove Page Up
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Table 9-4:   (continued)
2222222222222222222222222222222222222222222222222222222222222
Key on the LK201/LK401
Keyboards

Equivalent Key or Function on a
PC-Style Keyboard2222222222222222222222222222222222222222222222222222222222222

Next Page Down

Select Delete

Prev End

Keypad 0 Ins, Keypad 0

Keypad 1 End, Keypad 1

Keypad 2 down arrow, Keypad 2

Keypad 3 PgDn, Keypad 3

Keypad 4 left arrow, Keypad 4

Keypad 5 Keypad 5

Keypad 6 right arrow, Keypad 6

Keypad 7 home, Keypad 7

Keypad 8 up arrow, Keypad 8

Keypad 9 PgUp, Keypad 9

Keypad . (period) Keypad Del

Keypad - Keypad + (addition)

Keypad , no equivalent PC-style keypad key

Keypad Enter Keypad Enter

PF1 Num Lock

PF2 Keypad / (division)

PF3 Keypad * (multiplication)

PF4 Keypad - (subtraction)2222222222222222222222222222222222222222222222222222222222222

Note that the Digital PC-style keyboard has a key labeled ← in the
position where the key marked 331

33
is located on the

LK201/LK401 keyboard. On both styles of keyboard, this key
deletes the character to the left of the cursor when pressed. On the
PC-style keyboard, you can use the Delete key on the near keypad
to delete the character that the block cursor is on or the character
to the left of the line cursor.

In keyboard mappings, the ← and 331
33

keys perform the backspace
function. The Delete key on the PC-style keyboards performs the
delete function.
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9.4 Customizing the Motif Window Manager (mwm)
To customize the Motif window manager (mwm), modify a special
file called .mwmrc or set resources in the Mwm file in your home
directory.

9.4.1 Setting Window Manager Resources
The Mwm file contains resource settings for window manager
items such as border, menu, and icon colors; focus policy; use of
an icon box; icon placement and size; and menu bindings. The
mwm first searches your home directory for the Mwm file, then
searches for it in /usr/lib/X11/app-defaults.

Place all mwm resources in the Mwm resource file. For new
resources to take effect, select Restart from the Workspace menu
to restart mwm.

Tip

For monochrome monitors, mwm overrides the color
resources defined in Mwm with those defined in
/usr/lib/X11/app-defaults/Mwm_bw and
/usr/lib/X11/app-defaults/Mwm_gray.

9.4.2 Customizing Window Manager Behavior
Default operation of mwm is controlled by the systemwide file
named /usr/lib/X11/system.mwmrc. This file establishes
the contents of the Workspace (root) and Window menus, and
what key and button combinations you use to invoke menu
functions and manage windows.

The file .mwmrc defines:

• Window menu names and contents

• What happens when you select a menu item or press a mouse
button

• Which keyboard keys act as accelerator keys

See Appendix D for a listing of specific appearance and behaviors
you can change.
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9.4.3 Customizing the Workspace Menu
This section describes how to make a personal copy of .mwmrc
to add a Workspace submenu called ‘‘Clients’’ that contains some
of the more frequently used X Consortium clients. Appendix D
contains a sample file you can use for a reference.

1. Copy the file system.mwmrc to your home directory with
the following command:
% cp /usr/lib/X11/system.mwmrc .mwmrc

2. Edit the .mwmrc file. Look for the following text:

Menu RootMenu
{

"Workspace" f.title
"Shuffle Up" _U f.circle_up
"Shuffle Down" _D f.circle_down
"Next Window" _N f.next_key
"Previous Window" _v f.prev_key
no-label f.separator

"Pack Icons" _P f.pack_icons
"Options" _O f.menu MwmCustomizeMenu
no-label f.separator

"Restart..." _R f.restart
"Help" _H f.menu MwmHelpMenu

}

After the line that begins with "Help" (and before the close
brace), insert the following line to add a menu item called
Clients to your Workspace menu:

"Clients" _C f.menu MyClientsMenu

After the close brace, enter the following text to create the new
Clients menu. Note the f.exec function is used to call each
client.
Menu MyClientsMenu
{

"Clients Menu" f.title
"Start Clock" f.exec "xclock &"
"Start Load" f.exec "xload &"
"Start Calc" f.exec "xcalc &"
"Start xbiff" f.exec "xbiff &"

}

When you are done, double-check your typing and then save
the file.

The changes you made to .mwmrc are not read by the window
manager until it is restarted. Select the Restart menu item in the
Workspace menu to restart the window manager.
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This chapter provides information on AccessX, Puff, Optacon, and
Xsoundsentry. These utilities provide features to help people with
physical, hearing, and visual disabilities.

10.1 Using AccessX
AccessX provides features to help people with different disabilities
interact with Digital workstations running the Digital UNIX
operating system (Version 3.0 or higher). These features can make
it easier for you to use the standard workstation input devices: the
keyboard and the mouse. You interact with the workstation as
usual, by entering commands and manipulating menus and dialog
boxes. However, with AccessX, you have an easier time
performing these input operations.

This section discusses the AccessX features. These features have
been incorporated into the Digital UNIX operating system
software, so they are available for you to turn on whenever you
want to use them. In some instances, you might need to have an
administrator establish certain default settings. But, you can turn
the features on and off any time.

The following list summarizes the features:

• StickyKeys

The StickyKeys feature lets you perform multikey operations
with one hand, one finger, or a mouth stick. You can use this
feature to enter uppercase letters or certain punctuation
characters without having to hold down the Shift Lock key
while you press the letter key. This feature also makes it easier
to enter control characters such as Ctrl/c.

• MouseKeys

The MouseKeys feature lets you use keys on the numeric
keypad as well as other keyboard keys instead of the mouse to
perform input functions such as clicking on objects or moving
the cursor. With this feature, you can use one finger or a
mouth stick to move the cursor to different areas of the screen,
manipulate menus, and select, cut, and paste text.



• ToggleKeys

The ToggleKeys feature provides audio feedback when a
keyboard light indicator has been turned on or off. This feature
can help people who might have difficulty seeing the keyboard
light indicators for these keys or people who are using a
keyboard that does not provide light indicators for any
keyboard settings.

• RepeatKeys

The RepeatKeys feature allows you to adjust how fast the
auto-repeat keyboard mechanism responds or to turn it off
entirely. With this feature turned on, you can set your
keyboard so that holding down a key for a longer than average
time will not result in a second entry of that character.

• SlowKeys

The SlowKeys feature makes the keys less likely to respond
when brushed accidentally. With this feature turned on, the
computer only accepts a key stroke that is held a certain length
of time. The computer ignores light keystrokes that are held
only for a moment.

• BounceKeys

The BounceKeys feature eliminates the problem of pressing a
key and then accidentally pressing it again before moving to
another key. You can set this feature to tell the computer not
to process a second pressing of a key unless a certain amount
of time elapses between each pressing.

• TimeOut

The TimeOut feature shuts off the AccessX features on a
workstation after a specified period of time. With the TimeOut
feature turned on, if you are sharing a workstation and have set
some AccessX features, the settings will automatically be
turned off before the next person uses the machine. If you want
to retain the AccessX settings all the time, you can turn off the
TimeOut feature.

There are two ways to enable AccessX on your workstation:

• At the user prompt, enter the accessx command and press
the Enable AccessX button in the dialog box that appears.

• Use the +accessx flag with the Xdec command to enable
AccessX whenever your system starts up.
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You can select the AccessX features from the AccessX dialog box
that appears when you choose AccessX from the Applications
menu of the DXsession Session Manager or enter the accessx
command. You use the Adjust Settings dialog box to customize
some of the AccessX features. The Adjust Settings dialog box has
a Test Area where you can try out settings before applying them to
your session.

The next section explains how to bring up the AccessX dialog box
and use it to select the AccessX features. The following sections in
the chapter explain each feature in detail and provide instructions
on how to turn the feature on and off, use it, and customize it. The
next to last section explains how to use the Adjust Settings dialog
box and the Test Area. The final section discusses the items in the
AccessX menu bar.

If you are using a workstation for the first time, be sure to read the
earlier chapters in this manual for information about how to use
menus, dialog boxes, and other components of the windowing
interface.

10.1.1 Selecting AccessX Features
To use the AccessX features, you can enter accessx at the
keyboard or select AccessX from the Applications menu in the
Session Manager menu bar. Then, you enable AccessX and the
feature or features you want.

Note that there are ways to turn on many of the AccessX features
directly from the keyboard. You can use these methods at any
time, without having to type accessx or select AccessX from
the Applications menu. These methods are explained in the
sections that describe the individual AccessX features.

When you enter the accessx command or select AccessX from
the Applications menu, the AccessX dialog box appears on your
workstation screen. Figure 10-1 shows the AccessX dialog box.
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Figure 10-1:   AccessX Dialog Box
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The AccessX dialog box has three areas:

• Menu bar

• Selections for the AccessX utility as a whole

• Area for enabling individual features
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The following sections discuss each area.

Note

As you might expect, you can use the mouse to move
the pointer anywhere in the AccessX and the Adjust
Settings dialog boxes. Once you are in the box, you
can also use the Tab key to jump from one area to
another within the box. In the Adjust Settings dialog
box, you can use the arrow keys to manipulate the
sliders to change various settings.

10.1.1.1 Selections for the AccessX Utility

The AccessX dialog box has push buttons for the utility as a
whole. The following list describes the buttons.

• Enable AccessX

Click on the Enable AccessX button to turn on the AccessX
utility. The button shown in the dialog box will appear to be
pushed in. Now, all the individual AccessX features are
available for you to enable (that is, turn on). To turn off the
AccessX utility, click on the Enable AccessX button so that it
appears pushed out in the dialog box.

Note that when the Enable AccessX button is pushed out
(turned off), you cannot manipulate any of the other buttons in
the dialog box. However, you can still select items in the
menu bar.

• Beep on feature use

When you turn the individual AccessX features on or off, the
workstation can provide an audible signal; a low-pitched beep
followed by a high-pitched beep for ON and a high-pitched
beep followed by a low-pitched beep for OFF). You can decide
whether you like these audible signals or whether you want to
suppress them. Click on the ‘‘Beep on feature use’’ button if
you want the workstation to provide the audible signals. The
button in the dialog box will appear to be pushed in. If you do
not want the workstation to produce these signals, click on the
button in the dialog box so that it appears to be pushed out.

You might find that when you first start using AccessX
features, you want the audible signals. Later on, you might
prefer to use AccessX without the beeps. To eliminate them,
click on the ‘‘Beep on feature use’’ button so that it appears
pushed out.
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• Show StickyKeys and MouseKeys status

The status bar displays the status of the keyboard modifiers
and the pointer buttons. A section of the status bar shows you
what modifiers are locked. If StickyKeys are turned on, when
the control key is pressed the first time, it latches the control
key and the status box displays this as Modifiers: Control.
Figure 10-2 shows a sample Status message box.

Figure 10-2:   Show StickyKeys and MouseKeys
StatusMessage Box
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• TimeOut

With the TimeOut feature turned on, the workstation
automatically turns off AccessX when the machine is not used
for a certain length of time. To use this feature, click on the
TimeOut button.

Notice the slider field to the right of the TimeOut button. You
use this field to set the length of time in minutes that you want
the workstation to wait before it automatically turns off
AccessX. To operate the slider, make sure that the TimeOut
button is pushed in. Then, use the mouse to place the cursor on
the slider block inside the field. Press MB1 (mouse button 1)
to move the slider to the right or left until the number over the
block shows the number of minutes you want to set for the
TimeOut feature. You can also press the left and right arrow
keys to move the slider.

The length of time it takes before the TimeOut feature turns
off AccessX ranges from 1 to 10 minutes. The shorter slider
time values are toward the left; the longer ones are toward the
right.
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Note

Sliders can be difficult to manipulate with the mouse.
If you enabled the MouseKeys feature, the movement
of the slider will be easier to control. You can also
use the left and right arrow keys to move the slider by
a single increment. Using the arrow keys offers the
best control for moving the slider.

10.1.1.2 Keyboard Control and Keyboard Response Boxes

The bottom portion of the AccessX dialog box contains two boxes
with three buttons each. The Keyboard Control box has buttons for
the following AccessX features:

• StickyKeys

• MouseKeys

• ToggleKeys

You use these features to control your working environment.

The Keyboard Response box has buttons for the following
AccessX features:

• RepeatKeys

• SlowKeys

• BounceKeys

You use these features to customize how keys respond when you
press them.

To turn any of these six keyboard features on, use the mouse to
move the cursor to the appropriate button and click on it. The
workstation displays the button as pushed in to indicate that the
feature is turned on. To turn off a feature, click on the button so
that the workstation displays it as being pushed out.

Remember that you can turn some of the features on or off directly
from the keyboard without having to display the AccessX dialog
box. The methods for turning on features directly from the
keyboard are explained later in this chapter under the sections for
those features that have the keyboard capability.
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10.1.1.3 Menu Bar

The following is a list of items in the AccessX menu bar:

• File

• Adjust

• Help

Each menu item contains a submenu. To access the submenu, click
on the menu item and then hold down MB1 to display the
submenu, or press the Alt key and enter the mnemonic, that is, the
underlined letter in the menu. (For example, to access the Adjust
menu, press Alt and then enter the letter A.)

The following sections discuss each of the submenus.

10.1.1.3.1 File Submenu – The File menu has three items:

• Load Settings

• Save Settings

• Exit

Select Exit to dismiss the AccessX dialog box and exit from the
utility.

The other two menu items deal with saving settings you changed
in one or more of the Adjust dialog boxes: Adjust Settings,
StickyKeys Adjust, MouseKeys Adjust, or Keyboard Response
Adjust. After you finish modifying any settings and pressing the
OK button, you need to select the File submenu and then the Save
Settings item to preserve your changes.

When you select Save Settings, the settings are recorded in an X
Window System resource file. Resource files are used to set the
characteristics of your workstation environment, including the
number and locations of windows that appear on the desk top
when you log in, background and foreground colors, and any
AccessX settings.

If you use Save Settings to store your settings in a resource file,
those customizations remain in effect each time you log in to your
workstation and enable the AccessX utility. Whenever you make
changes to your AccessX settings, select Save Settings to store the
new settings for the rest of your work session as well as future
work sessions.

When you select Save Settings, the utility displays the Save
Information message box to indicate whether the save is successful
or not. If the save is successful, the message Saved User Profile
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Successfully appears in the box. If AccessX has a problem saving
the settings you specified, it provides an appropriate error message
in this box. Figure 10-3 shows a sample Save Information
message box.

Figure 10-3:   Save Information Message Box
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If you start making changes to your AccessX settings and then
decide you want to restore the settings that were in place at the
start of your work session, select Load Settings from the File
menu. This menu item reloads the settings that are in the resource
file as a result of the last Save Settings action you performed.
Figure 10-4 shows a sample Load Information message box.

Figure 10-4:   Load Information Message Box
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10.1.1.3.2 Adjust Submenu – The Adjust submenu allows you to access the
complete Adjust Settings dialog box or a specific portion of that
box. The Adjust submenu has four items:

• All...

• StickyKeys...

• MouseKeys...

• Keyboard Response...

When you select All..., the complete Adjust Settings dialog box
appears. This box includes areas for customizing StickyKeys,
MouseKeys, RepeatKeys, SlowKeys, and BounceKeys. There is a
Test Area near the bottom of the dialog box that you can use to try
out your settings. The action buttons are at the bottom of the box:
OK, Reset, Defaults, Cancel, and Help. You use the OK button
when you are satisfied with your customizations and want to load
or save your settings. If you want to restore the settings that were
in effect before you did any customization, press Reset. Use
Defaults to restore the default system settings. Use Cancel to exit
from the dialog box without making any changes. Press the Help
button for details about the various elements of the dialog box.

When you select the StickyKeys... submenu item, AccessX
displays the StickyKeys portion of the Adjust Settings dialog box,
along with a Test Area and the four action buttons. You should
select this menu item if you want to customize only the
StickyKeys feature.

Similarly, select the MouseKeys... submenu item if you want to
customize only that feature. The resulting dialog box includes the
MouseKeys portion of the Adjust Settings dialog box and the four
action buttons. Note that there is no Test Area in the MouseKeys
dialog box. To test your MouseKeys settings, move the cursor by
pressing one of the direction keys on the keypad.

If you select Keyboard Response..., you see the RepeatKeys,
SlowKeys, and BounceKeys areas of the Adjust Settings dialog
box. Again, there is a Test Area where you can try out your
settings. The action buttons are at the bottom of this display.

Section 10.1.2 contains complete details on using the Adjust
Settings dialog box to customize your AccessX environment. This
information applies to the StickyKeys, MouseKeys, and Keyboard
Response dialog boxes as well.
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10.1.1.3.3 Status Submenu – The Status submenu shows the current status of
the following AccessX features:

• StickyKeys...

• MouseKeys...

When you select one of these items, a corresponding status box is
displayed in the upper left corner of your workstation screen. You
can leave the status box displayed while you work if you want.
When you are finished with the box, press the close button at the
bottom to dismiss the box.

When you select StickyKeys..., the utility displays the StickyKeys
status box. There are two columns in this box: Latched and
Locked. When you have turned on the StickyKeys feature and
used it to latch or lock some keys, this status box shows which
keys you have set. Figure 10-5 shows the StickyKeys status box.

The StickyKeys status box reports on seven modifier keys. The
following table contains the names of the modifiers keys and their
corresponding keyboard keys. Note that Digital UNIX does not
assign functions to all modifier keys.
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Modifier
Key Name Corresponding Keyboard Key2222222222222222222222222222222222222222222222222222222222222
Shift Shift Key

Control Ctrl Key

Mod 1 Usually Alt Key

Mod 2 Usually unassigned

Mod 3 Usually unassigned

Mod 4 Often Num Lock

Mod 5 Usually unassigned2222222222222222222222222222222222222222222222222222222222222

Figure 10-5:   StickyKeys Status Box
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The MouseKeys status box shows the current mouse button key as
well as which mouse button keys are pressed or released. If you
are using the MouseKeys feature, whenever you select a mouse
button from the numeric keypad, that button is displayed as the
Current Button. It remains the Current Button until you select a
different mouse button. When you click on a mouse button or
press 5 on the numeric keypad with MouseKeys in effect, the
MouseKeys status box lets you know which button is being
pressed and when it is released. Figure 10-6 shows the
MouseKeys status box.
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Figure 10-6:   MouseKeys Status Box
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These status boxes are helpful in keeping track of which modifier
key or mouse button is in effect, especially if you are interrupted
in the midst of a multikey operation. You can keep one or both of
these status boxes visible at the side on your desk top while you
are using AccessX so that you can check the StickyKeys or
MouseKeys status at any time.

10.1.1.3.4 Help Submenu – You use the Help submenu to get information
about the AccessX features on line while you are using the utility.
The Help topics cover much of the same information that is
available in this chapter. There are seven help topics:

• General...

• StickyKeys...

• MouseKeys...

• ToggleKeys...

• RepeatKeys...

• SlowKeys...

• BounceKeys...

To read the online descriptions, select Help from the AccessX
menu bar and then select the topic you want from the Help
submenu. The utility displays an AccessX Help window with the
information. Use the scroll bar on the right side of the window to
move through the descriptions. When you are finished reading,
press the Close button at the bottom of the window.

Access to DECwindows for People with Disabilities 10–13



10.1.2 Adjust Settings Dialog Box
Figure 10-7 shows the Adjust Settings dialog box. There are six
areas: one for the five keyboard features that you can customize
and the Test Area. You can use the Test Area to try out the
different customizations to be sure you are comfortable with the
new settings.

Figure 10-7:   Adjust Settings Dialog Box
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Notice that most of the selections include a slider at the right. Use
MB1 (mouse button 1) or the arrow keys to operate the sliders.
The scales and values of each slider differ. See the sections on the
individual AccessX features for details about each setting.

At the bottom of the box are five buttons: OK, Reset, Defaults,
Cancel, and Help. Click on the OK button to indicate that you
have completed selecting the customizations you want and are
ready for AccessX to implement your choices. Use the Reset
button to restore the settings to the way they were before you
started to make changes. Use the Defaults button to restore the
default system settings. Click on the Cancel button if you want to
undo your changes. Click on the Help button to get information
about the various boxes within the dialog box.
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Near the bottom of the Adjust Settings dialog box is a box labeled
Test Area. Use this area to test the settings you have made for the
following AccessX features:

• StickyKeys

• RepeatKeys

• SlowKeys

• BounceKeys

ToggleKeys has no customization, so you do not need to use the
Test Area for that feature. To test the MouseKeys feature, move
the cursor by pressing one of the direction keys on the keypad.

The StickyKeys Adjust and the Keyboard Response Adjust dialog
boxes each have Test Areas. You use these Test Areas exactly as
you do the one in the Adjust Settings dialog box.

To use the Test Area, do the following:

1. Turn on the feature you want to test, either through the
AccessX dialog box or by using the keyboard method.

2. Make whatever adjustments you want for that feature in its
area in the Adjust Settings dialog box.

3. Move the cursor to the Test Area and click MB1.

4. Enter some characters on the line in the test field to test your
settings for that feature.

5. If you want to adjust a setting, move the cursor to the
appropriate location in the Adjust Settings dialog box and then
change that setting.

6. Again, move the cursor to the Test Area and click MB1 to test
the new setting.

7. Enter more characters on the line to test the new setting.

When you move the cursor out of the Test Area box, you
automatically shut off that box. Once you are satisfied with your
settings, you can close the Adjust Settings dialog box and continue
with your work.

10.1.3 StickyKeys
Certain computer operations require pressing a key and holding it
down while pressing a second key. For example, to enter the
dollar sign ($), you need to press the Shift key and hold it down
while pressing the 4 key on the main keyboard. With the
StickyKeys feature turned on, you no longer have to hold the first
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key down while pressing the second one when you enter such
things as uppercase letters or control characters. After you press
the first key of a two-key sequence, you can release it; it stays in
effect until you finish pressing the second key.

The StickyKeys feature works for the Shift, Control, Compose
Character, and Alt Function keys. These keys are known as
modifier keys. You use these modifier keys to enter uppercase
letters, control characters, 8-bit characters (for example, letters
with accent marks), and keyboard accelerators. The StickyKeys
feature enables you to press a modifier key and then the key it is
to modify with one hand, one finger, or a mouth stick.

The following sections describe how to turn the StickyKeys
feature on and off, use it to enter data, and customize its settings.

10.1.3.1 Turning StickyKeys On and Off

You can turn on the StickyKeys feature at any time while you are
using your workstation. Use either the AccessX dialog box or your
keyboard to turn StickyKeys on or off.

To turn on the StickyKeys feature from the keyboard, press one of
the Shift keys on your keyboard five times in succession. Avoid
pressing any other keys or moving the mouse until you have
finished pressing Shift for the fifth time.

When you turn on StickyKeys, the computer signals with one
short, low-pitched beep followed by a short, high-pitched beep.
(You can reset AccessX to suppress this audible signal by turning
off the ‘‘Beep on feature use’’ button in the AccessX dialog box.)

You turn off StickyKeys the same way you turn it on: by pressing
one of the Shift keys five times in succession. When you turn off
the feature, the computer signals with a high-pitched beep
followed by a low-pitched beep, unless you have customized your
AccessX environment to turn off audible signals.

10.1.3.2 Using StickyKeys

The StickyKeys feature works in two ways:

• Latching

• Locking

When you latch a modifier key, only the next key you type is
affected. You might use latching for entering control key
sequences, accessing punctuation characters that require the Shift
key (such as the dollar sign or parentheses), entering letters with
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accents, or typing the first letter of a person’s name.

Follow these steps to latch a modifier key:

1. Turn on the StickyKeys feature if it is not already set.

2. Press the modifier key (Shift, Ctrl, Compose Character, or Alt
Function).

3. Press the key you want to be affected by the modifier key.

4. Continue typing.

Note that there is no change to the way the Shift Lock key works
when you have StickyKeys turned on.

Locking a modifier key is similar to using the Shift Lock key.
With locking in effect, the modifier key remains in effect until you
unlock it. In general, you will use the locking feature to enter a
group of all uppercase letters or shifted punctuation characters
such as the underscore to make a solid line.

Follow these steps to lock and unlock a modifier key:

1. Turn on the StickyKeys feature if it is not already set.

2. Press the modifier key twice in succession. After you press the
key once, the system produces a single beep. When you press
the modifier key a second time, the system produces a short,
low-pitched beep followed by a high-pitched beep.

3. Enter all the characters you want to be affected by the modifier
key.

4. Press the modifier key once to unlock it. The system produces
a high-pitched beep followed by a low-pitched beep to signal
that the key is unlocked.

Using locked StickyKeys with the Shift key is not the same as
pressing the Shift Lock (Caps) key on the keyboard. With locked
StickyKeys, you enter all the alternate punctuation marks that are
paired with the digit keys and other punctuation characters on the
main keyboard. For example, with locked StickyKeys, you would
input a percent sign when you pressed the 5 key on the main
keyboard. With the Shift Lock key in effect, pressing that 5 key
would input the digit 5.

Occasionally, you might need to latch more than one modifier key,
for example, to enter an uppercase letter with an accent mark or to
produce a control key sequence such as Ctrl/^. If you have
StickyKeys turned on, all you need to do is press each key in
succession. The first modifier key will stay latched while you press
the second one and then the non-modifier key. As soon as you
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have pressed the non-modifier key, both modifier keys are
released.

During your work session, you can use the Status submenu on the
AccessX menu bar to determine which StickyKeys have been
locked or latched. See Section 10.1.1.3.3 for details.

10.1.3.3 Customizing StickyKeys

To customize your StickyKeys environment, select the All... or
StickyKeys... item from the Adjust menu. The StickyKeys feature
has the following option buttons:

• Auto off

You can set the StickyKeys feature to turn off automatically
whenever a person uses a modifier key by holding it down
while pressing another key. To set the turnoff to be automatic
in this way, click on this button to push it in. Automatic
turnoff can be useful if several people are using the same
workstation and some of them might not be accustomed to
using the StickyKeys feature.

• Modifiers beep

You can decide whether you want the workstation to produce
beeps whenever you lock, latch, or release a modifier key.
Click on the Modifiers beep button to have the workstation
give an audible signal. Note that you can turn this signal on or
off regardless of whether you have selected the ‘‘Beep on
feature use’’ item in the AccessX dialog box.

10.1.4 MouseKeys
With the MouseKeys feature, you can press keys on the numerical
keypad instead of manipulating the mouse to move the cursor and
perform window operations such as selecting menus, interacting
with dialog boxes, and cutting and pasting text.

The following sections describe how to turn the MouseKeys
feature on and off, use it to perform window operations, and
customize the settings.

10.1.4.1 Turning MouseKeys On and Off

You can turn on the MouseKeys feature at any time while you are
using your workstation. Use either the AccessX dialog box or your
keyboard to turn MouseKeys on or off.

10–18 Access to DECwindows for People with Disabilities



To turn on the MouseKeys feature from your keyboard, you need
to enter a sequence of three keys: the left Shift key, the key
directly to the left of the space bar, and the key in the upper left
corner of the numeric keypad. (The key to the left of the space bar
might be labeled Compose Character or Alt Function. The key in
the upper left corner of the numeric keypad might be labeled PF1
or Num-Lock.) To enter this key sequence, you must hold down
the left Shift key, press and hold down the key to the left of the
space bar, and then press the key in the upper left corner of the
numeric keypad. You can use the StickyKeys or Slow Keys
feature to help you enter this multikey sequence.

When you turn on MouseKeys, the computer signals with a low-
pitched beep followed by a high-pitched beep. (You can reset
AccessX to suppress this audible signal by turning off the ‘‘Beep
on feature use’’ button in the AccessX dialog box.)

To turn off MouseKeys, press the same combination you used to
turn on the feature: the left Shift key, then the key to the left of
the space bar, and finally the upper left key on the numeric
keypad. When you turn off this feature, the computer signals with
a high-pitched beep followed by a low-pitched beep, unless you
have customized your environment to turn off that sound.

10.1.4.2 Using MouseKeys

In the MouseKeys feature, the actions that can be performed with
a mouse have been mapped to the keys on the numeric keypad at
the right side of your workstation keyboard. You can perform the
following operations:

• Move the cursor.

• Select the appropriate mouse button.

• Click on the selected mouse button.

• Double click on the selected mouse button.

• Lock onto and drag an object.

Figure 10-8 shows the numeric keypad with the mouse key
operations marked for LK401-style keyboards. Figure 10-9 shows
the numeric keypad with the mouse key operations marked for the
PC-style keyboards.
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Figure 10-8:   MouseKeys Operations
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Figure 10-9:   MouseKeys Operations - PC-style
Keyboard
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To move the cursor on the screen, press the keys that have
directional arrows in Figure 10-8 or Figure 10-9. Keys 2, 4, 6,
and 8 move the cursor in a straight line, either down, to the left, to
the right, or up. Keys 1, 3, 7, and 9 move the cursor in a diagonal
line, either to the lower left, lower right, upper left, or upper right.
Use the keys in combination to locate the cursor in the exact
position you need.

You can hold down a key to continue moving the cursor in the
direction you want. When you first press one of these keys, the
cursor moves slowly, but as you continue to hold down the key,
the movement speeds up. You can adjust this maximum speed to
be either faster or slower than the default setting. See Section
10.1.4.4 for details.

To select a mouse button (MB1, MB2, or MB3), press the
appropriate key on the top row of the numeric keypad. Note that
the MouseKeys feature considers MB1 to be the default. If you are
using MB1 to click or double click on an object, all you have to
do is press the appropriate click key; you can eliminate first
pressing the PF2 key or the slash (/) key on the PC-style numeric
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keypad.

To perform a single click with MouseKeys, press the 5 key on the
numeric keypad. Pressing this key performs operations such as
selecting the window that you want to work in, selecting a menu
item, pressing a push button in a dialog box, or dismissing a
window. If you press the 5 key without having selected a mouse
button, MouseKeys assumes that you want MB1.

There are two ways to perform a double click operation. You can
press the 5 key twice in succession, or you can press the comma
(,) key or plus sign (+) key on PC-style keyboards. Double
clicking is used to start certain operations in some applications.

Locking a mouse button enables you to move to an item you want
to select from a pull-down menu or to select text from one
location to paste in another. You use the locking feature so that
you can move the cursor in a drag operation. Use the 0 key on the
numeric keypad to lock a mouse button. Press the period (.) key
on the numeric keypad to release a mouse button. If you have not
selected a mouse button before pressing the 0 key, MouseKeys
assumes that you want to lock MB1.

A common lock and drag operation that you can do with
MouseKeys is to cut and paste text. You need to cut and paste text
when you want to copy something from one place in a window to
another, for example, to repeat a command that you entered
previously in that session. You can use cut and paste to copy or
move text or command lines from one window to another. You
can also use this technique to delete text from one part of your file
in an editing session and move it to another file.

The following list shows the steps required to copy a command
line from one window to another:

1. Use the keys on the numeric keypad to move the cursor to the
start of the command line that you want to copy.

2. Press the 0 key on the numeric keypad to lock MB1.

3. Press the 6 key to select the entire command line. (The
selected text will appear in reverse video in your screen.)

4. Press the period key on the numeric keypad to release the drag
operation for MB1.

5. Move the cursor to the command prompt in the window where
you want to copy the command line.

6. Select MB1 (the PF2 or / key on the numeric keypad) and
click (5 on the numeric keypad) to change focus to the new
window.
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7. Select MB2 (the PF3 or * key on the numeric keypad) and
click (5 on the numeric keypad) to copy the command text to
the new location.

You can now press Return to issue the command in the new
window.

10.1.4.3 Using the Mouse and MouseKeys Together

There are times when you might want to use a combination of the
MouseKeys feature and the mouse itself. Even though you have
MouseKeys turned on, all the usual mouse capabilities are still
available through the mouse itself.

You might find it easier to use the mouse itself to move the
pointer long distances, but prefer to use MouseKeys to perform
operations that require dragging, such as selecting command lines
or text. Being able to use MouseKeys for double clicking can be
helpful for people with hand tremors.

10.1.4.4 Customizing MouseKeys

To customize your MouseKeys environment, select the All... or
MouseKeys... item from the Adjust menu. The MouseKeys feature
has the following option buttons:

• Max speed (pixels/sec)

The Max speed values refer to how fast the cursor is moving
once it has finished accelerating. The speed is measured in
pixels per second. (Screen displays on workstations, terminals,
and televisions are composed of hundreds or thousands of
pixels. Each pixel is a tiny dot that can either be lighted or not
depending on the image that is being displayed at a given
moment.) Use the slider at the right of the Max speed button
to select the speed that the cursor moves when you are using
MouseKeys.

The slider values range from 10 pixels/sec to 1000 pixels/sec.
Use MB1 or the arrow keys to move the slider from the lowest
value on the left to the higher values on the right. If you find
the cursor is moving too fast, you can reduce this value.

• Time to max (sec)

Use this setting to determine how long it takes for the cursor
to reach its maximum speed. The choices are from zero to four
seconds. Use MB1 or the arrow keys to move the slider from 0
seconds on the left towards 4 seconds on the right. You might
want to start with 2 seconds and later change the setting if you
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find the acceleration time is too long or too short.

• Motion delay (sec)

Use this setting to determine how long before the pointer
begins to accelerate.

10.1.5 ToggleKeys
The ToggleKeys feature causes the workstation to beep when a
light on the keyboard is turned on or off. Some keyboards or
workstation monitors have lights that indicate when this key has
been pressed. However, not all systems are equipped with such
indicator lights. In addition, some users might not be able to see
whether the lights are on or off. With the ToggleKeys feature set,
the workstation provides an audible signal each time the Shift
Lock key is pressed

With ToggleKeys turned on, when you press the Shift Lock key to
turn on its function, the workstation produces a low-pitched beep
followed by a high-pitched beep. When you press the Shift Lock
key to turn its function off, the workstation produces a high-
pitched beep followed by a low-pitched beep.

When the ToggleKeys feature is turned on, the workstation will
beep regardless of whether you have selected the ‘‘Beep on feature
use’’ item in the AccessX dialog box. That setting applies only to
the workstation signal that sounds when the feature itself is turned
on or off.

The ToggleKeys feature has no special settings, so there is no box
for it in the Adjust... dialog box.

You can turn on the ToggleKeys feature at any time while you are
using your workstation. You must use the AccessX dialog box to
turn ToggleKeys on or off.

10.1.6 RepeatKeys
The RepeatKeys feature lets you adjust how fast the auto-repeat
mechanism works for your keyboard. On most keyboards, when
you press a key and hold it down, the computer continues to input
the character until you release the key. If you find that keys are
repeating when you only intended to input one character, you can
adjust the auto-repeat mechanism so that it does not take effect
until the key is held down for a longer period of time.
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10.1.6.1 Turning RepeatKeys On and Off

You can turn on the RepeatKeys feature at any time while you are
using your workstation with the AccessX dialog box.

10.1.6.2 Customizing RepeatKeys

To customize your RepeatKeys environment, select the All... or
Keyboard Response... item from the Adjust menu. The
RepeatKeys feature has the following option buttons:

• Repeat rate (sec/key)

The repeat rate determines the speed at which a key will repeat
when you continue to hold it down after it has repeated once.
The higher the number you select, the slower the key will
repeat. Use the slider at the right of the Repeat rate button to
select the repeat speed you want.

The slider values range from 0.01 sec/key to 10 sec/key. The
slower values are toward the right; the faster values are toward
the left.

• Repeat delay (sec)

You use this setting to adjust the time you have to hold down
a key before it repeats. Use the slider at the right of the Repeat
delay button to select the amount of delay time you want.

The slider values range from one tenth (0.01) of a second to a
full four seconds (4). The faster (shorter) delay times are
toward the left; the slower (longer) delay times are toward the
right.

10.1.7 SlowKeys
The SlowKeys feature lets you adjust the length of time a key
must be held down before the computer accepts the signal as
input. If you find yourself accidentally brushing keys when
moving about the keyboard or pressing keys when your hands are
only resting on them, you might want to turn on the SlowKeys
feature. With SlowKeys in effect, lightly pressing or brushing a
key will not cause that character to be treated as input by the
computer. You must hold a key down continuously for a set
amount of time before the computer processes the input.
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10.1.7.1 Turning SlowKeys On and Off

You can turn on the SlowKeys feature at any time while you are
using your workstation. Use either the AccessX dialog box or your
keyboard to turn SlowKeys on or off.

To turn on the SlowKeys feature from your keyboard, press the
right Shift key and hold it down for about 8 seconds. After 4
seconds, you will hear three short beeps. This is a warning signal
in case you had not intended to press the Shift key. Ignore this
warning and hold the key down for approximately 4 more seconds
until the computer signals with a low-pitched beep followed by a
high-pitched beep. (You can reset AccessX to suppress these
audible signals by turning off the ‘‘Beep on feature use’’ button in
the AccessX dialog box.)

You turn off SlowKeys the same way that you turn it on, that is,
by pressing the right Shift key for 8 seconds. Again, after 4
seconds, you will hear three short beeps. Ignore this warning and
hold the key down for approximately 4 more seconds until the
computer signals with a high-pitched beep followed by a low-
pitched beep, unless you have customized your environment to
turn off that sound.

10.1.7.2 Customizing SlowKeys

To customize your SlowKeys environment, select the All... or
Keyboard Response... item from the Adjust menu. The SlowKeys
feature has the following option buttons:

• Beep when key is pressed; accepted

You can choose to have your workstation produce a beep when
you press a key, when that key is accepted, or both. To have
your workstation beep when a key is pressed, click on the push
button preceding the word ‘‘pressed’’. Click on the push
button preceding the word ‘‘accepted’’ to have the workstation
beep whenever it processes a keystroke. You can have both
buttons pushed in to have the workstation beep when you press
the key and again when that key has been accepted as input.
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• Key delay (sec)

Key delay determines how long you have to press a key before
the computer accepts that keystroke as input. Use the slider at
the right of the Key delay button to change the length of the
delay time.

The slider values range from a tenth of a second (0.1) to a four
second delay (4.0). The shorter delay times are toward the
left; the longer delay times are toward the right.

10.1.8 BounceKeys
The BounceKeys feature lets you adjust the length of time the
computer waits between the time you first press a key and when
you press it again before accepting the second keystroke as input.
With this feature in effect, the computer ignores a second pressing
of a key that can occur when your hand accidentally bounces off a
key that you have just pressed. To have the computer accept your
pressing a key for the second time, you need to let some time
elapse before you press the key again.

The BounceKeys time lapse only applies to pressing the same key
a second time. The setting has no effect on how fast the computer
processes input when you press one key and then a different key.

10.1.8.1 Turning BounceKeys On and Off

You can turn on the BounceKeys feature at any time while you are
using your workstation. You must use the AccessX dialog box to
turn on BounceKeys. You also use the AccessX dialog box to turn
off BounceKeys.

10.1.8.2 Customizing BounceKeys

To customize your BounceKeys environment, select the All... or
Keyboard Response... item from the Adjust menu. The
BounceKeys feature has the following option button:

• Debounce time (sec)

The Debounce time is the length of time you must wait before
pressing the same key a second time to have the computer
accept both keystrokes as input. Use the slider at the right of
the Debounce time button to change the delay time that you
must wait to press a key a second time.

Access to DECwindows for People with Disabilities 10–27



The slider values range from a tenth of a second (0.1) to four
seconds (4.0). The shorter times are toward the left; the longer
times are toward the right.

10.2 Optacon II
The Optacon II, a product of TeleSensory Corporation, is an
optical-to-tactile conversion device meant to assist the blind in
accessing visual information. The optacon utility was made
specifically to allow blind users to use an Optacon II to have more
access to an X Window System display. The optacon utility
does so by mapping the pixels surrounding the on-screen pointer
to the pins on the Optacon II. All black pixels will cause the
associated Optacon II pins to vibrate, and all other pixels will
cause the associated Optacon II pins to remain still.

To use the Optacon II utility, you can enter optacon at the
keyboard or select Optacon from the Applications menu in the
Session Manager menu bar. For further information, see the
optacon(1X) reference page.

10.3 Puff
Puff, developed at the Army High Performance Computing
Research Center, provides text and graphics magnification for
sight impaired users.

You can invoke the Puff utility by entering the puff command or
from the Applications menu in the session Manager if the menu
was customized to include Puff. Figure 10-10 shows a Puff
window magnifying the area around the pointer.
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Figure 10-10:   Puff Window

 

HelpFile Adjust

accessx

Enable AccessX Beep on feature use

Show StickyKeys and MouseKeys Status

puff

ZK−1120U−R

For further information, see the puff(1X) reference page.

10.4 Xsoundsentry
The xsoundsentry utility provides visual indications of bell
events that occur in the X server. These bell events result from
calls to XBell. (See XBell(3X11)). This utility is useful for
people with hearing disabilities and well as those who work in
noisy environments. For further information, see the
xsoundsentry(1X) reference page.

Access to DECwindows for People with Disabilities 10–29





AUsing DECwindows with a Keyboard3333333333333333333333
This appendix contains tables and procedures that describe how to
use a keyboard to work with menus, windows, and dialog boxes.
See Chapter 3 for general information about using DECwindows.

A.1 Traversing Menu Bars and Pull-Down Menus
Table A-1 describes how to traverse menu bars and pull-down
menus.

Table A-1:   Traversing the Menu Bar and Pull-Down
Menus

2222222222222222222222222222222222222222222222222222222222222222222222
To Key Sequence Example or Explanation2222222222222222222222222222222222222222222222222222222222222222222222

F10Move to first menu in
menu bar

Not applicable in some
applications. A DECterm, for
example, passes the F10
sequence to the host.

Alt+mnemonicPull down a menu from
the menu bar

Pulls down the menu from
the menu bar that is
associated with that
mnemonic.

↑ or ↓Move to next menu item
in a pull-down menu

Moves the location cursor up
or down; it cycles (wraps) at
the top and bottom.

← or →Move to another pull-
down menu in the menu
bar

Moves the location cursor
left or right; it cycles (wraps)
at each end.

Activate highlighted
menu item

Return, Ctrl+Return,
or Enter

Activates the highlighted
menu item.

Activate a menu item Mnemonic of the
menu item

Mnemonic is the underlined
letter in the menu item.

F11 (ESC)Move location cursor
from menu bar to where
it was before you started
using the menu bar

Works only with an explicit
focus policy. With an
implicit focus policy, the
location cursor moves from
the menu bar to wherever the
pointer is located.



Table A-1:   (continued)
2222222222222222222222222222222222222222222222222222222222222222222222
To Key Sequence Example or Explanation2222222222222222222222222222222222222222222222222222222222222222222222
Dismiss all menus F10 If you are using an explicit

focus policy, the cursor goes
to where it was before you
started using the menus.
With an implicit focus
policy, the focus moves to
wherever the pointer is
situated.2222222222222222222222222222222222222222222222222222222222222222222222

Table A-2 describes how to traverse submenus.

Table A-2:   Traversing Submenus
222222222222222222222222222222222222222222222222222222222222222222222222
To Press Example or Explanation222222222222222222222222222222222222222222222222222222222222222222222222
Display a submenu • Arrow key in the

direction the menu goes

• Ctrl+Arrow key

• Return

• Ctrl+Return

• Enter

Pressing any of the keys
listed makes the menu
appear.

Activate a menu item in a
submenu

Return, Ctrl+Return, or
Enter

↑ or ↓Move to another menu
item in a submenu

These keys move up and
down within the submenu;
they cycle at the top or
bottom.

←Move to the pull-down
menu item from which
the submenu came

Makes the submenu menu
disappear and highlights
the menu item from which
the submenu menu came.

Display a submenu or
activate an item in a
submenu

Mnemonic of the menu
item or the submenu item

Mnemonic is the
underlined letter in the
item.222222222222222222222222222222222222222222222222222222222222222222222222

Table A-3 describes how to move to a previous menu.
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Table A-3:   Moving to a Previous Menu
2222222222222222222222222222222222222222222222222222222222222222222222
To Press Example or

Explanation2222222222222222222222222222222222222222222222222222222222222222222222
See Figure A-1.Move the location cursor

from any submenu item
to the parent menu

• ←
• Ctrl+←
• Ctrl+↑

See Figure A-1.Move the location cursor
from a menu item to the
default menu item in the
menu just to the left of
the current cursor
location

• ←
• Ctrl+←
• Ctrl+↑

2222222222222222222222222222222222222222222222222222222222222222222222

Figure A-1:   Moving to a Previous Menu
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Table A-4 describes how to move to the next menu.

Using DECwindows with a Keyboard A–3



Table A-4:   Moving to the Next Menu
2222222222222222222222222222222222222222222222222222222222222222222222
To Press Example or

Explanation2222222222222222222222222222222222222222222222222222222222222222222222
See Figure A-2.Move the location cursor

from a menu item in a
pull-down menu to the
default menu item in the
associated submenu

• →
• Ctrl+→
• Ctrl+↓

See Figure A-2.Move the location cursor
from a menu item in a
pull-down menu to the
default menu item in the
pull-down menu just to
the right of the current
location cursor

• →
• Ctrl+→
• Ctrl+↓

2222222222222222222222222222222222222222222222222222222222222222222222

Figure A-2:   Moving to the Next Menu
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A.2 Traversing Windows
The following sections describe how to use your keyboard to
move between and within windows.

A.2.1 Moving Between Windows
To move between groups of windows:

• Press Alt+Tab or Alt+F11 to move from one group of
windows to another.

You can also use Alt+Tab or Alt+F11 to move from one
minimized window to another when the minimized windows
are not in an icon box. When a minimized window has input
focus, its window menu appears, and the first menu item
(Restore) is highlighted. (To move from one minimized
window to another in an icon box, use the arrow keys.)

• Press Alt+F6 or Alt+Shift+F6 to move to the next or previous
window within a group of windows..LI Press Alt+Shift+F11 or
Alt+Shift+Tab to move to the previous group of windows.

• Press F4 to pop up the window menu of a minimized window
when that window is in an icon box.

• Press the arrow keys to move between minimized windows
that are in an icon box.

• Press Alt+F5 or Return to restore a minimized icon box.

A.2.2 Moving Within Windows
To move within windows:

• Press F10 to focus on the menu bar.

• Press Shift+F11 (on some keyboards F11 is marked ESC) to
pull down the window menu.

• Press Tab to move from one tab group to another.

• Use the accelerators for menu items in the window menu.

The following table summarizes keyboard accelerators available
from the Window menu:
2222222222222222222222222222222222222222222222222222222222222
To Press2222222222222222222222222222222222222222222222222222222222222
Move a window Alt+F7

Size a window Alt+F8
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2222222222222222222222222222222222222222222222222222222222222
To Press2222222222222222222222222222222222222222222222222222222222222
Minimize a window Alt+F9

Restore a minimized window Alt+F5

Maximize a window Alt+F10

Lower a window to the bottom of the window
stack Alt+F3

Close (not minimize) a window Alt+F42222222222222222222222222222222222222222222222222222222222222

To move a window around the screen:

1. Press Alt+F7 or:

• Press Shift+F11 to pull down the window menu.

• Press ↓ until the Move menu item is highlighted.

• Press Return or Ctrl+Return to activate the menu item.

2. Press the arrow keys to move the window in the direction that
you want it to go. You can also press Ctrl+arrow keys to move
the window several pixels at a time.

3. Press Return or Ctrl+Return to finish the operation.

To size a window:

1. Press Alt+F8 or:

• Press Alt+space bar or Shift+F11 to pull down the window
menu.

• Press ↓ until the Size menu item is highlighted.

• Press Return or Ctrl+Return to activate the menu item.

2. Press one arrow key to indicate which side of the window to
size. For example, press ↑ for the top of the window, ← for
the left side, and so on. You can also press two arrow keys,
one after the other, to indicate which corner to size. For
example, press ↑ and then ← to indicate the upper left corner,
and so on.

3. Once you have indicated which side or corner of the window
size, press the arrow keys to size the window in the direction
that you want the window to be sized. You can also press
Ctrl+arrow keys to size the window several pixels at a time.

4. Press Return or Ctrl+Return to finish the operation.
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A.3 Traversing Dialog Boxes
Table A-5 describes how to work with dialog boxes.

Table A-5:   Working with Dialog Boxes
2222222222222222222222222222222222222222222222222222222222222222
To Press2222222222222222222222222222222222222222222222222222222222222222

Tab or Ctrl+TabMove forward from tab group to tab group
(field to field)

Move backward from tab group to tab group Shift+Tab or Ctrl+Shift+Tab

Arrow keysMove from item to item within a tab group
(field)

Activate a selection in a group of radio
boxes, check boxes, or list boxes, or to pop
up an options menu

Select, space bar, or
Ctrl+space bar

Activate an item in a group of push buttons Select, space bar, Ctrl+space
bar, Return

Ctrl+Return or EnterActivate an item in a group of push buttons

Return, Ctrl+Return, or EnterActivate an item in an options menu or the
default action of the dialog box

Cancel a dialog box or an options menu F11 (ESC)2222222222222222222222222222222222222222222222222222222222222222

Table A-6 describes how to move within dialog boxes.

Table A-6:   Moving Within Dialog Boxes
2222222222222222222222222222222222222222222222222222222222222222
To Press Example or Explanation2222222222222222222222222222222222222222222222222222222222222222

Arrow keysMove cursor from
button to button

Sets of check buttons, push
buttons, or radio buttons are
considered one tab group (a
single button is not a tab
group). Use the arrow keys to
move the location cursor from
one item to another.
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Table A-6:   (continued)
2222222222222222222222222222222222222222222222222222222222222222
To Press Example or Explanation2222222222222222222222222222222222222222222222222222222222222222

For example, if the buttons are
arranged vertically, you can
press ↑ or ← to go up, and you
can press ↓ or → to move
down. If the buttons are
arranged horizontally, press ←
or ↑ to move left, and press →
or ↓ to move right.

In some cases, buttons are not
arranged in a primarily vertical
or horizontal manner. Rather,
they might be arranged in a box
format, as the following
numbers show:

1 2
3 4

Pressing the arrows keys moves
through the buttons in the
following manner (starting at
1):

• → moves: 2, 3, 4, 1, 2, 3, 4,
1, . . .

• ↓ moves: 3, 2, 4, 1, 3, 2, 4, 1,
. . .

• ← moves: 4, 3, 2, 1, 4, 3, 2,
1, . . .

• ↑ moves: 4, 2, 3, 1, 4, 2, 3, 1,
. . .

Space barInsert one space in a
text-entry box

Pressing Ctrl+space bar does
nothing.

↑ or ↓Move to another
options menu item
or another list box
item

← or →Move left or right
one character

Use these arrow keys in list
boxes to display more text, for
example, to display the end of a
long file name.

Prev ScreenMove up one screen
(page)
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Table A-6:   (continued)
2222222222222222222222222222222222222222222222222222222222222222
To Press Example or Explanation2222222222222222222222222222222222222222222222222222222222222222

Next ScreenMove down one
screen (page)

Move left one screen Ctrl+Prev Screen

Ctrl+Next ScreenMove right one
screen

Ctrl+Alt+←Go to the top of the
list or file

Ctrl+Alt+→Go to the bottom of
the list or file

Alt+←Display leftmost
character (go to the
beginning of a line)

Alt+→Display rightmost
character (go to the
end of a line)

Cancel F11 (ESC) Pressing F11 (ESC) cancels any
action in the entire dialog box
and makes the dialog box
disappear.2222222222222222222222222222222222222222222222222222222222222222

Table A-7 describes how to activate items in a tab group.

Table A-7:   Activating Items in a Tab Group
2222222222222222222222222222222222222222222222222222222222222222
To Press Example or Explanation2222222222222222222222222222222222222222222222222222222222222222
Activate check or
radio buttons

Select, space bar,
or Ctrl+space bar

Radio buttons can be either
toggled or set.

Activate an
options menu

Select, space bar,
or Ctrl+space bar

You do not need to keep the key
pressed to keep the menu visible.
Press the key once and the menu
remains.

Activate an
options menu
item

Return,
Ctrl+Return, or
Enter

Once you have chosen a menu
item, the options menu disappears.
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Table A-7:   (continued)
2222222222222222222222222222222222222222222222222222222222222222
To Press Example or Explanation2222222222222222222222222222222222222222222222222222222222222222
Activate push
buttons

Select, space bar,
Ctrl+space bar,
Return,
Ctrl+Return, or
Enter

Return or Ctrl+Return activate the
default push button. If you have
more than one tab group of push
buttons, Return and Ctrl+Return
activate only the default buttons,
and do not activate any buttons in
the other tab group.2222222222222222222222222222222222222222222222222222222222222222
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BComposing Characters3333333333333333333333
Depending on the keyboard type, you compose characters in either
of the following ways:

• Use three-stroke sequences on a LK401 keyboard, including
the North American/United Kingdom, Dutch, and
Norwegian/Danish keyboards.

• Use two-stroke sequences on other keyboards.

To compose a character:

1. Find the character you want to create in column 1 of the three
tables that follow.

2. To compose a three-stroke sequence, press the Compose
Character key and type the two characters in column 2.

3. To compose a two-stroke sequence, type the two characters in
column 3. The desired character is displayed.

4. Press the Compose Character key, the 331
33

(delete) key, the Tab
key, Return key, or the Enter key to cancel a compose
sequence.

Note

The North American, United Kingdom, and Dutch
keyboards do not have diacritical marks. If you use a
diacritical mark, DECterm uses an equivalent
character.

Table B-1 lists the characters you can compose in Multinational
Character Mode.



Table B-1:   Multinational Character Mode Compose
Characters

2222222222222222222222222222222222222222222222222222222222222222
Character Three-

Stroke
Sequence

Two-Stroke
Sequence

2222222222222222222222222222222222222222222222222222222222222222
" double quotation mark " space bar " space bar

# number sign ++

’ apostrophe ’ space bar ’ space bar

@ commercial at sign A A

[ opening bracket ( (

\ backslash / / or / <

] closing bracket ) )

^ circumflex accent ^ space bar ^ space bar

` grave accent ‘ space bar ‘ space bar

{ opening brace ( -

| vertical line / ^

} closing brace ) -

~ tilde ~ space bar ~ space bar

¡ inverted ! !!

¢ cent sign C/ or C|

£ pound sign L- or L=

¥ yen sign Y- or Y=

§ section sign SO or S! or S0

¤ currency sign XO or X0

 copyright sign CO or C0

ª feminine ordinal A_

« open angle brackets < <

˚ degree sign 0 ^

± plus-or-minus sign + - -
2 superscript 2 2 ^
3 superscript 3 3 ^

µ micro sign / U

¶ paragraph sign P!

· middle dot . ^
1 superscript 1 1 ^

º masculine ordinal O_

» closed angle brackets >>
1/4 fraction one-quarter 1 4
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Table B-1:   (continued)
2222222222222222222222222222222222222222222222222222222222222222

Character Three-
Stroke
Sequence

Two-Stroke
Sequence

2222222222222222222222222222222222222222222222222222222222222222
1/2 fraction one-half 1 2

¿ inverted ? ??

À A grave A ‘ ‘ A

Á A acute A ´ ´A

Â A circumflex A^ ^A

Ã A tilde A~ ~A

Ä A umlaut A" or "A "A

Å A ring ˚AA* or A˚
(degree sign)

Æ A E diphthong AE

Ç C cedilla C,

È E grave E ‘ ‘ E

É E acute E ´ ´ E

Ê E circumflex E^ ^E

Ë E umlaut E" or "E "E

Ì I grave I ‘ ‘ I

Í I acute I ´ ´ I

Î I circumflex I^ ^I

Ï I umlaut I" or "I "I

Ñ N tilde N ~ ~ N

Ò O grave O ‘ ‘ O

Ó O acute O ´ ´ O

Ô O circumflex O^ ^O

Õ O tilde O~ ~O

Ö O umlaut O" or "O "O

OE O E diphthong O E

Ø O slash O /

Ù U grave U ‘ ‘ U

Ú U acute U ´ ´ U

Û U circumflex U^ ^U

Ü U umlaut U" or "U "U

Ÿ Y umlaut Y" or "Y "Y

ß German small sharp s ss

à a grave a ‘ ‘ a

á a acute a ´ ´ a
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Table B-1:   (continued)
2222222222222222222222222222222222222222222222222222222222222222

Character Three-
Stroke
Sequence

Two-Stroke
Sequence

2222222222222222222222222222222222222222222222222222222222222222
â a circumflex a^ ^a

ã a tilde a ~ ~ a

ä a umlaut a" or "a "a

å a ring ˚aa* or a˚
(degree sign)

æ a e diphthong a e

ç c cedilla c , (comma)

è e grave e ‘ ‘ e

é e acute e ´ ´ e

ê e circumflex e^ ^e

ë e umlaut e" or "e "e

ì i grave i ‘ ‘ i

í i acute i ´ ´ i

ı̂ i circumflex i^ ^i

ı̈ i umlaut i" or "i "i

ñ n tilde n ~ ~n

ò o grave o ‘ ‘ o

ó o acute o ´ ´ o

ô o circumflex o^ ^o

õ o tilde o ~ ~ o

ö o umlaut o" or "o "o

oe o e diphthong o e

o/ o slash o/

ù u grave u ‘ ‘ u

ú u acute u ´ ´ u

û u circumflex u^ ^u

ü u umlaut u" or "u "u

ÿ y umlaut y" or "y "y

ISO Latin 1 Characters

no break space sp sp

|| broken vertical bar || or ! ^

¬ logical not - ,

- soft (syllable) hyphen - -

 registered trademark R O

¯ macron - ^
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Table B-1:   (continued)
2222222222222222222222222222222222222222222222222222222222222222

Character Three-
Stroke
Sequence

Two-Stroke
Sequence

2222222222222222222222222222222222222222222222222222222222222222
3/4 three quarters 3 4

÷ division sign - :

´ acute accent ´ ´

¸ cedilla , ,

¨ dieresis " " " space bar

Ý Y acute Y ’ ´ Y

ý y acute y ’ ´ y

Io capital Icelandic thorn T H

Io small Icelandic thorn t h

D- capital Icelandic Eth - D

∂- small Icelandic Eth - d2222222222222222222222222222222222222222222222222222222222222222

In the ISO Latin 1 mode, the characters w, W, and ] are not
available.

Table B-2 lists the characters you can compose using typewriter
keys in National Replacement Mode.

Table B-2:   National Replacement Mode Compose
Characters (Typewriter Keys)

2222222222222222222222222222222222222222222222222222222222222222222
Character Three-Stroke

Sequence
Two-Stroke
Sequence2222222222222222222222222222222222222222222222222222222222222222222

British

£ pound sign L- or L=

` grave accent ‘ space bar

Danish

# number sign ++

´ apostrophe ´ space bar

@ commercial at sign AA

` grave accent ‘ space bar

Dutch

£ pound sign L- or L=

´ apostrophe ´ space bar
1/4 one quarter 1 4
1/2 one half 1 2
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Table B-2:   (continued)
2222222222222222222222222222222222222222222222222222222222222222222

Character Three-Stroke
Sequence

Two-Stroke
Sequence2222222222222222222222222222222222222222222222222222222222222222222

3/4 three quarters 3 4

ij i j sign i j

fl florin f -

` grave accent ‘ space bar

´ acute accent ´ ´

¨ dieresis " ^

Finnish

# number sign ++

´ apostrophe ´ space bar

Flemish and French/Belgian

£ pound sign L- or L=

´ apostrophe ´ space bar

` grave accent ‘ space bar

French Canadian

´ apostrophe ´ space bar

à a grave ‘a ‘a

â a circumflex ^ a ^ a

è e grave ‘e ‘e

ê e circumflex ^ e ^ e

ı̂ i circumflex ^ i ^ i

ô o circumflex ^ o ^ o

ù u grave ‘u ù

û u circumflex ^ u ^ u

German/Austrian

´ apostrophe ´ space bar

` grave accent ‘ space bar

Italian

´ apostrophe ´ space bar

Norwegian

´ apostrophe ´ space bar

` grave accent ‘ space bar

Portuguese

´ apostrophe ´ space bar

` grave accent ‘ space bar

Ã A tilde ~ A

Õ O tilde ~ O

B–6 Composing Characters



Table B-2:   (continued)
2222222222222222222222222222222222222222222222222222222222222222222

Character Three-Stroke
Sequence

Two-Stroke
Sequence2222222222222222222222222222222222222222222222222222222222222222222

ã a tilde ~ a

õ o tilde ~ o

Spanish

£ pound sign L- or L=

´ apostrophe ´ space bar

§ section sign !S or OS or 0S

` grave accent ‘ space bar

~ tilde ~ space bar

Swedish

# number sign ++

´ apostrophe ´ space bar

É E acute ´ E

é e acute ´ e

Swiss/French and Swiss/German

´ apostrophe ´ space bar

ê e circumflex ^ e ^ e

ı̂ i circumflex ^ i ^ i

ô o circumflex ^ o ^ o

ù u grave ‘ u ‘ u

û u circumflex ^ u ^ u2222222222222222222222222222222222222222222222222222222222222222222

Table B-3 lists the characters that you compose in National
Replacement Mode using data processing keys.

Table B-3:   National Replacement Mode Compose
Characters (Data Processing Keys)

2222222222222222222222222222222222222222222222222222222222222222222
Character Three-Stroke Sequence2222222222222222222222222222222222222222222222222222222222222222222

" double quotation mark " space bar

# number sign + +

´ apostrophe ´ space bar

@ commercial at aa or AA or aA

[ opening bracket ( (

\ backslash / <

] closing bracket ^ space bar
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Table B-3:   (continued)
2222222222222222222222222222222222222222222222222222222222222222222

Character Three-Stroke Sequence2222222222222222222222222222222222222222222222222222222222222222222
{ opening brace ( -

| vertical bar ^ /

} closing brace ) -

~ tilde ~ space bar2222222222222222222222222222222222222222222222222222222222222222222
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CCommands That Help You Manage
Windows3333333333333333333333

In addition to the Motif window manager (mwm), the following
commands are also useful in managing windows:

• resize

• xrefresh

C.1 Resetting Environment Variables with resize
The resize command resets the tty’s size information and
displays a command which you can use in your shell to define the
value of the TERMCAP environment variable (which contains
window length and width information). This enables a shell to
reflect the current size of its window.

Do not confuse resize, the command, with the window
manager function f.resize. The f.resize function changes
the size of a window, but does not reset any environment
variables. The resize command, on the other hand, does not
change the size of a window, but it does reset the tty’s window
size information and displays a command that can be used to reset
the TERMCAP environment variable. Resetting this tty size
information and/or the TERMCAP environment variable enables
character-cell programs to adjust their output to the window’s new
size.

C.1.1 When to Use resize

Use resize when you notice that a character-cell program or
shell does not seem to be using correct window size information.



Usually, it is not necessary to use the resize command.
Terminal emulators, ttys, and shells use escape sequences, system
calls, and signals to communicate window size information, and
they automatically keep this information up-to-date, reflecting any
changes in the window size. Using resize may be necessary
when using older implementations of rlogin or telnet, or
LAT connections from an xterm or DECterm. The resize
command may also be useful when using an ordinary video
terminal with a screen size other than 24×80.

C.1.2 Example
After you have resized a window, either by dragging the window
frame or by choosing Size from the window menu, you can reset
the TERMCAP environment variable to reflect the new window
size by issuing the following command:
% eval ‘resize‘

C.2 Repainting the Screen with xrefresh
The xrefresh client repaints the screen or a specified portion
of the screen. This client performs a similar task to the
f.refresh window manager function. However, the
xrefresh client, because of its options, is more versatile.

C.2.1 When to Use xrefresh

Occasionally, an X program might not clean up properly after
itself, leaving graphics litter on the screen. Use xrefresh any
time you want X to redisplay everything on the screen (or on a
portion of the screen).

To use xrefresh, execute it from the command line of any
terminal window. To repaint just a portion of the screen, use the
-geometry option.
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C.2.2 Examples
The following command repaints the entire display:
xrefresh

This command repaints a portion of the display in the upper-left
corner:
xrefresh -white -geometry 400x200+1+1
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DSample Resource and Configuration
Files3333333333333333333333

This appendix provides the following sample files:

• The Motif window manager resource file, Mwm

• The Motif window manager configuration file, .mwmrc

• The resource file .Xdefaults

D.1 Motif Window Manager Resources
Example D-1 shows the Motif window manager resources you can
customize for color, fonts, placement, and border decorations.

Example D-1:   Motif Window Manager Resources

! Active border colors
Mwm*activeForeground: #000000000000
Mwm*activeBackground: #9851785167AD
Mwm*activeBackgroundPixmap: unspecified_pixmap
Mwm*activeTopShadowColor: #AF4199C18E2E
Mwm*activeTopShadowPixmap: unspecified_pixmap
Mwm*activeBottomShadowColor: #529737652849
Mwm*activeBottomShadowPixmap: unspecified_pixmap
Mwm*activeAutoShade: True
!
! Window manager menu colors
! This is used for color customization to match the menu colors
! to the active or inactive borders. If this is set to 0,
! the menu colors will not be changed during customization
Mwm*matchMenuColors : 1
Mwm*menu*foreground: #000000000000
Mwm*menu*background: #9851785167AD
Mwm*menu*backgroundPixmap: unspecified_pixmap
Mwm*menu*topShadowColor: #AF4199C18E2E
Mwm*menu*topShadowpixmap: unspecified_pixmap
Mwm*menu*bottomShadowColor: #529737652849
Mwm*menu*bottomShadowPixmap: unspecified_pixmap
!
! Icon image and box colors
Mwm*iconImageForeground: #000000000000
Mwm*iconImageBackground: #CA94AA469193
Mwm*iconImageBackgroundPixmap: unspecified_pixmap
Mwm*iconImageTopShadowColor: #DC28BC3DA3D6
Mwm*iconImageTopShadowPixmap: unspecified_pixmap
Mwm*iconImageBottomShadowColor: #9851785167AD
Mwm*iconImageBottomShadowPixmap: unspecified_pixmap



Example D-1:   (continued)
Mwm*iconImageAutoShade: True
!
! Set the trough color to set the iconbox color
Mwm*iconbox.IBframe.IBsWindow.hScrollBar.TroughColor:
Mwm*iconbox.IBframe.IBsWindow.vScrollBar.TroughColor:
!
! Inactive border colors
Mwm*foreground: #000000000000
Mwm*background: #CA94AA469193
Mwm*backgroundPixmap: unspecified_pixmap
Mwm*topShadowColor: #DC28BC3DA3D6
Mwm*topShadowPixmap: unspecified_pixmap
Mwm*bottomShadowColor: #9851785167AD
Mwm*bottomShadowPixmap: unspecified_pixmap
Mwm*autoShade: True
!
! Matte colors
Mwm*matteForeground: #000000000000
Mwm*matteBackground: #CA94AA469193
Mwm*matteTopShadowColor: #DC28BC3DA3D6
Mwm*matteTopShadowPixmap: unspecified_pixmap
Mwm*matteBottomShadowColor: #9851785167AD
Mwm*matteBottomShadowPixmap: unspecified_pixmap
Mwm*matteAutoShade: True
!
!
! Set to greater than 0 pixels to add an additional border
! between border and the window
Mwm*matteWidth: 0
!
! Mwm fonts
Mwm*fontList: -*-Menu-Medium-R-Normal--*-120-*-*-P-*-ISO8859-1
!
! Set to Explicit to determine focus by clicking on the window
! or border
! Set to Pointer to determine focus based on the location of
! the pointer
Mwm*keyboardFocusPolicy: Explicit
!
! Policy when the window with focus is minimized or removed
! if focuspolicy is explicit, set to true to give focus to
! the window with previous focus
Mwm*autoKeyFocus: True
!
! Policy when the window with focus is raised
! if focuspolicy is explicit, set to true to give focus to
! the window that is raised
Mwm*raiseKeyFocus: True
!
! if focuspolicy is explicit, set to true to give a window focus
! when it is restored from an icon
Mwm*deiconifyKeyFocus: True
!
! Set to True to raise a window when it is given focus
! Set to False to keep the stacking order the same when a window
! is given focus
Mwm*focusAutoRaise: True
!
! if focuspolicy is explicit,
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Example D-1:   (continued)
! set to true to give input focus to a window when it is mapped
Mwm*startupKeyFocus: True
!
! Set to True to place and size windows interactively
! false to use default placement
Mwm*interactivePlacement: False
!
! Delay time to retry interactive placement if it fails
Mwm*interPlaceDelay: 1000
!
! Number of retries for interactive placement before using default
! placement
Mwm*interPlaceRetries: 4
!
! This determines default placement of window when there is
! no specification by the user
! Set to true to have Mwm stagger the positions of a window
! from the top left corner
Mwm*clientAutoPlace: False
!
! Set to true to include the border when positioning a window
! Set to false to exclude the border
Mwm*positionIsFrame: False
!
! Set to true to gray icons in the iconbox
! when the icons are not in the minimized state
Mwm*fadeNormalIcon: True
!
! Border decorations
! Set to all for all decorations
! Set to any of the following to limit decorations:
! maximize minimize resizeh border menu title
! Set to none for no decorations
Mwm*clientDecoration: all
!
! Set to True for compatibility for running XUI applications
Mwm*useDECMode: True
!
! Set to True to display icon box
! Set to False to displays icons without the icon box
Mwm*useIconBox: False
!
Mwm*iconBoxSBDisplayPolicy: vertical
!
! Icon decorations
! Set to all or any of the following to control what is
! displayed with an icon
! activelabel label image
Mwm*iconDecoration: activelabel label image
!
! Position of Icon box
! width x height + x position + y position
Mwm*iconBoxGeometry: 14x1+0+2000
!
! Size of resize border
Mwm*resizeBorderWidth: 10
!
! When moving a window,
! if this is set to True, the entire window will move
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Example D-1:   (continued)
! if this is set to False, an outline will move
Mwm*moveOpaque: False
!
! Set this to True to ignore the appropriate MOD keys for window
! manager operations depending on the keyboard and language
Mwm*ignoreModKeys: False
! Set this to True to always ignore MOD2, MOD3, MOD4 keys for
! window ! manager operations regardless of the keyboard and
! language
Mwm*ignoreAllModKeys: False
!
Mwm*transientDecoration: Title resize
Mwm*workspaceMenu: True
!
! How to place icons when a window is minimized
! Set to left top for top of screen left to right
! Set to left bottom for bottom of screen left to right
! Set to right top for top of screen right to left
! Set to right bottom for bottom of screen right to left
! Set to top left for left of screen top to bottom
! Set to top right for right of screen top to bottom
! Set to bottom left for left of screen bottom to top
! Set to bottom right for right of screen bottom to top
Mwm*iconPlacement: Bottom Right
!
! Set to True to place icons according to iconPlacement resource
! Set to False for interactive arrangement
Mwm*iconAutoPlace: True
!
! Set to numbers of pixels between the edge of screen and the
! icons
Mwm*iconPlacementMargin: 1
!
! Title for icon box
Mwm*iconBoxTitle: Icon box
!
Mwm*restartSettings: True
!
! Feedback information
! options are all or none or
! behavior move resize placement quit restart kill
Mwm*showFeedback: behavior placement quit restart kill
!
! Resize Mwm dialog boxes to fit on screen
*DXmfitToScreenPolicy: as_needed
!
! Double-click on window menu (on border of window)
! Set to true to enable double-click on window menu to "close"
! a window
Mwm*wMenuButtonClick2: False

Example D-2 defines the window and root (Workspace) menus and
bindings. The Motif window manager searches for .mwmrc in
your home directory and then
/usr/lib/X11/system.mwmrc. This can vary depending on
the language and certain environment variables set for your
system. You can define your configuration file by adding the
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following line in the Mwm file located in your home directory:
Mwm*configFile: ~/.mwmrc

Example D-2:   Motif Window Manager Menu Bindings

!
! Default bindings as defined in the configuration file
Mwm*buttonBindings: DefaultButtonBindings
Mwm*keyBindings: DefaultKeyBindings
!
! Definition for Window menu on the border of a window
Mwm*windowMenu: DefaultWindowMenu
!
! Definition for Window menu on iconbox
Mwm*iconbox*windowMenu: IconBoxMenu
!
! Definition for System menu when MB1 is pressed on the screen
Mwm*systemMenu: RootMenu

D.2 Sample Motif Window Manager Configuration File
The file .mwmrc contains all window manager menu definitions
and keyboard bindings. Table D-1 lists the available window
manager functions.

Table D-1:   The Motif Window Manager Functions
2222222222222222222222222222222222222222222222222222222222222222
f.beep f.send_msg f.normalize

f.exec f.set_behavior f.refresh

f.prev_key f.circle_down f.raise

f.move f.focus_key f.dec_customize

f.pack_icons f.maximize f.focus_color

f.restart f.nop f.raise_lower

f.refresh_win f.kill f.minimize

f.lower f.separator f.normalize_and_raise

f.quit_mwm f.title f.resize

f.pass_key f.circle_up f.raise_lower

f.next_cmap f.next_key

f.post_smenu f.menu2222222222222222222222222222222222222222222222222222222222222222

Example D-3 shows a sample .mwmrc file.
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Example D-3:   Motif Window Manager Configuration File

! Menu descriptions
!
!
! Root Menu
! Workspace menu from MB1 on screen
Menu RootMenu
{

"Workspace" f.title
"Shuffle Up" _U f.circle_up
"Shuffle Down" _D f.circle_down
"Next Window" _N f.next_key
"Previous Window" _v f.prev_key
no-label f.separator
"Pack Icons" _P f.pack_icons
"Options" _O f.menu MwmCustomizeMenu
no-label f.separator
"Restart..." _R f.restart
"Help" _H f.menu MwmHelpMenu

}

! Workspace menu from Window menu
Menu WorkspaceMenu
{

"Shuffle Up" _U f.circle_up
"Shuffle Down" _D f.circle_down
"Next Window" _N f.next_key
"Previous Window" _v f.prev_key
no-label f.separator
"Pack Icons" _P f.pack_icons
"Options" _O f.menu MwmCustomizeMenu
no-label f.separator
"Restart..." _R f.restart

}

! Customize menu from window menu
Menu MwmCustomizeMenu
{

"Workspace..." _W f.dec_customize workspace
"Border..." _B f.dec_customize border
"Border Colors..." _o f.dec_customize bordercolor
"Icons..." _I f.dec_customize icons
"Icon Colors..." _c f.dec_customize iconcolor
"Matte..." _M f.dec_customize matte
no-label f.separator
"Apply Current Settings" _A f.dec_customize apply
"Reset to Last Saved Settings" _R f.dec_customize reset
"Reset to Default" _D f.dec_customize default

}

! Help menu from window menu
Menu MwmHelpMenu
{

"On Window Manager..." _W f.dec_help mwm
"On Version..." _V f.dec_help version
"On Terms..." _T f.dec_help terms

}

! Default Window Menu
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Example D-3:   (continued)
! Menu associated with window border
Menu DefaultWindowMenu
{

"Restore" _R Alt<Key>F5 f.normalize
"Move" _M Alt<Key>F7 f.move
"Size" _S Alt<Key>F8 f.resize
"Minimize" _n Alt<Key>F9 f.minimize
"Maximize" _x Alt<Key>F10 f.maximize
"Lower" _L Alt<Key>F3 f.lower
no-label f.separator
"Workspace" _W f.menu WorkspaceMenu
"Close" _C Alt<Key>F4 f.kill
"Help" _H f.menu MwmHelpMenu

}

! Default Iconbox menu
! Menu associated with the icon box
Menu IconBoxMenu
{

"Restore" _R Alt<Key>F5 f.normalize
"Move" _M Alt<Key>F7 f.move
"Size" _S Alt<Key>F8 f.resize
"Minimize" _n Alt<Key>F9 f.minimize
"Maximize" _x Alt<Key>F10 f.maximize
"Lower" _L Alt<Key>F3 f.lower
no-label f.separator
"Workspace" _W f.menu WorkspaceMenu
"Pack Icons" _P Shift Alt<Key>F7 f.pack_icons
"Help" _H f.menu MwmHelpMenu

}
!
!-------------------------------- ------------------------------
!
! Key bindings
!
!
Keys DefaultKeyBindings
{

Shift<Key>Escape window|icon f.post_wmenu
! Commented out to avoid conflict with Compose space
! Meta<Key>space window|icon f.post_wmenu

Meta<Key>Tab root|icon|window f.next_key
Meta Shift<Key>Tab root|icon|window f.prev_key
Meta<Key>Escape root|icon|window f.next_key
Meta Shift<Key>Escape root|icon|window f.prev_key
Meta Shift Ctrl<Key>exclam root|icon|window f.set_behavior
Meta Ctrl<Key>exclam root|icon|window f.set_behavior
Meta<Key>F6 window f.next_key transient
Meta Shift<Key>F6 window f.prev_key transient
Shift<Key>F4 root|icon|window f.menu RootMenu
<Key>F4 icon f.post_wmenu

}
!
!---------------------------------------------------------------
!
! Button Bindings
!
!
! Button binding for default keyboard focus policy: Explicit
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Example D-3:   (continued)
Buttons DefaultButtonBindings
{

<Btn1Down> icon|frame f.raise
<Btn3Down> icon|frame f.post_wmenu
<Btn1Down> root f.menu RootMenu
<Btn3Down> root f.menu RootMenu
<Btn1Click2> title f.minimize
Shift <Btn1Click2> icon f.minimize
Shift <Btn1Click> icon|frame f.lower
Ctrl <Btn1Click> root|icon|frame f.next_key
Ctrl Shift <Btn1Click> root|icon|frame f.prev_key
Meta <Btn1Click> root|icon|frame f.next_key transient
Meta Shift <Btn1Click> root|icon|frame f.prev_key transient

}

D.3 Sample .Xdefaults Resource File
Example D-4 shows a sample .Xdefaults file you can use to
set resources for the Session Manager, Motif window manager,
and applications.

Example D-4:   Sample .Xdefaults Resource File

#ifndef COLOR
!
! Black and white monitor
!
*foreground: Black
*background: White
*highlight: Black
*highlightColor: Black
*topShadowColor: Black
*bottomShadowColor: Black
*topShadowPixmap: 25_foreground
*bottomShadowPixmap: 75_foreground
DXsession.display_foreground: Black
DXsession.display_background: White
DXsession.display_pattern: 0
DXsession.pointer_foreground: Black
DXsession.pointer_background: White
DXsession.pointer_shape: 0
!----------------------------------------------------------
!
#else
!
#ifdef MONOCHROME_ON_COLOR
!
!
! Gray-scale monitor
*foreground: gray15
*background: gray65
*highlight: grey15
*highlightColor: grey15
*topShadowColor: grey80
*bottomShadowColor: grey25

D–8 Sample Resource and Configuration Files



Example D-4:   (continued)
DXsession.display_foreground: grey45
DXsession.display_background: grey45
DXsession.display_pattern: 1
DXsession.pointer_foreground: Black
DXsession.pointer_background: White
DXsession.pointer_shape: 0
!
!----------------------------------------------------------
!
#else
! Color monitor
!
*background: #CA94AA469193
*foreground: Black
*highlight: #4BE0624076AE
*highlightColor: #4BE0624076AE
*topShadowColor: #DC28BC3DA3D6
*bottomShadowColor: #9851785167AD
DXsession.display_foreground: #4BE0624076AE
DXsession.display_background: #4BE0624076AE
DXsession.display_pattern: 1
DXsession.pointer_foreground: Black
DXsession.pointer_background: White
DXsession.pointer_shape: 0
#endif
#endif

Sample Resource and Configuration Files D–9
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A
Accelerators

using

in Mail, 5–45

in Paint, 5–57

AccessX

AccessX command, 10–2

AccessX dialog box, 10–3 to 10–13

Adjust Settings dialog box, 10–10, 10–14 to

10–15

Adjust submenu, 10–10

audible signaling, 10–5

BounceKeys feature, 10–27 to 10–28

enabling, 10–2, 10–5

exiting, 10–8

File submenu, 10–8 to 10–9

Help submenu, 10–13

Keyboard Control box, 10–7

Keyboard Response box, 10–7

loading settings, 10–9

main menu bar, 10–8 to 10–13

MouseKeys feature, 10–18 to 10–24

MouseKeys status, 10–6

RepeatKeys feature, 10–24 to 10–25

saving settings, 10–8 to 10–9

selecting features, 10–3

SlowKeys feature, 10–25 to 10–27

AccessX (cont.)

Status submenu, 10–11 to 10–13

StickyKeys feature, 10–15 to 10–18

StickyKeys status, 10–6

Test Area, 10–15

TimeOut feature, 10–6

ToggleKeys feature, 10–24

turning features on and off, 10–7

Xdec +accessx command, 10–2

AccessX command, 10–2

+accessx flag

with Xdec command, 10–2

AccessX menu item

Applications menu, 10–3

AccessX utility, 10–1 to 10–28

Activating controls, A–9

Activating windows

changing input focus, 6–3

Alarms, setting

in Clock, 5–38

Application-specific resource files

location of, 9–8

sample for DECterm application, 9–8

sample for Differences application, 9–8

Application-specific resources, 9–7

Applications

help menu, 2–5

running across network, 4–10



Applications (cont.)

running from Applications menu, 2–3

running from terminal window, 2–3

starting automatically, 7–1

stored as icons, 3–6

Applications menu

AccessX menu item, 10–3

Assigning resources, 9–3, 9–7

Auto repeat

setting, 7–7

B
Background color

See Screen background color

See Screen background pattern

See Window background color

Backspace function key, 9–15

Bell

setting warning, 7–6

Bookreader, 5–10

reading references pages with, 5–3

Bookreader application

arrows

in navigation window, 5–5

in topic window, 5–7

Close button, 5–7

cross-references, 5–8

displaying libraries, 2–3

examples

displaying, 5–9

extensions

customizing, 5–9

figure

displaying, 5–9

footnotes, 5–8

Go Back button, 5–7

Bookreader application (cont.)

hotspots

customizing, 5–9

description of, 5–8

library

changing, 5–9

description of, 2–3, 5–4

menu items

Context-Sensitive Help, 5–4

Expand, 5–5

Extensions, 5–9

Fully Expand, 5–5

Hotspots, 5–9

menus

using pull-downs, 5–4

opening books

multiple, 5–10

reading online documents, 2–3

Screen arrows, 5–7

starting, 2–3, 5–2

subtopics

displaying, 5–5

table of contents, 5–5

displaying graphics, 5–9

tables

displaying, 5–9

Topic arrows, 5–7

topic window, 2–7, 5–6

topics

locating, 5–5

reading, 5–7

windows

library, 2–3, 5–4

navigation, 5–5

topic, 5–6
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Border color

See Window border color

BounceKeys, 10–2, 10–27 to 10–28

adjusting settings, 10–10

customizing, 10–27

turning on and off, 10–27, 10–7

Browser color model

defined, 4–9

C
Calculator

accumulator display

order of precedence, 5–10

arithmetic functions, 5–16, 5–10

copying data between applications, 5–19

customized settings

saving, 5–20

entering data

with mouse or keyboard, 5–12

memory display, 5–10

mistakes

correcting, 5–15

mode

changing to hexadecimal, 5–11

changing to octal, 5–11

order of precedence, 5–16

percentages, 5–16

special functions

in decimal mode, 5–17

in hexadecimal and octal modes, 5–18

starting, 5–2

storing values, 5–16

Calendar, 5–21, 5–26

displays, 5–21

entries

sending and receiving through Mail, 5–25

Calendar (cont.)

icons

selecting and removing, 5–24

starting, 5–2

time slots

creating an entry, 5–22

using the Entry Editor, 5–23

Cardfiler, 5–27, 5–29

card files

creating, 5–28

opening, 5–28

scrolling, 5–28

searching, 5–28

cards

creating, 5–28

saving in a file, 5–28

starting, 5–2

CDA Viewer

and CDA converters, 5–30, 5–30, 5–36

file formats, 5–35

starting, 5–2

viewing files, 5–31, 5–34

Characters

composing, B–1

Check button, 3–16

illustrated, 3–15

Choosing colors

color models, 4–6

Clicking

with the mouse, 3–2

Client applications

Desktop Applications, 1–3

terminal emulators, 1–2

X Consortium clients, 1–4

Clock, 5–37, 5–40

customizing display, 5–37
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Clock (cont.)

setting alarm, 5–38

starting, 5–2

Close button (Bookreader), 5–7

Color

See Pointer background color

See Pointer foreground color

See Screen background color

See Screen foreground

See Window background color

See Window border color

See Window foreground color

See Window highlight color

Color systems

changing screen display on, 7–1

Colors

choosing

using the scratch pad, 4–9

models for selecting, 4–8

Browser, 4–9

HLS, 4–8

Picker, 4–6

RGB, 4–9

Colors, choosing, 4–6

Configuration files

sample files, D–1

sample Mwm, D–1

sample .mwmrc, D–1, D–6

sample .Xdefaults, D–1

Controls

activating, A–9

Cursor

moving, 4–4

Customizing

sample resource files, D–1

Session Manager options, 7–1

Customizing (cont.)

window manager

border buttons, 6–4

pointer focus, 6–3

resize border, 6–4

Customizing applications

color, 9–2

fonts, 9–2

keyboard mapping, 9–2

startup state, 9–2

using application-specific resource files, 9–2

using .Xdefaults, 9–2

window size, 9–2

D
Data processing keyboard

using keyboard as a, 7–7

DDIF files

viewing with CDA Viewer, 5–35

DECterm, 5–40, 5–41

changing fonts, 9–6

composing characters, B–1

starting, 5–2

starting at beginning of session, 2–3, 7–1

terminal window, 5–40

DECwindows Motif environment

components of

client applications, 1–1

Motif window manager, 1–1

session manager, 1–1

Xserver, 1–1

Session Manager, 1–2

DECwindows, using keyboard with, A–1

Default files

See .Xdefaults file
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Default push button option

choosing, 3–17

Delete function key, 9–15

Desktop Applications

starting, 5–2

Desktop Applications, defined, 1–3

Dialog boxes, 3–15

components of, 3–15

traversing with keyboard, A–7, A–10

Displaying

remotely run applications, 4–10

Displaying applications, 4–12

Displaying libraries, 2–3

Double clicking

changing speed, 7–9

with the mouse, 3–2

Drag and drop, 4–5

Dragging

with the mouse, 3–2

DTIF files

viewing with CDA Viewer, 5–35

dxbook, 5–2

dxcalc, 5–2

dxcalendar, 5–2

dxcardfiler, 5–2

dxclock, 5–2

dxdiff, 5–2

dxmail, 5–2

dxnotepad, 5–2

dxpaint, 5–2

dxprint, 5–2

dxterm, 5–2

dxvdoc, 5–2

E
Editor

Notepad, 5–47

Entry Editor (Calendar)

creating an entry with, 5–23

Explicit focus

moving location cursor, A–1

F
Failsafe mode

forcing at session start, 2–2

File editing

with Notepad, 5–47

Files

printing, 4–6

selecting, 3–19

text-entry box, 3–19

Focus, input

and copying text, 4–3, 6–3

Foreground color

See Pointer foreground color

See Screen foreground

See Window foreground color

G
Go Back button (Bookreader), 5–7

H
Help

alternative style, 2–7

choosing topics, 2–8

invoking, 2–5

moving through text, 2–7

navigating, 2–8

requesting on objects, 2–5
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Help (cont.)

searching, 2–8

Help command, 2–5

Help menu, 2–5

contents of, 2–5

Help window

illustrated, 2–6

Highlighting color

See Window highlight color

HLS color model

defined, 4–8

Hotspots (Bookreader), 5–8

I
Icons

applications stored as, 3–6

customizing color options, 6–6

customizing options, 6–5

Implicit focus

moving location cursor, A–1

inbox folder (Mail), 5–44

Input focus

directing typing to a window, 3–4

setting from Workspace menu, 6–3

Intensity system

changing screen display on, 7–1

K
Keyboard

accelerators, 3–14

LK201/LK401, 9–13

LK-style with PCXAL, 9–13

PC-style with LK201/LK401, 9–13

setting a data processing, 7–8

setting an international, 7–7

Keyboard (cont.)

using in place of mouse, A–1

Keyboard Control box (AccessX), 10–7

Keyboard mapping

redefining in .Xdefaults, 9–8

text editing keys, 9–8

Keyboard mnemonics, 3–14

Keyboard Response box (AccessX), 10–7

adjusting settings, 10–10

Keyboard settings

changing, 7–6

Keyclick volume

adjusting, 7–6

Keys

setting lock state, 7–7

text editing, 4–4

L
Library window, 5–5

List box

illustrated, 3–17

selecting from, 3–17

M
Mail

adding Buttons and button boxes, 8–9

autosorting, 8–5, 5–41, 5–46

changing default settings, 8–6

Create-Send window, 5–41

opening, 5–41

environment options, 8–6

messages

sending, 5–43

performance

startup, 8–10
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Mail (cont.)

PostScript files

displaying, 5–45

sending, 5–44

Read window, 5–44

starting, 5–2

startup

performance, 8–10

using accelerators, 5–45

using advanced features, 8–1

Mail messages

changing editor, 8–1

creating, 5–41

changing editor, 8–1

creating a subset of, 8–2

new, 5–44

old, 5–44

picking, 8–2

reading, 5–44

new, 5–44

nontext, 5–45

old, 5–44, 5–45

sending, 5–43

PostScript files, 5–44

to an alias, 5–43

Matte

illustrated, 3–4

Matte (window border), 3–4

Maximize button, 3–4

illustrated, 3–4, 3–7

using, 3–7

MB1, 3–1

MB2, 3–1

MB3, 3–1

Menu bar, 3–4

illustrated, 3–4

Menus

keyboard accelerators, 3–14

mnemonics, 3–14

moving within pull-down menus, A–1

moving within submenus, A–2

options menu, 3–13

Pop-up menu, 3–12

Pull-down menu, 3–12

submenus, 3–13

tear-off menus, 3–14

Message boxes, 3–20

Minimize button, 3–3

illustrated, 3–3

Mnemonics

keyboard, 3–14, A–1

modifier keys

with AccessX StickyKeys, 10–16

Monochrome system

changing screen display on, 7–1

Motif window manager

customizing

border colors, 6–5

icon options, 6–5

matte options, 6–7

with Workspace menu, 6–1

customizing icon colors, 6–6

Workspace menu, 3–10

Motif window manager, defined, 1–2

Mouse

basics, 3–1

changing double click speed, 7–9

using, 3–1

Mouse buttons

rearranging, 7–10

using, 3–1
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Mouse settings

changing, 7–8

MouseKeys, 10–1, 10–18 to 10–24

adjusting settings, 10–10

customizing, 10–23

status box, 10–12 to 10–13

turning on and off, 10–18, 10–7

using with LK401-style keyboards, 10–19

using with PC-style keyboards, 10–19, 10–21

Moving to the next menu, A–3

Moving to the previous menu, A–2

N
Navigation window, 5–5

table of contents, 5–5

Navigation with keyboard, A–1

Network

controlling access over, 7–5

Next menu

moving to, A–3

Notepad, 5–47, 5–54

starting, 5–2

Notepad text editor

Buffer, 5–48

canceling edits, 5–50

copying text, 5–51

editing file, 5–49

exiting from, 5–53

formatting text, 5–48

moving text, 5–50

navigating, 5–49

saving text, 5–51

scrolling, 5–48

starting, 5–47

typing text, 5–47

O
Optacon II utility, 10–28

Options menu, 3–13

P
Paint

accelerators, 5–57

basic functions, 5–58, 5–55

canvas

moving the display, 5–56

files

opening, 5–58

standard type, 5–58

starting, 5–2

tool palette

location of, 5–55

Password

defined, 2–2

Pause Screen

changing text displayed on, 7–2

Pause Session dialog box, 2–4

PC-style keyboard, 9–13

Pending delete

defined, 4–4

Picker color model

defined, 4–6

illustrated, 4–6

switching models, 4–8

Pointer acceleration

changing, 7–9

Pointer background color

changing, 7–10

Pointer foreground color

changing, 7–10
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Pointer settings

changing, 7–8

Pointer shape, 3–1

changing, 7–10

Pointing

with the mouse, 3–2

Pop-up menu, 3–12

in Clock, 5–38

PostScript file

displaying with Mail, 5–45

PostScript files

viewing with CDA Viewer, 5–35

Pressing

with the mouse, 3–2

Previous menu

moving to, A–2

Print queue

specifying a printer, 4–6

submitting files to, 4–6

Print Screen, 5–59, 5–63

running from terminal, 5–59

starting, 5–2

time delay, 5–61

printing files, 4–6

Printing files

created in applications, 4–6

Puff utility, 10–28

Pull-down menu, 3–12

Push button, 3–13

illustrated, 3–15, 3–17

using, 3–17

Push buttons, 3–1

Q
QuickCopy

copying text with, 4–3

R
Radio button, 3–16

illustrated, 3–15

Reading online documents, 2–3

Redefining keys, 9–8

assigning values, 9–12

sample Emacs text translation string, 9–10

Reference pages

for Desktop applications, 5–3

Remote applications

authorizing workstation access, 4–11, 4–10,

4–12

enabling the display, 4–12

running, 4–10

Repainting screen with xrefresh, C–2

RepeatKeys, 10–2, 10–24 to 10–25

adjusting settings, 10–10

customizing, 10–25

turning on and off, 10–25, 10–7

Resize borders, 3–3

illustrated, 3–3

resize, managing windows with, C–1

Resource files

application-specific, 9–1

defined, 9–2

Resource specification

syntax for, 9–3

text translation string, 9–9

Resources

locating application-specific, 9–7

sample files for customizing, D–1
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Resources (cont.)

sample files for customizing (cont.)

Mwm, D–1

.Xdefaults, D–8

RGB color model

defined, 4–9

S
Sample .Xdefaults file, D–8

Scale, 3–17

illustrated, 3–15, 3–17

Screen background color

setting, 7–4

Screen background pattern

setting, 7–3

Screen display

restoring, 2–2

Screen foreground

setting, 7–4

Screen saver

adjusting, 7–3

Screen timeout, 2–2

Scroll bar

illustrated, 3–8

using, 3–7

Scroll region

illustrated, 3–7

Scrolling, 3–7

Secondary windows

moving between, A–5

Security

setting for network access, 7–5

Security options

in Session Manager, adding hosts, 4–11

Selecting

windows, 3–4

Selecting files

file selection box, 3–19

Selection

book, 5–4

library, 5–4

Session

ending, 2–4

pausing, 2–3

starting, 2–1

failsafe mode, 2–2

Session Manager

changing window settings, 7–2

customizing, 7–1

setting security options, 4–11

starting as icon, 7–2

Session Manager settings

saving, 7–11

Session Manager, defined, 1–2

Settings

saving in dialog boxes, 3–17

Shift clicking

with the mouse, 3–2

Slider, 3–7

illustrated, 3–8

SlowKeys, 10–2, 10–25 to 10–27

adjusting settings, 10–10

customizing, 10–26

turning on and off, 10–26, 10–7

Specifying resources

in .Xdefaults, 9–3

Stepper arrow, 3–7

illustrated, 3–8

StickyKeys, 10–1, 10–15 to 10–18

adjusting settings, 10–10

customizing, 10–18

latching, 10–16
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StickyKeys (cont.)

locking, 10–17

status box, 10–11 to 10–12

turning on and off, 10–16, 10–7

with modifier keys, 10–16

Submenus, 3–13

T
Table of contents, 5–5

opening topics from, 5–5

Tear-off menus, 3–14

Terminal emulators

using DECterm, 5–40

Text, 4–5

copying

between windows, 4–2

with drag and drop, 4–5

deleting, 4–4

editing, 4–1, 4–4

editing with Notepad, 5–47

selecting, 4–1

viewing with scroll bars, 3–7

Text editing keys

functions, 9–8

redefining, 9–8

Text files

viewing with CDA Viewer, 5–35

Text translation string

samples, 9–10

syntax for specifying, 9–9

text bindings, 9–12

Text-entry boxes, 3–16

typing in, 3–16

TimeOut (AccessX), 10–2, 10–6

Title bar, 3–3

illustrated, 3–3

Title bar (cont.)

moving a window with, 3–5

ToggleKeys, 10–2, 10–24

turning on and off, 10–7

Topic

locating, 5–5

Traversal

between windows, A–5

dialog boxes, A–7

pull-down menus, A–1

submenus, A–2

within windows, A–5

Typewriter keyboard

using keyboard as a, 7–7

V
Visual Differences, 5–63, 5–66

displaying differences, 5–65

moving between differences, 5–66

selecting files, 5–64

starting, 5–2, 5–63

W
Window

directing typing to, 3–4

dragging, 3–5

minimizing, 3–6

moving, 3–5

selecting, 3–4, 5–5

sizing, 3–5

topic, 5–5

Window background color

setting, 7–4

Window border color

setting, 7–5
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Window environment

components

Motif window manager, 1–1

Session Manager, 1–1

X server, 1–1

Window environment components

client applications, 1–1

Window foreground color

setting, 7–4

Window frame, 3–3

illustrated, 3–3

Window highlight color

setting, 7–5

Window management tips, 3–2

enlarging a window, 3–7

moving, 3–5

multiple windows, 3–2

resizing, 3–5

shrinking, 3–6

Window manager

Motif window manager, 1–2

setting, 7–3

Window menu, 3–9

illustrated, 3–9

Window menu button, 3–3

illustrated, 3–3

Window title, 3–3

illustrated, 3–3

Windows

copying text between, 4–2

copying text between with drag and drop,

4–5

customizing, 3–12

moving between, A–5

moving within, A–5

Work area, 3–4

illustrated, 3–4

Workspace, 3–10

Workspace menu, 3–10

customizing, 9–17

customizing with option menu, 3–12

illustrated, 3–10

tailoring, 6–1

using Next and Previous Window, 3–11

using Shuffle Up and Down, 3–11

Workstation

locking, 2–3

Workstation display

controlling network access to your, 7–5

X
X Window System

client applications, defined, 1–1

client/server relationships, 1–1

X server, defined, 1–1

Xdec +accessx command, 10–2

.Xdefaults file

assigning resources, 9–3

creating, 9–2

loading changes, 9–4

locating sample, 9–2

xrefresh, C–2

.xsession file

customizing keyboard with, 9–14

customizing mail editor with, 8–2

Xsoundsentry utility, 10–29
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Technical Support
If you need help deciding which documentation best meets your needs, call 800-DIGITAL
(800-344-4825) before placing your electronic, telephone, or direct mail order.

Electronic Orders
To place an order at the Electronic Store, dial 800-234-1998 using a 1200- or 2400-bps
modem from anywhere in the USA, Canada, or Puerto Rico. If you need assistance using the
Electronic Store, call 800-DIGITAL (800-344-4825).

Telephone and Direct Mail Orders

Your Location Call Contact

800-DIGITALContinental USA,
Alaska, or Hawaii

Digital Equipment Corporation
P.O. Box CS2008
Nashua, New Hampshire 03061

Puerto Rico 809-754-7575 Local Digital subsidiary

Canada 800-267-6215 Digital Equipment of Canada
Attn: DECdirect Operations KAO2/2
P.O. Box 13000
100 Herzberg Road
Kanata, Ontario, Canada K2K 2A6

International ————— Local Digital subsidiary or
approved distributor

Internala ————— SSB Order Processing – NQO/V19
or
U. S. Software Supply Business
Digital Equipment Corporation
10 Cotton Road
Nashua, NH 03063-12603333333333333333333333

a For internal orders, you must submit an Internal Software Order Form (EN-01740-07).
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